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Federal
Communications

Commission (FCC)
Notice

This product was tested and found to comply with the limits for a Class 
A digital device, pursuant to Part 15 of the FCC Rules. These limits are 
designed to provide reasonable protection against harmful interfer-
ence when the equipment is operated in a commercial environment. 
This product generates, uses, and can radiate radio frequency energy 
and, if not installed and used in accordance with the instruction 
manual, may cause harmful interference to radio communications. 
Operation of this product in a residential area is likely to cause harmful 
interference, in which case you will be required to correct the interfer-
ence at your own expense.

This device complies with part 15 of the FCC Rules. Operation is 
subject to the following two conditions: (1) This device may not cause 
harmful interference, and (2) This device must accept any interference 
received including interference that may cause undesired operation.

The authority to operate this product is conditioned by the require-
ments that no modifications be made to the equipment unless the 
changes or modifications are expressly approved by Acterna.

Industry Canada
Requirements

This Class A digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe A est conforme à la norme NMB-
003 du Canada.

EMC Directive
Compliance

This product was tested and conforms to the EMC Directive, 89/336/
EEC as amended by 92/31/EEC and 93/68/EEC for electromagnetic 
compatibility. A copy of the Declaration of Conformity is provided with 
this manual.

If you purchase the 2802-FE to perform 10/100 Ethernet testing, you 
must use the shielded twisted pair cable (STP) provided to maintain 
CE compliance.

Warning: This is a class A product. In a domestic environment this 
product may cause radio interference in which case the user may be 
required to take adequate measures.
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Low Voltage Directive
Compliance

This product was tested and conforms to the Low Voltage Directive, 
73/23/EEC as amended by 93/68/EEC. Conformity with this directive 
is based upon compliance with the harmonized safety standard, 
EN60950. A copy of the Declaration of Conformity is provided with this 
manual.
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Important Safety Instructions
The following table defines safety terms. Failure to observe these 
precautions while using the FST-2802, violates the intended use of this 
product.

When using this product, always follow basic safety precautions to 
reduce the risk of fire, shock, and injury to persons. Basic safety 
precautions are as follows:

1 Read and follow all warning notices and instructions marked on 
the product and included in the manual.

2 Use only the AC Adapter/Charger supplied with the product.

3 Do not use AC Adapter/Charger outdoors or in wet or damp loca-
tions.

4 Connect the AC Adapter/Charger to the correct mains voltage, as 
indicated on the ratings label.

5 Do not allow anything to rest on the power cord, and do not locate 
the product where people can walk on the power cord.

6 Avoid using this product during an electrical storm. There may be 
a remote risk of electric shock from lightning.

7 Do not use this product in the vicinity of a gas leak or in any explo-
sive environment. 

8 Do not attempt to service this product yourself, as opening or 
removing covers may expose you to dangerous, high voltage 
points and other hazards. Contact qualified service personnel for 
all service.

Safety definitions

Term Description

DANGER Indicates an imminently hazardous situation which, if 
not avoided, will result in death or serious injury.

WARNING Indicates a potentially hazardous situation which, if 
not avoided, could result in death or serious injury.

CAUTION Indicates a potentially hazardous situation which, if 
not avoided, may result in minor or moderate injury. It 
may also be used to alert against unsafe practices.
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9 CAUTION: Danger of explosion if battery is incorrectly replaced. 
Replace only with (part number 11-18066). Dispose of used 
batteries according to the manufacturer's instructions.

10 CAUTION: Use of controls or adjustments or performance of 
procedures other than those specified herein may result in 
hazardous radiation exposure.

11 CAUTION: The FST-2802 is a Class 1 laser product. 

Symbols The following safety symbol is used on the FST-2802. All safety 
precautions must be observed when operating, servicing, or repairing 
the FST-2802. Failure to comply with the following safety precautions 
or with hazard cautions and warnings used throughout this manual 
violates the intended use of this instrument. 

Save these instructions

GENERAL HAZARD
This icon represents a general warning or caution.
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About This Guide
The topics discussed in this chapter are as follows:

– “Purpose and scope” on page xxii
– “Assumptions” on page xxii
– “Related information” on page xxii
– “Technical assistance” on page xxiii
– “Conventions” on page xxiv
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About This Guide
Purpose and scope
Purpose and scope
The purpose of this guide is to help you successfully use the FST-2802 
TestPad features and capabilities. This guide includes task-based 
instructions that describe how to install, configure, use, and trouble-
shoot the FST-2802 TestPad. Additionally, this guide provides a 
complete description of Acterna’s warranty, services, and repair infor-
mation, including terms and conditions of the licensing agreement.

Assumptions
This guide is intended for novice, intermediate, and experienced users 
who want to use the FST-2802 TestPad effectively and efficiently. We 
are assuming that you have basic computer, mouse/track ball, and 
networking experience and are familiar with basic telecommunication 
concepts and terminology.

Related information
Use this guide in conjunction with the FST-2802 Online Help.
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Technical assistance
Technical assistance
If you need assistance or have questions related to the use of this 
product, call or e-mail Acterna’s Technical Assistance Center for 
customer support.

During off-hours, you can request assistance by doing one of the 
following: leave a voice mail message at the Technical Assistance 
number in your region; e-mail North American Technical Assistance 
Center, tac@acterna.com, or European Technical Assistance Center, 
support.uk@acterna.com; or submit your question using our online 
Technical Assistance Request form at www.acterna.com.

Table 1 Technical assistance centers

Region Phone Number

Americas (except Brazil) 1-866-ACTERNA
301-353-1550

(1-866-228-3762)
tac@acterna.com

Brazil 0800-7015370
4617 3839
4617 3729

Europe, Africa, and Mid-
East

+800 882 85822 
(European Freephone)

(Acterna UK)

+49 (0) 7121 86 1345
(Acterna Germany)

+33 (0) 1 39 30 24 24 
(Acterna France)

support.uk@acterna.com

support.uk@acterna.com

hotline.germany@acterna.com

hotline.germany@acterna.com

Asia and the Pacific +852 2892 0990 
(Hong Kong)

+8610 6833 7477 
(Beijing-China)

Australia +61 3 9690 6700
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About This Guide
Conventions
Conventions
This guide uses naming conventions and symbols, as described in the 
following tables.

Table 2 Typographical conventions

Description Example

User interface actions appear in 
this typeface.

On the Status bar, click Start.

Buttons or switches that you press 
on a unit appear in this Typeface.

Press the On switch.

Code and output messages 
appear in this typeface.

All results OK

Text you must type exactly as 
shown appears in this typeface.

Type: a:\set.exe in the dialog 
box.

Variables appear in this typeface. Type the new hostname.

Book references appear in this 
typeface. 

Refer to Newton’s Telecom Dictio-
nary

A vertical bar | means “or”: only 
one option can appear in a single 
command.

platform [a|b|e]

Square brackets [ ] indicate an 
optional argument.

login [platform name]

Slanted brackets < > group 
required arguments.

<password>

Table 3 Keyboard and menu conventions

Description Example

A plus sign +  indicates simulta-
neous keystrokes.

Press Ctrl+s

A comma indicates consecutive 
key strokes.

Press Alt+f,s

A slanted bracket indicates choos-
ing a submenu from menu.

On the menu bar, click 
Start > Program Files.
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Table 4 Symbol conventions

Table 5 Safety definitions

This symbol represents a general hazard.

This symbol represents a risk of electrical shock.

NOTE:
This symbol represents a Note indicating related information or tip.

WARNING:
Indicates a potentially hazardous situation which, if not avoided, 
could result in death or serious injury.

CAUTION:
Indicates a potentially hazardous situation which, if not avoided, 
may result in minor or moderate injury.
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Chapter 1 FST-2802 TestPad Overview
1

This chapter provides a general description of the FST-2802 TestPad. 
Topics discussed in this chapter are as follows:

– “About the FST-2802 TestPad” on page 2
– “What’s new” on page 2
– “Features and capabilities” on page 3
– “Configurations and options” on page 6
– “Accessories” on page 8
– “Exploring the FST-2802” on page 15
– “Powering the TestPad” on page 20
– “Navigating the user interface” on page 21
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About the FST-2802 TestPad
About the FST-2802 TestPad
The FST-2802 TestPad Gigabit Ethernet Services Module is the ideal 
telecommunications solution for testing and verifying Ethernet and 
Fibre Channel network elements and services. The FST-2802 is opti-
mized for field use because it is portable and easy-to-use. As a 
member of the Acterna TestPad 2000 family of products, the FST-2802 
has an easy-to-use touch screen user interface that simplifies test 
setup and reduces test configuration time. The “smart tester” icon-
driven interface is easy to learn, and the large display provides ample 
space for viewing test results. 

The following items ship with the FST-2802:

– FST-2802 application module—The application module connects 
to the UIM, allowing you to test 1G Ethernet links. Options are 
available which enable you to test 10BaseT/100BaseT Ethernet, 
1G Fibre Channel, and 2G Fibre Channel links. You can also 
purchase the optional dual port configuration to generate and 
analyze Ethernet or Fibre Channel traffic from two ports simulta-
neously.

– Y cable—The Y cable connects to the USB/Serial port, enabling 
you to connect USB and serial devices to the FST-2802.

– User documentation—The FST-2802 ships with a User’s Guide 
and a comprehensive help system.

Before testing, the FST-2802 must be connected to a FST-2000 user 
interface module (UIM), which can be ordered separately (part number 
2000-V6). The UIM ships with a VGA display, a battery, and an AC 
adapter, which you use to supply power to the TestPad.

What’s new
The FST-2802 is a significant enhancement over previous TestPads. 
The primary changes are as follows:

– BER testing—You can now use the FST-2802 to verify circuit 
performance by sending BER patterns over switched (layer 2) and 
unswitched (layer 1) networks.
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Features and capabilities
– 1G and 2G Fibre Channel testing—1G and 2G Fibre Channel 
options are now available for the FST-2802 which enable you to 
test and verify Fibre Channel network elements and services by 
testing connectivity, measuring service disruption time and round 
trip delay, and transmitting patterns to stress the jitter and noise 
characteristics of Fibre Channel network elements and systems.

– Dual port configuration—An optional dual port configuration is now 
available which allows you to generate and analyze Ethernet or 
Fibre Channel traffic from two ports simultaneously.

– THRU mode for 10/100 Ethernet testing—If you purchase the 
optional dual port configuration and the 10/100 option, you can 
now monitor 10/100 traffic in THRU mode.

– Optional single-mode and multi-mode GigE and Fibre Channel 
GBICs—You can now test Fibre Channel (and GigE Ethernet) on 
an optical link using a single-mode or multi-mode GigE and Fibre 
Channel GBIC.

– Optional copper GigE GBIC—You can now test 1G Ethernet on a 
copper link using a copper GBIC.

– Optional single-mode long-haul GBIC—You can now test 1G 
Ethernet over very long distances using a long-haul GBIC.

Features and capabilities
The FST-2802 provides you with the tools you need to provision 
Ethernet or Fibre Channel service, verify end-to-end connectivity, and 
analyze link performance by simulating different traffic conditions.

Features and capabilities of the FST-2802 include the following:

– Traffic generation—Using the FST-2802, you can generate frames 
and configure traffic parameters such as bandwidth utilization, 
frame length, and frame rate. You can simulate different network 
traffic conditions and analyze the performance of a link by config-
uring traffic loads for constant, bursty, and ramped traffic.

– Filtered traffic—Using the FST-2802, you can filter received traffic 
by defining a profile which specifies the frame characteristics of 
the traffic you want to monitor.
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Features and capabilities
– Link status—Using the easy-to-interpret LEDs on the FST-2802, 
you can obtain a quick summary of the state of the link you are 
analyzing. The LEDs indicate the status of the link or a specific 
traffic stream, allowing you to quickly verify circuit integrity or iden-
tify the source of a problem.

– Verify end-to-end connectivity—Using the FST-2802, you can 
ensure physical layer integrity and verify end-to-end connectivity 
of a circuit.

– Link utilization and throughput verification—Using the FST-2802, 
you can generate traffic at a specific bandwidth to verify the error 
free throughput of a link. The FST-2802 allows you to loopback 
frames at the far end to qualify the link in both directions.

– Identify problems with faulty interfaces—Using the FST-2802, you 
can perform basic troubleshooting of links and verify the capability 
of network elements to support reliable communications by trans-
mitting standard frames over a circuit.

– Round trip delay measurement—Using the FST-2802, you can 
verify that a link complies with round trip delay requirements as 
specified in a customer’s service level agreement. You can also 
ensure frame loss and frame error statistics fall within the range 
specified as acceptable.

– Service disruption time measurement—Using the FST-2802, you 
can measure the amount of time it takes to switch service to a 
protect line.

– Pattern transmission—Using the FST-2802, you can stress the 
jitter and noise characteristics of Gigabit Ethernet and Fibre 
Channel components and systems on physical layer networks by 
transmitting continuous random test patterns (CRPAT), continuous 
jitter test patterns (CJPAT), and the compliant supply noise pattern 
(CSPAT).

Ethernet features In addition to the standard features, the following features are avail-
able when performing Ethernet tests using the FST-2802:

– Auto-negotiation—You can configure auto-negotiation before 
establishing the link, which ensures compatibility between the 
FST-2802 and any installed Ethernet interface.
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– Frame verification—You can verify that the size and format of 
Ethernet frames conforms to IEEE 802.3 or DIX (Digital/Intel/
Xerox) requirements, ensuring the capability of network elements 
to support reliable communications.

– Jumbo frames—You can optionally transmit jumbo frames which 
exceed the IEEE 802.3 maximum length of 1518 bytes.

– Loopback frame generation—You can generate loopback frames 
to loop up a second FST-2802 at the far end. This feature allows 
you to leave one FST-2802 at a central location to measure bi-
directional throughput.

– IP Ping testing—You can send ping requests and respond to ping 
messages from another Ethernet device to verify connectivity.

– RFC 2544 script—You can run a script which automates the test 
procedures recommended in RFC 2544. The script prompts you to 
select key parameters for each of the tests, runs the tests, and 
then automatically generates a text file of results for the tests.

– User-assigned source MAC address—You can optionally change 
the default MAC address assigned to each port of the FST-2802 
when you configure tests.

Fibre Channel
features

In addition to the standard features, the following features are avail-
able when performing Fibre Channel tests using the FST-2802:

– Frame verification—You can verify that the size and format of 
Fibre Channel frames conforms to ANSI X3T11 requirements, 
ensuring the capability of network elements to support reliable 
communications.

– Loopback testing—You can generate loopback frames to loop up 
a second FST-2802 at the far end. This feature allows you to leave 
one FST-2802 at a central location to measure bi-directional 
throughput.

FST-2000 TestPad
features

The FST-2802 uses the Acterna FST-2000 TestPad Version 6 User 
Interface Module (UIM), which runs under the Windows XP operating 
system. The FST-2000 provides a variety of connectivity tools which 
make installation and troubleshooting more efficient. Options and 
accessories are also available which allow you to establish network 
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connections to the TestPad, use the TestPad to access a local Web 
browser, or emulate a VT-100 terminal. Standard features of the FST-
2000 include:

– Print capability—You can print test configurations and test results 
using the FST-2802. You can generate a print file at timed inter-
vals or whenever a test ends. You can also manually print test 
configurations, test results, and histograms at any time, and you 
can encrypt print file data to ensure the integrity of the data trans-
mitted to your supervisor or Technical Support department.

– Email test configurations and test results—If you purchase the 
Networking option, you can email test configurations and test 
results to your supervisor directly from the FST-2802.

– View Portable Document Format (PDF) files—You can launch and 
view PDFs on the FST-2802.

– Command line remote control—You can configure the FST-2802 
and perform tests from a remote PC or laptop by issuing remote 
control commands.

– Remote GUI—If you purchase the Networking option, you can use 
the Remote GUI to run the TestPad GUI from any remote device 
with a Web browser, such as a PC or laptop. When viewing the 
GUI from a remote device, you can configure and perform tests, 
view test results, and do anything you could do using the FST-
2802 itself.

– VNC Viewer—You can launch the Virtual Network Computing 
(VNC) viewer to run remote applications from the FST-2802.

– FTP—If you purchase the Networking option, you can use FTP to 
transfer files to and from the FST-2802.

– FST-2802 Help—You can display FST-2802 Help which includes 
detailed instructions for configuring and performing tests, compre-
hensive result descriptions, and a glossary of terms.

Configurations and options
When you order a FST-2802, you order a single or dual port configu-
ration which allows you to test 1G Ethernet. You can also expand your 
testing capabilities by purchasing optional interfaces for the FST-2802, 
including a 10/100 BaseT Ethernet interface, a 1G Fibre Channel inter-
face, and a 2G Fibre Channel interface. Options are also available for 
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the FST-2000 which allow you to launch a Web browser, emulate a VT-
100 terminal, run the GUI from a remote device, or automate tests 
using test scripts.

Table 1 lists the FST-2802 configurations.

FST-2802 options The FST-2802 offers the following application module options: 

– 10/100 interface (part number 2802-FE)—Using this option, you 
can test 10BaseT and 100BaseTX links. If you purchase the 
optional dual-port configuration, you can transmit and analyze 10/
100 and/or 1G Ethernet traffic from both ports simultaneously.

– 1G Fibre Channel interface (part number 2802-1G-FC)—Using 
this option, you can test 1G Fibre Channel network elements and 
services. If you purchase the optional dual-port configuration and 
2G Fibre Channel interface, you can transmit and analyze 1G and/
or 2G Fibre Channel traffic from both ports simultaneously.

– 2G Fibre Channel interface (part number 2802-2G-FC)—Using 
this option, you can test 2G Fibre Channel network elements and 
services. If you purchase the optional dual-port configuration and 
1G Fibre Channel interface, you can transmit and analyze 1G and/
or 2G Fibre Channel traffic from both ports simultaneously.

– VLAN Tagging (part number 2802-VLAN)—Using this option, the 
FST-2802 can transmit VLAN (virtual LAN) tagged frames, 
enabling you to verify that an Ethernet link supports VLAN tagging. 
The FST-2802 can also analyze received traffic to verify that the 
required bandwidth is allocated to tagged frames on a link and 
determine that VLAN prioritization is functioning properly.

– Layer 2 IP Address Filter (part number 2802-IP FILTER)—Using 
this option, you can monitor Ethernet traffic for IP addresses, and 
view filtered layer 2 link statistics for a selected IP address.

Table 1 FST-2802 configurations

Configuration Part Number Allows you to test:

Single port 2802-GIGE 1G Ethernet using one GBIC port.

Dual port 2802-DUAL 1G Ethernet using two GBIC ports.
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FST-2000 TestPad
options

The features provided by FST-2000 TestPad options are available for 
any application module you attach to the TestPad.

The FST-2000 TestPad offers the following options:

– Web browser (part number 2000-WEB)—Using this option, you 
can launch a Web browser on the FST-2802 to access information 
on the Internet or your company’s intranet.

– VT100 emulation (part number 2000-VT100)—Using this option, 
the FST-2802 can emulate a VT100 terminal. This option includes 
a DB-9 Female to DB-9 Male cable, enabling you to establish a 
serial connection for VT100 emulation.

– Scripting (part number 2000-SCR)—Using this option, you can 
write your own test scripts using the Tcl/Tk scripting language to 
automate and standardize your testing processes.

– Networking (part number 2000-NET)—Using this option, you can 
establish network connections to the FST-2802 for a variety of 
applications.

Accessories
You can also purchase accessories for the FST-2802 such as GBICS 
for testing GigE Ethernet and Fibre Channel links, card and cables for 
establishing remote connections, and printers. To order accessories 
for the FST-2802, contact Acterna Customer Care.
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GBIC accessories Table 2 lists the GBICs available for testing GigE Ethernet and Fibre 
Channel links. Please consult your GBIC manufacturer’s data sheet 
for detailed specifications.

Table 2 GBIC accessories

Accessory Part Number Used to…

Multi-mode GigE GBIC AC-GBIC-SX Test 1G Ethernet on optical links over 
distances up to:
– 275 meters with 62.5µm multi-

mode fiber
– 550 meters with 50µm multi-

mode fiber
NOTE: This GBIC is not recom-
mended for use with 10µm single-
mode fiber.

Single-mode GigE GBIC AC-GBIC-LX Test 1G Ethernet on optical links over 
distances up to:
– 275 meters with 62.5µm multi-

mode fiber
– 550 meters with 50µm multi-

mode fiber
– 10,000 meters with 10µm single-

mode fiber
NOTE: This GBIC is not recom-
mended for use with multi-mode 
fiber.
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Multi-mode GigE and Fibre 
Channel GBIC

AC-GBIC-ALLRATE-SX Test 1G Ethernet, 1G Fibre Channel, 
and 2G Fibre Channel on optical 
links over distances up to:
1G Ethernet
– 275 meters with 62.5µm multi-

mode fiber
– 550 meters with 50µm multi-

mode fiber
1G Fibre Channel
– 300 meters with 62.5µm multi-

mode fiber
– 550 meters with 50µm multi-

mode fiber
2G Fibre Channel
– 150 meters with 62.5µm multi-

mode fiber
– 300 meters with 50µm multi-

mode fiber
NOTE: This GBIC is not recom-
mended for use with 10µm single-
mode fiber.

Table 2 GBIC accessories

Accessory Part Number Used to…
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Single-mode GigE and Fibre 
Channel GBIC

AC-GBIC-ALLRATE-LX Test 1G Ethernet, 1G Fibre Channel, 
and 2G Fibre Channel over distances 
up to:
1G Ethernet
– 275 meters with 62.5µm multi-

mode fiber
– 550 meters with 50µm multi-

mode fiber
1G Fibre Channel
– 300 meters with 62.5µm multi-

mode fiber
– 550 meters with 50µm multi-

mode fiber
2G Fibre Channel
– 225 meters with 62.5µm multi-

mode fiber
– 225 meters with 50µm multi-

mode fiber
– 10,000 meters with 10µm single-

mode fiber

Copper GigE GBIC AC-GBIC-COPPER Test 1G Ethernet on copper links 
over distances up to 100 meters.
NOTE: This copper GBIC (AC-GBIC-
COPPER) does not support auto-
negotiation; therefore, the FST-
2802’s link partner must also use a 
copper GBIC that does not support 
auto-negotiation.

Single-mode Long-haul GigE 
GBIC

AC-GBIC-LONGHAUL Test 1G Ethernet over distances up 
to 80 kilometers on optical links.
NOTE: This GBIC is not recom-
mended for use with multi-mode 
fiber.

Table 2 GBIC accessories

Accessory Part Number Used to…
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Connectivity
accessories

Table 3 lists the accessories available for establishing remote connec-
tions.

NOTE:
The optional SX, LX, and copper GBICs offered by Acterna as 
accessories comply with the Revision 5.5 GBIC specification. The 
long-haul GBIC complies with the Revision 5.4 GBIC specification. 
Please refer to your GBIC manufacturer’s site for detailed specifica-
tions.

Table 3 Connectivity accessories

Accessory Part Number Used to…

DB-9 Female to 
DB-9 Female null 
modem cable

CB-014491 Connect a laptop to the 
serial connector of the Y 
cable. Typically used for 
remote control command 
operation.

Serial PCMCIA 
card

2000-SERIAL Provide a second serial 
connection to the TestPad. 
This allows you to connect 
two serial devices to the 
TestPad—one to the serial 
connector of the Y cable, 
and one to the connector 
provided on the serial 
PCMCIA card.

Analog dial-up 
modem PCMCIA 
card

2000-ANLG-
MODEM

Establish an analog dial-up 
connection to the TestPad. 
Ships with an RJ-11 phone 
cable.

RJ-11 phone cable 
(replacement)

CB-834011 Connect an Analog Dial-Up 
Modem PCMCIA card to a 
phone jack.
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Ethernet 10/100 
Base-T LAN PCM-
CIA card

2000-LAN Establish an Ethernet con-
nection from the TestPad to 
a laptop or LAN. 
– Ships with an Ethernet 

LAN cable for LAN con-
nections (replacement 
cables can be ordered 
if necessary).

– Laptop connections 
require an Ethernet 
cross-over cable (part 
number CB-834251).

Ethernet Type III 
LAN PCMCIA card

2000-LAN-TYPE3 Establish an Ethernet con-
nection from the TestPad to 
a laptop or LAN. 
– Ships with a 6 ft. Ether-

net LAN extension 
cable for LAN connec-
tions (replacement 
cables can be ordered 
if necessary).

– Laptop connections 
require an Ethernet 
cross-over cable (Part 
number: CB-834251).

Ethernet LAN cable 
(replacement)

CB-016267 Connect an Ethernet PCM-
CIA card in the TestPad to 
an Ethernet jack.

802.11b Wireless 
LAN PCMCIA card

2000-WLAN Establish an 802.11 wire-
less connection to the Test-
Pad.

Bluetooth Wireless 
PCMCIA card

2000-BT-MODEM Establish a Bluetooth wire-
less connection to the Test-
Pad.

USB Direct Con-
nect cable

CB-18944 Establish a direct USB con-
nection from the TestPad to 
a laptop via the USB con-
nector on the Y cable.

Table 3 Connectivity accessories (Continued)

Accessory Part Number Used to…
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Print accessories Table 4 lists the available print accessories.

Ethernet cross-over 
cable (6 ft.)

CB-834251 Connect a PCMCIA Ether-
net card in the TestPad to a 
laptop.

Y cable (replace-
ment)

CB-45570 Connect to the USB/Serial 
port, enabling you to con-
nect serial and USB 
devices to the TestPad.

Table 3 Connectivity accessories (Continued)

Accessory Part Number Used to…

Table 4 Print accessories

Accessory Part Number Used to…

Serial Printer PR-40B Print test configurations, 
test results, and histograms 
from the TestPad. 
– Requires DB-9 Female 

to DB-9 Male cable 
(part number: CB-
018179) to connect to 
the TestPad.

DB-9 Female to DB-9 
Male cable

CB-018179 Connect a PR-40B printer 
to the serial connector of 
the Y cable.

DB-9 Female to DB-
25 Male Cable

CB-45766 Connect a PR-40A printer 
to the serial connector of 
the Y cable.
NOTE: The PR-40A printer 
is no longer available for 
purchase. 
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Additional
accessories

Table 5 lists additional accessories available for the FST-2802.

Exploring the FST-2802
The following sections introduce you to the top, bottom, front, and LED 
display panels of the FST-2802.

USB Printer 2000-USB-
PRINTER

Print test configurations, 
test results, and histograms 
from the TestPad. The USB 
Printer connects to the 
USB connector on the Y 
cable via a cable (supplied 
with the printer).

Table 4 Print accessories (Continued)

Accessory Part Number Used to…

Table 5 Additional accessories

Accessory Part Number Connects to…

USB Portable 
Keyboard

2000-USB-KEYBRD The USB connector of the 
Y cable.

USB Mouse 2000-USB-MOUSE The USB connector of the 
Y cable.

USB Hub 2000-USB-HUB The USB connector of the 
Y cable. Connecting a USB 
hub enables you to connect 
multiple USB devices to the 
TestPad simultaneously.

2.5mm Headset 2000-HEADSET The Headset jack on the 
bottom panel of the Test-
Pad.

ATA PCMCIA 
Storage Card

2000-STORAGE The top or bottom PCMCIA 
card slot on the TestPad.
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Top panel The top panel provides the USB/Serial port, dual PCMCIA card slot, 
RJ-45 connector(s) for 10/100 Ethernet testing, and GBIC port(s) for 
1G Ethernet, 1G Fibre Channel, and 2G Fibre Channel testing. 
Figure 1 illustrates the single port configuration with one RJ-45 
connector and one GBIC port (outlined in grey).

If you purchase the dual port configuration (see Figure 2), a second 
RJ-45 connector and GBIC port is available. The Port 1 GBIC port and 
RJ-45 connector are outlined on the unit in grey; the Port 2 GBIC port 
and RJ-45 connector are outlined on the unit in blue. 

Figure 1 FST-2802 top panel (single port configuration)

USB/Serial 10/100 Mbps

!
1 Gbps / 2Gbps

PORT 1

TX RX

PCMCIA card slots

USB/Serial port

RJ-45 connector

GBIC port

NOTE:

You can easily determine which port is currently selected by looking 
at the buttons on the main screen. When Port 1 is selected, the 
buttons on the main screen are grey. When Port 2 is selected, the 
buttons are blue.

Figure 2 FST-2802 top panel (dual port configuration)
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USB/Serial port The USB/Serial port provides a 10-pin connector for the Y cable. By 
attaching the Y cable shipped with the FST-2802 (see Figure 3), you 
can connect serial devices such as a printer, laptop, or PC, and USB 
devices, such as a keyboard, mouse, printer, or hub to the TestPad. 
The serial connector of the Y cable is configured as a Data Terminal 
Equipment (DTE) connector; the USB port is configured as a USB 
host.

To connect serial and USB devices to the TestPad, first connect the Y 
cable to the TestPad. If you are connecting USB devices such as a 
mouse, keyboard, hub, or printer, you connect the device directly to 
the USB connector of the Y cable. If you are connecting a serial 
device, you connect an intermediate cable to the Y cable, and then 
connect the other end of the cable to the device.

For descriptions of each of the intermediate cables, see Table 3 on 
page 12 and Table 4 on page 14.

PCMCIA card slots Two PCMCIA card slots are provided on the TestPad. PCMCIA cards 
are available for the TestPad which allow you to establish modem, 
wireless, Ethernet, or serial connections to the TestPad and store test 
configurations, test results, and print files.

Ethernet LAN, Ethernet cross-over, and some serial cables are also 
attached to associated PCMCIA cards which are inserted in the Test-
Pad.

For descriptions of each of the connectivity cards offered as an acces-
sory by Acterna, see Table 3 on page 12.

Figure 3 Y cable

USB/Serial port connector

USB connector

Serial connector
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Bottom panel The bottom panel provides the battery access panel, headset jack, DC 
IN jack (used with the AC adapter to power the TestPad), and the 
power switch. See Figure 4.

Figure 4 FST-2802 bottom panel
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Battery access panel

Headset jack

DC IN jack

Power switch
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Front panel The front panel provides a touch-sensitive LCD screen that displays 
the user interface. The user interface allows you to set up the TestPad, 
configure tests, and display test results (see “Navigating the user inter-
face” on page 21). The power LEDs, status LEDs, speaker, and micro-
phone are also located on the front panel. See Figure 5.

Figure 5 FST-2802 front panel
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LED display panel The LED display panel provides current and historical Status and 
Alarm LEDs for each port. The inside column of LEDs indicates the 
current condition or state of the link; the outside column of LEDs indi-
cates the historical condition of the link. See Figure 6.

For a detailed description of each LED, see Chapter 7 “Test Results”.

Powering the TestPad
Power is supplied to the FST-2802 by the battery or the AC power 
adapter. To supply power using the adapter, plug the adapter into the 
DC IN jack located on the bottom panel of the FST-2802. For power 
specifications see “Electrical specifications” on page 247.

To power the TestPad
– Turn the power switch to the ON position.

The Power LED, located on the front panel, illuminates green when the 
TestPad is powered.

Figure 6 LED display panel
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WARNING:
RISK OF DAMAGE TO UNIT. Do not use the adapter supplied with 
the Acterna FST-2000 User Interface Module (UIM) with older UIMs 
labeled TTC 2000 or TestPad 2000. Do not use the adapter sup-
plied with older UIMs with the Acterna FST-2000 UIM.
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Navigating the user interface
The user interface lets you set up the TestPad, configure tests, and 
display test results. The touch-sensitive screen is divided into separate 
areas for TestPad set up, test configuration, and test results.

Application
buttons

The application buttons, located on the upper-left corner of the inter-
face, provide quick access to each test for the currently selected port. 
The buttons are organized by operating mode (MON, TERM, and for 
dual port units, THRU), rate and protocol (for example, 1G Ethernet), 
and then test.

Figure 7 FST-2802 dual port user interface
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Application buttons
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NOTE:
We recommend using the stylus supplied with the TestPad to acti-
vate functions on the touch-sensitive screen.
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RFC 2544 button The RFC 2544 button runs a script which automates the Ethernet test 
procedures recommended in RFC 2544. The script prompts you for 
key parameters, runs the tests, and then automatically generates a 
text file of results for the tests.

Port Swap button If you have a dual port FST-2802, the Port Swap button toggles 
between Port 1 (grey) and Port 2 (blue), and allows you to select a port 
before choosing a test application, configuring a test, or performing an 
action (such as turning the laser on). 

The default port is Port 1. When Port 1 is selected, the buttons on the 
main screen are grey, and “Port 1 Selected” appears on the button. 
When Port 2 is selected, the buttons are blue, and “Port 2 Selected” 
appears on the button. The THRU button for dual port units is always 
blue and grey, since thru mode applies to both ports.

The Port Swap button does not appear on the single port user inter-
face.

SETUP button The SETUP button provides access to the tabs used to configure your 
tests. After you select the port and application for a test, you select the 
Setup button to configure the test. For details on configuring a test, see 
“Step 1: Configuring a test” on page 94.

Configuration
summary bar

The configuration summary bar displays the application selected for 
each port. For example, if you select and configure a 1G Ethernet 
traffic generation test on Port 1, and a 1G Ethernet pattern test appli-
cation on Port 2, the following information appears in the configuration 
summary bar:

PORT 1:Term 1G Ethernet Traffic  Port 2:Term 1G 
Ethernet Pattern Test
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Result buttons In each result pane there is a Result Group and Result Category 
button. The Result Group button allows you to set the port for the 
results; the Result Category button allows you to set the results cate-
gory. By selecting a different port or category for each pane, you can 
view two sets of results at the same time.

Result display The test results for the TestPad appear in the result display.

Action buttons The action buttons are located above the message display. The action 
buttons perform additional functions specific to the application you 
specified for the currently selected port. A different set of action 
buttons appears each time you select a mode of operation. For 
example, if you configure a port for a 1G Ethernet, 1G Fibre Channel, 
or 2G Fibre Channel test, the Laser On/Off action button appears, 
enabling you to turn the laser on and off. The buttons may or may not 
be active depending on the application you select.

Message display The message display shows the operating mode, protocol, rate, 
status, and current events for each active port. For example, the 
message display might display a confirmation message informing you 
that a TestPad on the far end of a circuit is in loopback mode. 

– To view historical messages, select the up arrow in the message 
display. The Message History Pane appears, listing up to ten 
historical messages. 

– To close the pane and return to the main screen, select the down 
arrow.

System buttons Two system buttons are located to the right of the message display.
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Tools button Selecting the Tools button displays the Tools menu which lists the 
commands in Table 6.

Table 6 Tools menu commands

Command… Used to…

Programs Access a variety of applications, such as the 
On-screen Keyboard, PDF Viewer, and VNC 
Viewer. If you purchase the Web browser or 
VT-100 emulation options, the associated 
applications are also listed as menu com-
mands.

TestPad Settings Specify screen saver, brightness, speaker, and 
date and time settings.

Connectivity Specify parameters for printer, network, Serial 
Remote Command Line, and Remote GUI con-
nections. 

File Management Access the File Management dialog box to 
manage files and transfer files to and from the 
TestPad using FTP.

FST-2802 Settings Access the FST-2802 revision information and 
load upgrades and options. You can also reset 
the FST-2802 by clearing NOVRAM and 
returning the unit to factory default settings. 

Print Management Set up and schedule print events, create head-
ings for print output, and print test configura-
tions, test results, and histograms. 

Store/Recall Setups Access the Saved Setups dialog box. Using the 
options on the screen, you can store test con-
figurations. After you store a configuration, you 
can recall and load the configuration to auto-
matically configure a test.

AutoMATE If you purchase the scripting option, access the 
automated test scripts you develop using Tcl/
Tk.

Help Launch FST-2802 Help.

Restart Port 1 Restart the test on Port 1.

Restart Port 2 Restart the test on Port 2.
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Power Status button The Power Status button displays current battery strength by bar 
graph and percentage and indicates whether the TestPad is powered 
using an AC power adapter.

Extended Keypad The Extended Keypad is located to the right of the touch-sensitive 
screen. The keys are used to initiate specific operations on the 
TestPad (such as a test restart or screen toggle), launch the on-screen 
keyboard or online help, or access dialog boxes to control the bright-
ness of the screen and to set up print events. Table 7 describes the 
function of each key.

Restart Both Ports Restart tests on Port 1 and Port 2.
NOTE: You can also restart tests on both ports 
using the Test Restart button on the Extended 
Keypad.

Table 6 Tools menu commands (Continued)

Command… Used to…

Table 7 Extended Keypad keys

Icon Description

Restart—Press this key to restart the tests on each active 
port simultaneously. When you restart a test, the TestPad 
resets the current test result totals and clears any errors 
and/or alarms.
NOTE: If you want to restart a test on a specific port, select 
Tools > Restart Port 1 or Tools > Restart Port 2.

Toggle Screen—Press this key to toggle between applica-
tions. For example, if you launched the Web browser, press 
this key to toggle between the TestPad user interface and 
the browser.

Brightness—Press this key to access the Screen Brightness 
tab.
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Keyboard—Press this key to launch the on-screen key-
board.

Printer Setup—Displays a series of tabs which allow you to 
schedule or generate print output on the TestPad.

Help—Launches FST-2802 Help.

Table 7 Extended Keypad keys (Continued)

Icon Description

NOTE:
When you use the Remote GUI, you can use the Tools menu to 
access each of the commands associated with the Extended Key-
pad keys.
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2

This chapter provides step-by-step instructions for each of the basic 
operations you can perform using the FST-2802. Topics discussed in 
this chapter are as follows:

– “Connecting and swapping application modules” on page 28
– “Maintaining the battery” on page 30
– “Connecting a USB device” on page 33
– “Setting up the FST-2802” on page 34
– “Defining the Custom result category” on page 45
– “Restoring factory defaults” on page 46
– “Printing test configurations, test results, and histograms” on 

page 47
– “Using the on-screen keyboard” on page 61
– “Sending e-mail” on page 62
– “Launching Adobe Acrobat Reader” on page 66
– “Launching the VNC Viewer” on page 67
– “Launching the Web browser” on page 68
– “Emulating a VT100 terminal” on page 69
– “Using the Remote GUI” on page 69
– “Managing files” on page 71
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Connecting and swapping application modules
Connecting an application module involves holding it at a slight angle 
to the UIM, inserting the UIM into the application module slot, gently 
rotating the application module into a parallel position with the UIM, 
and then sliding the application module into the UIM.

Swapping application modules involves turning the TestPad off, 
disconnecting the attached application module from the UIM, and then 
attaching the new application module to the UIM.

To connect or swap application modules

1 If an application module is connected to the UIM and the TestPad 
is on, turn off the TestPad.

2 If you are swapping application modules, turn the screw on the 
front of the application module counter-clockwise to release the 
application module; otherwise, proceed to step 4.

3 Disconnect the application module from the UIM by slowly pulling 
the two modules apart, and then gently rotating the right side of 
the UIM into an upwards position.

4 On the back of the application module you are about to connect, 
verify that the following labels appear (indicating that the applica-
tion module is compatible with a Version 6 or higher UIM):
– If you are connecting a FST-2802, verify that a label appears 

stating “Version 6 Compatible”.
– If you are connecting any other application module, verify that 

a label appears stating “FST-2000 INTEROPERABLE”.

NOTE:
FST-2802’s which are compatible with the Version 6 UIM are identi-
fied with a “Version 6 Compatible” label on the back of the applica-
tion module.

FST-2802 application modules running software version 3.0 and 
higher require a Version 6 or higher UIM. If you connect a FST-2802 
application module running software version 3.0 or higher to an 
older UIM, a message will appear on the user interface instructing 
you to remove the application module and attach it to a newer UIM.
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5 While holding the application module at a slight angle (see 
Figure 8), insert the bottom right corner of the UIM no more than 
1/4 inch into the inside bottom edge of the application module slot.

6 Gently rotate the application module into a parallel position with 
the UIM (see Figure 9 on page 29).

Figure 8 UIM insertion into application module slot

Figure 9  Rotating the application module

Application moduleUIM

Rotate
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7 Slide the application module into the UIM, keeping the two 
modules parallel at all times (see Figure 10).

8 Turn the screw clockwise to secure the TestPad.

The TestPad is ready for use.

Maintaining the battery
The TestPad comes equipped with a rechargeable Nickel-Metal 
Hydride (NiMH) battery. The battery life of a fully-charged battery 
varies depending on the type of functions that you are performing.

CAUTION: DAMAGE TO TESTPAD
If you attempt to connect the UIM and application module at an 
angle, you may damage the TestPad. Be certain to align the UIM 
and application module in a parallel position before connecting the 
modules.

Figure 10 UIM and application module connection

NOTE:
When you turn the TestPad on for the first time, the UIM and the 
application module require several minutes to initialize the software. 
Do not turn the power off during initialization or you may corrupt the 
files.
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If the battery is not charged with sufficient capacity to power the 
TestPad, the TestPad will not completely power up, and the LOW 
BATTERY LED will illuminate. You can power the TestPad and 
recharge the battery using the supplied AC adapter.

To prolong the life span of the battery, follow the guidelines below:

– Store the battery in a cool, dry, and clean environment. Do not 
leave the battery in a car or truck, particularly during extremely 
warm weather.

– Use the AC adapter to power up the TestPad the first time you use 
the TestPad, or after prolonged storage.

– Before using the battery to power the TestPad, check the battery 
capacity.

– If the battery capacity is depleted or if the battery has been stored 
for a prolonged period, use the Acterna battery charger to charge 
the battery. Do not use an un-approved charger.

– Condition the battery after prolonged storage or 30 cycles of use. 
To condition the battery, deeply discharge the battery, and then 
recharge the battery fully three times.

– If the TestPad will not be used for more than a week, remove the 
battery.

– Do not charge the battery after exposure to extremely hot or cold 
temperatures.

– If the battery capacity is depleted and you are not ready to 
recharge the battery, turn the TestPad power OFF.

– Always carry a fully charged spare battery.

Viewing the
battery charge

status

To view the battery charge status
– Look at the Power Status button on the user interface. The button 

displays the current battery strength using a bar graph and 
percentage.
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Charging the
battery

The Low Battery LED illuminates when the battery is below 25 percent 
capacity. You can recharge the battery using an AC adapter.

To charge the battery 

1 Turn off the TestPad.

2 Verify that the battery is cool to the touch. If the battery is warm, 
wait for it to cool down before proceeding to step 3.

3 To start a new charge cycle, or to restart a charge cycle that was 
terminated, do one of the following:
– If the battery is already in the TestPad, insert or reinsert the AC 

adapter.
– If the AC adapter is already plugged in, insert or reinsert the 

battery into the TestPad.

4 Let the battery charge for up to two hours depending on the 
current charge state of the battery.

The battery is charged.

Replacing the
battery

The following procedure describes how to replace the battery in a 
TestPad. 

NOTE:
Environmental conditions such as the temperature of the battery 
may cause the charging process to terminate before the battery is 
completely recharged. The internal battery charger can operate 
when the TestPad is on; however, to ensure a complete recharge, 
turn the TestPad off, remove the AC adapter, and then verify that 
the battery is cool to the touch before beginning a new charge 
cycle.

CAUTION: DANGER OF EXPLOSION
Risk of explosion if battery is replaced with an incorrect type.

Replace with the same or equivalent type recommended by the 
manufacturer. Dispose of used batteries according to the manufac-
turer’s instructions.
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To replace the battery 

1 Turn off the TestPad or connect AC power. 

2 Unlock the battery access panel by turning the screw counter-
clockwise. See Figure 4 on page 18.

3 Open the battery access panel.

4 Pull the strap to remove the battery.

5 Align the new battery with the terminals facing up and pointing 
toward the battery compartment.

6 Verify that you can read the terminal markings (-) V D C (+) at the 
top end of the battery.

7 Slide the new battery into the battery compartment until the termi-
nals click into place. 
The bottom of the battery should be about 0.25 inches (0.635 
centimeters) inside the compartment.

8 Close the battery access door, and then lock the door by turning 
the screw clockwise.

9 If the TestPad is on, you can resume testing. If you turned the 
TestPad off, turn it on to resume testing.

The battery is replaced.

Connecting a USB device
You can connect a USB keyboard, mouse, or printer to the TestPad. If 
you want to use more than one USB device simultaneously, you can 
connect a USB hub to the TestPad, and then connect each device to 
one of the four ports available on the hub.

To connect a USB device to the TestPad

1 Turn the TestPad power ON.

NOTE:
The battery can be “hot swapped” which means if AC power is con-
nected, you can replace the battery without affecting the current 
test.
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2 Insert a Y cable into the USB/Serial port. This cable provides a 
USB connector.

3 Do one of the following:

The USB device is connected.

Setting up the FST-2802
Setting up the FST-2802 involves specifying a password for the 
Remote GUI, and specifying various settings for the TestPad such as 
the date and time format, screen saver, screen brightness, and 
speaker volume. It may also involve loading software upgrades and 
options.

NOTE:
You must connect the Y cable to the USB/Serial port before you 
connect the keyboard, mouse, printer, or hub cable to the USB con-
nector.

To… Do this…

Connect a keyboard or mouse Insert the keyboard or mouse 
cable into the USB connector of 
the Y cable.

Connect a printer Attach one end of the printer 
cable (supplied with the printer) 
to the printer, and then attach the 
other end to the USB connector 
of the Y cable.

Connect a USB hub Attach the hub cable to the USB 
connector of the Y cable, and 
then connect the USB devices to 
the hub.

NOTE:
The TestPad also provides an on-screen keyboard which allows 
you to type by tapping keys on a keyboard displayed on the touch-
sensitive screen. For instructions on using the on-screen keyboard, 
see “Using the on-screen keyboard” on page 61.
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Specifying a
Remote GUI

password

If you intend to use the Remote GUI to control the TestPad from a 
remote PC or laptop, you must specify a Remote GUI password to 
secure access to the TestPad. Each time you initiate a Remote GUI 
session, you’ll be required to enter the password. 

The default Remote GUI password is acterna.

To specify a Remote GUI password

1 Select Tools > Connectivity.
The Connectivity Menu appears.

2 Select Remote GUI.
The Remote GUI Password dialog box appears.

3 In Remote GUI Password, type a password using up to eight 
characters, and then select OK. 

The Connectivity Menu appears, and the Remote GUI password is set.

Specifying date
and time settings

By default, the TestPad presents dates on print files using a standard 
MM/DD/YYYY format, and time using a standard Hour:Minute:Second 
format. You can change the date, time, or format at any time. 
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To specify date and time settings

1 Select Tools > TestPad Settings.
A series of setup tabs appears.

2 Select Time/Date.

3 To specify the settings, do the following:

To… Do this…

Set the date format In Set Date Format, select a date format.

Set the time format In Set Time Format, select a time format.

Set the date Select the arrow to the right of the Set Date 
field. A calendar appears. Do one of the fol-
lowing:
– To select a date from the month and 

year displayed, simply select the date.
– To navigate through the calendar to 

select a date from a different month or 
year, use the arrows at the top of the 
calendar to display the month, and then 
select the date.
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4 Select OK.

The date and time settings are specified.

Setting up the
screen saver

The TestPad is equipped with a screen saver. You can setup the 
TestPad to use the screen saver, or you can disable the screen saver 
entirely. If you use the screen saver, you can specify how much time 
must elapse before the TestPad displays the screen saver, and you 
can optionally display a blank screen or a scrolling message whenever 
the screen saver appears.

To set up the screen saver

1 Select Tools > TestPad Settings.
A series of setup tabs appears.

Set the time In Set Time, select the hour, minutes, or 
seconds you want to modify, and then select 
the up or down arrow to the right of the field 
to increase or decrease the value in incre-
ments of one.

To… Do this…
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2 Select Screen Saver.

3 If you do not want to use a screen saver, under User a Screen 
Saver, select Never, and then proceed to step 4.
If you do want to use a screen saver, do the following:

a Select an option for Use a Screen Saver.

b Select a screen saver style: Blank Screen or Scrolling 
Message.

c If you selected Scrolling Message, select Edit to display the 
Enter new message dialog box, and then type the message.
Select OK to return to the Screen Saver tab.

d Select the time to elapse before the screen saver appears.

4 Select OK.

The screen saver is set up.

Setting the screen
brightness

You can control the screen brightness on the TestPad. Higher bright-
ness provides greater clarity when viewing the user interface.
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To set the screen brightness

1 Select Tools > TestPad Settings.
A series of setup tabs appears.

2 Select Brightness.

3 Under Brightness Setting, drag the pointer to the level of bright-
ness you want to use for the screen.

4 Select OK.

The screen brightness is set.

Specifying
speaker settings

You can control the speaker volume on the TestPad or mute the 
speaker entirely. You can also setup the TestPad to beep whenever 
you insert or remove a PCMCIA card or whenever you select a button 
on the user interface.

To specify speaker settings

1 Select Tools > TestPad Settings.
A series of setup tabs appears.
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2 Select Speaker.

3 To control the speaker’s volume, do one of the following:
– If you want to adjust the speaker volume, under Speaker 

Volume, drag the pointer to the level of volume you want the 
speaker to use.

– If you want to mute the speaker volume entirely, select Mute 
Speaker.

4 To set up the TestPad to beep whenever you insert or remove a 
PCMCIA card or select a button on the user interface, select 
Enable Beep.

5 Select OK.

The speaker settings are specified.

Loading options
and software

upgrades

If you purchase options or obtain an FST-2802 or UIM software 
upgrade, you receive a PCMCIA card with the software for the options 
or upgrade. Loading options or FST-2802 software upgrades involves 
inserting the PCMCIA card into a PCMCIA card slot, loading the soft-
ware, and then waiting for the TestPad to reboot. Loading options is 
typically a quick process; loading an FST-2802 software upgrade 
takes longer.
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For instructions on loading UIM software upgrades, refer to the 
upgrade instructions provided with the upgrade card.

Loading options You can load options from a single PCMCIA card or from two separate 
PCMCIA cards simultaneously.

To load options

1 Insert the PCMCIA card or cards with the options in a PCMCIA 
card slot.

2 Select the Tools button, and then do one of the following:
– To load UIM options, select TestPad Settings, and then select 

the Revisions/Options tab.
– To load FST-2802 settings, select FST-2802 Settings. The 

Revisions/Options tab appears.

Currently installed options on the TestPad appear under TestPad 
Options or FST-2802 Options.

3 Select Install Options.
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The Options Installation dialog box appears, listing the options 
available on the PCMCIA card (or cards).

The Number Remaining field indicates the remaining copies of the 
option which are available for installation. Each time you install an 
option, the TestPad decreases the number remaining by one.

4 Select the option or options you want to install.

5 Select Install & Reboot.

NOTE:
If you inserted two PCMCIA optioning cards into the TestPad, and 
both cards include the same option, the option appears twice in the 
list of options.
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The TestPad installs the options, and then the Install Options 
dialog box appears.

6 Select OK to acknowledge the message.

The TestPad reboots and the options are available.

Loading an FST-2802
software upgrade

Before you load an FST-2802 software upgrade, you must power the 
TestPad using an AC adapter. We also recommend using a battery 
charged to at least 50 percent capacity as a backup power supply.

If you insert a PCMCIA card into the TestPad with an FST-2802 soft-
ware upgrade before you turn the TestPad on, the TestPad automati-
cally detects a new version of the software when it boots up and asks 
if you want to upgrade the software.

Loading the upgrade typically takes about forty-five minutes.

To load a software upgrade

1 Insert the software upgrade card into a PCMCIA card slot.

2 Connect the AC adapter to the DC IN jack (located on the bottom 
panel of the TestPad), and then plug it in to an electrical outlet.

CAUTION: DAMAGE TO TESTPAD

When you load a software upgrade, the TestPad deletes all existing 
application module software, automatically reboots, and then loads 
the upgrade. Therefore, if power is interrupted during the course of 
the upgrade, the TestPad may require factory service to operate.
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3 Turn the TestPad power ON.
The TestPad displays a series of boot-up messages. When the 
boot-up is complete, a dialog box appears informing you that a 
newer version of the application module software has been 
detected and prompts you to upgrade the software.

4 Select OK.
The TestPad displays the following warning:
WARNING

DO NOT TURN POWER OFF AT THIS TIME.

Transfer of system files in progress. System may 
require factory service if power fails during 
transfer.

At the bottom of the screen, a box appears which shows the 
percentage of each file transferred during the upgrade.

After the last file is transferred, the TestPad reboots.

The software upgrade is loaded.

NOTE:
Between file transfers, a message appears informing you that the 
TestPad is preparing the system for another file transfer and advis-
ing you to be patient. It may take a couple of minutes for the Test-
Pad to begin transferring the next file.

NOTE:
If you insert a PCMCIA upgrade card after you turn the TestPad on, 
you can select Tools > FST-2802 Settings to display the Revisions/
Options tab, and then select the Revision Upgrade option to load 
the upgrade.
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Defining the Custom result category
You can define a Custom result category with results from a variety of 
categories. This allows you to quickly view the results on a single result 
pane without navigating through each individual category.

To define the Custom result category

1 Select Tools > FST-2802 Settings.
The Reset tab appears.

2 Select the Custom Results tab.

3 Select the results you want to view in the Custom category from 
the Available list, and then do one of the following:
– Use the > and < arrows to move single results between the 

Available and Selected list boxes. 
– Use the << arrows to move all selected results back to the 

Available list box.

4 Select OK to return to the main screen.

Results are selected for the Custom result category.
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Restoring factory defaults
You can restore the FST-2802 settings to the factory defaults using the 
Clear NOVRAM feature. When you clear NOVRAM, the TestPad 
restores the following settings for each port:

– Test applications. All test applications for the FST-2802 are 
restored to their default values.

– Print Management settings. The print management settings are 
restored to their default values.

To restore factory defaults

1 Select Tools > FST-2802 Settings.
The Reset tab appears.

2 Select Clear NOVRAM.
The TestPad restores the FST-2802 settings back to the factory 
defaults. This typically takes about ten seconds, and then a 
message appears informing you that the settings are restored.

3 Select OK to acknowledge the message.

The TestPad reboots, and the settings are restored.
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Printing test configurations, test results, and histograms
You can print test configurations, test results, and histograms from the 
TestPad. Printing involves connecting a printer, and then specifying 
print parameters such as the print mode, print type, and print event 
triggers. If you connected a serial printer, you must also configure the 
printer.

After you specify the print parameters, you are ready to generate print 
output. When you generate print output, you can do the following:

– Encrypt the output to ensure the integrity of the data you sent to 
your supervisor or Technical Support department.

– Send the output directly to a printer.
– Store the output in a file on the TestPad to print at a later time. 
– Automatically e-mail the output. For example, if you want your 

Technical Support department to review your test results, you can 
set up the TestPad to automatically e-mail the results to the 
department.

The following sections introduce you to some basic concepts about 
printing, and then describe how to connect a printer, configure a serial 
printer, specify print parameters, and print your print files.

Printing to text
files

The first time you generate print output, by default, the TestPad 
appends the output to the default print file, default.txt in the 
following directory:

Acterna\Files\FST-2802

NOTE:
If your FST-2802 has two ports, and both ports are active, the Test-
Pad generates output for each active port. For example, if you are 
testing using both Port 1 and Port 2, print output of test results will 
list test results for Port 1 first, and then the test results for Port 2.
FST-2802 TestPad User’s Guide Revision A 47



Chapter 2 Basic Operations
Printing test configurations, test results, and histograms
When you specify print parameters for the output, you can do the 
following:

– You can clear the output in the default.txt file, and then 
repopulate the file with new output.

– You can direct the print output to a new or different .txt file.

Encrypting print
files

You can optionally encrypt print files by selecting the Encrypt print file 
option on the Print Setup tab. When you generate an encrypted print 
file, the TestPad creates two files: the standard text (.txt) file, and 
an additional encrypted (.crp) file. For example, if you generate a 
print file named “1GPatt”, the TestPad creates the following files:

– 1GPatt.txt

– 1GPatt.crp

Sending an encrypted
print file

You can send an encrypted print file to your supervisor or Technical 
Support department by selecting the option to automatically email the 
file after it is generated (see “Sending e-mail” on page 62) or using 
FTP (see “Managing files” on page 71).

The first time you send an encrypted (.crp) file to your supervisor or 
Technical Support department, you need to send the decrypt.exe 
executable which enables them to read the encrypted file. The file is 
located at:

[SYS] Z:/decrypt.exe

Reading an encrypted
print file

To read an encrypted print file, you must launch decrypt.exe using 
the print filename as a parameter. For example, if the encrypted file’s 
name is 1GPatt.crp, use the following command to launch the 
executable:

decrypt.exe 1GPatt.crp

The executable converts the encrypted (.crp) file to a text (.txt) file.
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Print modes Print modes identify the way you want to generate print output: manu-
ally, at timed intervals, or when a test ends. You specify the print mode 
for your print output in the Print Mode field of the Setup tab.

Print types Print types represent the type of information you want to include in the 
print output (all test results, test results for a selected group of catego-
ries, test configurations, or histograms). When you specify print 
parameters, you specify the print type for your print output in the Print 
Type field of the Setup tab.

Print event
triggers

Print event triggers cause the TestPad to generate print output when-
ever the event (a result change, test restart, or a remote user connects 
or disconnects to the TestPad) occurs. The event output includes a 
date and time stamp indicating when the event occurred.

Connecting a
printer

The USB/Serial port, located on the top panel, is used to connect the 
standard Y cable provided with the TestPad. The Y cable provides a 
USB connector and a serial connector, allowing you to connect a USB 
printer, such as the 2000-USB-PRINTER, or serial printer, such as the 
PR-40B to the TestPad.

To connect the printer

1 Turn on the TestPad.

2 Attach the Y cable to the USB/Serial port.

NOTE:
To print test configurations (controls) and histograms, you must 
generate print output in manual mode.
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3 Do one of the following:
– If you are connecting a serial printer, using the supplied printer 

cable, connect the DB-9 female connector on the printer cable 
to the serial connector on the Y cable, and then connect the 
DB-9 male connector on the printer cable to the printer.

– If you are connecting a USB printer, using the supplied printer 
cable, connect the cable to the USB connector of the Y cable, 
and then connect the other end of the printer cable to the 
printer.

By default, the baud rate for the serial printer interface is 9600, and the 
parity method is none. If you need to change these settings, see 
“Configuring a serial printer” on page 50.

Configuring a
serial printer

Configuring a serial printer involves specifying the printer device, and 
then specifying the communications parameters, such as the baud 
rate, data bits, parity, stop bits, and flow control.

To configure a printer

1 Select Tools > Connectivity.
The Connectivity Menu appears.

2 Select Serial Printer.

NOTE:
When connecting to the PR-40B serial printer, use the printer cable 
provided with the printer. Operability of the printer port cannot be 
guaranteed if you use a cable longer than 3 meters.
50 FST-2802 TestPad User’s Guide Revision A



Chapter 2 Basic Operations
Printing test configurations, test results, and histograms
The Printer Configuration dialog box appears.

3 If you have either a serial card or a Y cable connected to the 
TestPad, the serial printer device available appears automatically 
under Serial Printer Device.
If you have both a serial card and a Y cable connected to the 
TestPad, under Serial Printer Device, select Serial Card to 
connect via a card, or Serial Port to connect via the serial port on 
the Y cable.

4 Specify the settings for the printer, and then select OK. Default 
values for each of the settings are as follows:
– Baud rate: 9600
– Data bits: eight
– Parity: None
– Stop bits: None
– Flow control: None

The printer is configured.

NOTE:
You can also use the Configure option on the Setup tab to configure 
a printer when you specify print parameters.
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Creating a
heading for print

output

You can create a custom heading for print output. These headings are 
particularly helpful if you append print output to the same print file each 
time you print. By defining unique headings for your print output, you 
can easily identify the output associated with each test.

To create a heading

1 Select Tools > Print Management.
A series of print management tabs appear.

2 Select Headings.

3 In Heading Line 1, type the first heading you want to appear on 
the print file.

4 If you want a second and third heading, type the headings in the 
corresponding fields.

5 Select Setup to return to the Setup tab, or OK to return to the 
main screen.

The heading is created and will appear above your print output.
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Generating print
output

Generating print output involves specifying the print mode, specifying 
a print type (and defining print type parameters, if necessary), and 
then selecting the Generate button to generate the print output imme-
diately, or scheduling the TestPad to automatically generate print 
output.

To generate print output

1 Select Tools > Print Management.
The Setup tab appears.

2 In Mode, select one of the following print modes:

Select To…

Manual Manually generate print output. Proceed to 
step 4.

Timed (Repeating) Generate print output at regularly scheduled 
intervals. 
For example, if you want the TestPad to gen-
erate test results output every ten minutes, 
select the Timed (Repeating) print mode, 
and then proceed to step 3 to specify the 
interval between generated print output.
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If you selected Timed (Repeating) or Timed (Test End), fields 
appear on the Setup tab which allow you to specify the interval 
between TestPad generated print output or the amount of time that 
will pass after a test restart before a test ends.

3 In Hours and Mins, type the hours or minutes, or select the up 
and down arrows next to the fields to increase or decrease the 
displayed value.

Timed (Test End) Generate print output whenever a test ends.
For example, if you want the TestPad to gen-
erate test results output when a test ends in 
thirty minutes, select the Timed (Test End) 
print mode, and then proceed to step 3 to 
specify the amount of time after a test restart 
(thirty minutes) that will pass before the test 
ends.

Select To…

NOTE:
You must select Manual mode to print test configurations (controls) 
and histograms.
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4 In Type, select one of the following print types:

5 If you chose Selected Categories as the print type in step 4, select 
the Categories tab to choose the categories for the print output, 
and then do the following:

a To select categories, use the > and < arrows to move single 
categories between the Available and Selected list boxes, or 
use the >> and << arrows to move all categories.

b Proceed to step 7.

Select… To…

All Results Print all test results for a test. Proceed to 
step 7.

Selected Categories Print test results for a specific group of cate-
gories. Proceed to step 5.

Controls Print the configuration for a test. Proceed to 
step 7.

Histogram Print specific results based upon the histo-
gram configuration. Proceed to step 6.
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6 If you selected Histogram as the print type in step 4, see “Setting 
up a histogram” on page 57 for instructions on setting up histo-
gram output, and then proceed to step 7.

7 Optional. If you want the TestPad to generate print output when-
ever you restart a test, a result changes, or a remote user 
connects or disconnects to the TestPad, select the Event tab, and 
then select Test Restart, Result Change, or Remote User 
Connect/Disconnect.

8 Return to the Setup tab.

9 Optional. If you want to clear the displayed print file, or direct the 
print output to a new or different file, do one of the following:

10 Optional. If you want to send the output directly to a printer, select 
Send output directly to a printer, and then select the printer you 
want to direct the output to (Serial or USB).

11 Optional. If you want to email the output when it is generated, 
select Email on print. See “Sending e-mail” on page 62 for 
instructions on sending e-mail from the TestPad.

To… Do this…

Clear the displayed 
print file, and then re-
populate the file with 
new output

Select Clear File.

Direct the print output 
to a new file

Choose Select File to display the File Man-
agement dialog box, and then do the fol-
lowing:
– Select the File Name field. An Acterna 

keypad appears.
– Type the new file name.
– Select OK to return to the Setup tab.

Direct the print output 
to a different file

Choose Select File to display the File Man-
agement dialog box, and then do the fol-
lowing:
– Under File Name, select the file you 

want to direct the output to.
– Select OK to return to the Setup tab.
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12 Optional. If you want to encrypt the output, select Encrypt print 
file.

13 Select Generate or Print File.

14 If you want to store the print settings you specified, select OK to 
return to the Main Screen. If you do not want to store the print 
settings, select Cancel.

If you sent the print output directly to a printer, the TestPad prints the 
output and sends the output to the .txt file you specified. If you sent 
the print output to a file, the output is stored in the .txt file to be 
printed at a later time.

Setting up a
histogram

A histogram is print output of test results in a bar graph format. Histo-
grams enable you to quickly identify spikes and patterns of errors over 
a specific interval of time. Figure 11 shows a sample Histogram 
printout.

Each time you run a test, the TestPad automatically accumulates data 
for a histogram in the histogram buffer. Whenever you start a new test, 
the histogram buffer clears, and then populates with data from the new 
test.

You can choose which results to collect for the histogram print output, 
and when the TestPad will collect the samples. If your FST-2802 has 
two ports and you are running tests on both ports, the TestPad will 
create a separate histogram for each test.

To set up histogram print output

1 Select the Tools button.
The Tools Menu appears.

Figure 11 Histogram printout
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2 Select Print Management.
The Setup tab appears.

3 In Mode, select Manual.

4 In Type, select Histogram.

5 Select the Histogram Setup tab.

6 Under Start, do one of the following:
– Select First Sample to select all available data for the print 

output from the moment the test starts.
– Select Start Date/Time to specify the start data and time for 

data collection for the histogram. If you select this option, you 
must type the date and time the TestPad will start collecting 
data in the associated fields.

NOTE:
You cannot print histograms in Timed (Repeating) or Timed (Test 
End) modes.
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7 Under End, do one of the following:
– Select Last Sample to select all available data for the print 

output from the moment you select Generate to generate 
output for the histogram.

– Select Set Duration to specify a duration of time during which 
the TestPad will collect data for the histogram. If you select this 
option, you must type the days, hours, and minutes for the 
duration in the associated fields.

8 Under Bar Interval, type the hours and minutes represented in 
each histogram bar.

9 Select the Histogram Results tab.

10 To select the result categories for the histogram, do one of the 
following:

a Select the categories you would like to include in the print 
output. Use the > and < arrows to move single categories 
between the Available and Selected list boxes. Use the >> and 
<< arrows to move all categories.

b Select OK.
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11 In Printer, select the printer you want to direct the histogram output 
to (Serial or USB).

12 Optional. If you want to send the histogram directly to a printer, 
select Send output directly to a printer.

13 Optional. If you want to email the histogram when it is generated, 
select Email on print. See “Sending e-mail” on page 62 for 
instructions on sending e-mail from the TestPad.

14 Select Generate or Print File.

If you sent the histogram directly to a printer, the TestPad prints the 
histogram and sends the output to the .txt file you specified. If you 
sent the histogram to a file, the output is stored in the .txt file to be 
printed at a later time.

Viewing stored
print files

You can view stored print files using the View File button on the Setup 
tab.

To view a stored print file

1 Select Tools > Print Management.
The Setup tab appears.

2 Under File, the most recently created print file appears. Do one of 
the following:
– To view the displayed print file, proceed to step 3.
– To view a different print file, choose Select File, and then 

select the print file you want to view.

NOTE:
The result categories available for a histogram depend on the cur-
rent test configuration. Each time you configure a test using the 
same settings, the histogram categories you selected previously for 
the configuration are automatically available; however, you can edit 
the categories at any time.

NOTE:
You can also view stored print files from the File Management dia-
log box. See “Viewing, running, deleting, or renaming a file” on 
page 75.
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3 Select View File.

The print file appears in the Print Viewer dialog box.

Printing a stored
print file

You can print stored print files using the Print File button on the Setup 
tab. 

To print a stored print file

1 Select Tools > Print Management.
The Setup tab appears.

2 Under File, the most recently created print file appears. Do one of 
the following:
– To print the displayed print file, proceed to step 3.
– To print a different print file, choose Select File, and then 

select the print file you want to print. 

3 Select Print File.

The print file is printed.

Using the on-screen keyboard
The FST-2802 provides an on-screen keyboard, which you can use to 
type information in the active window when you use the Web browser, 
use the VNC Viewer, or emulate a VT100 terminal using the TestPad.

To use the on-screen keyboard

1 Press the Keyboard key.
The on-screen keyboard appears.

2 In the active window, tap the field you need to type in.

NOTE:
You do not need to use the on-screen keyboard to type data in the 
FST-2802 user interface; a virtual keyboard is available whenever 
typing is required. If you need to type a lot of information, we recom-
mend using a USB keyboard.
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3 Tap the keys on the on-screen keyboard to type text in the field. To 
type a symbol, tap the Shift key. The numeric keys change to 
symbol keys. Type the symbol. The symbol keys change back to 
numeric keys. You must tap the Shift key each time you need to 
type a symbol.

After you launch the on-screen keyboard, you can:

– Move the keyboard to a different location by dragging the title bar.
– Minimize the keyboard.
– Maximize the keyboard by pressing the Keyboard key.
– Type all capital letters by first tapping the Caps Lock key.

Sending e-mail
If you purchased the Networking option, you can send e-mail from the 
TestPad. Before you send e-mail, you must establish a modem dial-
out, modem dial-in, or LAN connection to connect to a Simple Mail 
Transfer Protocol (SMTP) server.

When you compose e-mail, you can:

– Populate the Address Book with e-mail addresses.
– Type messages.
– Attach print files containing test results, test configurations, or 

histogram data.

NOTE:
To optimize performance of the TestPad, secondary features of the 
on-screen keyboard such as online help have been disabled.

NOTE:
The first time you compose an e-mail on the TestPad, you must 
specify the address for an SMTP server. Internet Service Providers 
(ISPs) typically provide an SMTP server. After you specify the 
SMTP server for the first e-mail, the TestPad stores the server 
address and provides it automatically each time you compose a 
new e-mail.
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To send an e-mail

1 Establish a modem dial-out, modem dial-in, or LAN connection 
from the TestPad to a network for Internet access.
– For detailed instructions on establishing a modem dial-out 

connection, see “Establishing modem dial-out connections” on 
page 83.

– For detailed instructions on establishing a modem dial-in 
connection, see “Establishing modem dial-in connections” on 
page 85.

– For detailed instructions on establishing a LAN connection, see 
“Establishing LAN connections” on page 87.

2 On the TestPad, select the Tools > Connectivity.
The Connectivity Menu appears.

3 Select Email.
The E-mail dialog box appears.

4 In SMTP, type the SMTP server address. The SMTP server 
address is typically one of the following:
– smtp.internet provider name.com 
– smtp.internet provider name.net
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where internet provider name represents the name of the 
company providing your internet service.

5 In From, type the address of an e-mail account you can retrieve 
messages from.

6 In Subject, type the subject of the e-mail.

7 To specify the destination e-mail address, under To:, select Add.
The Address Maintenance dialog box appears.

If you added addresses to the Address Book previously, the 
addresses appear in the Address Book.

NOTE:
You can not retrieve and read e-mail messages using the FST-2802 
user interface; however, if you purchased the Networking and the 
Web browser option, you can use the browser to access e-mail from 
an ISP account.
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8 Do one of the following:

9 If you are adding an address, do the following:

a Type the address in the field provided. To type the “@” symbol, 
select the Shift key.
The numeric keys change to symbol keys.

To… Do this…

Select an existing address from 
the address book

– Under Address Book, select 
the address, and then select 
>> to copy the address to the 
“To” List. 

– Proceed to step 10.

Add a new address to the 
address book

– Select Add to Address 
Book. A keyboard dialog box 
appears allowing you to type 
the new address.

– Proceed to step 9.

Add a new address without add-
ing it to the address book

– Select Add to “To” List. A 
keyboard dialog box appears 
allowing you to type the new 
address.

– Proceed to step 9.
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b Select OK to return to the Address Maintenance dialog box.
The new address appears in the Address Book or “To” List. 

10 Select OK to return to the E-mail dialog box. 
The To: address is automatically populated.

11 If you want to attach a file to the e-mail, do the following:

a Under Attach, select Add.
The Select Attachment dialog box appears.

b Navigate to the file you want to attach, and then select the file.

c Select OK to return to the E-mail dialog box.
The file appears in the attached box.

12 In Message, type the message to send with the e-mail, using up 
to 100 characters.

13 Select Send.

The TestPad sends the e-mail to the address you specified.

Launching Adobe Acrobat Reader
The FST-2802 provides Adobe Acrobat Reader, which enables you to 
read .PDF files on the TestPad.

To launch Adobe Acrobat Reader
– Select the Tools > Programs > PDFReader.

Acrobat Reader is launched.

NOTE:
To optimize performance of the TestPad, secondary features of 
Acrobat Reader such as online help have been disabled.
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Launching the VNC Viewer
If you purchased the Networking option, you can run remote applica-
tions from the TestPad using the VNC Viewer. 

For example, if you have a laptop in your truck which is running a work 
order application and a VNC server, and you are using the TestPad to 
test a circuit, after you complete the test, you can close out the work 
order from the TestPad without returning to your truck. To close the 
work order, you do the following:

– Establish an 802.11b or Bluetooth connection from the TestPad to 
the laptop.

– Launch the VNC Viewer on the TestPad.
– View the laptop’s work order application.
– Close the work order.

Before you launch the VNC Viewer, you must first establish a modem 
dial-out, modem dial-in, or LAN connection to the network or laptop the 
VNC server is running on. 

To launch the VNC Viewer

1 Establish a modem dial-out, modem dial-in, or LAN connection 
from the TestPad to the network or laptop the server is running on.
– For detailed instructions on establishing a modem dial-out 

connection, see “Establishing modem dial-out connections” on 
page 83.

– For detailed instructions on establishing a modem dial-in 
connection, see “Establishing modem dial-in connections” on 
page 85.

– For detailed instructions on establishing a LAN connection, see 
“Establishing LAN connections” on page 87.

2 Connect a USB keyboard, or press the Keyboard key to launch 
the on-screen keyboard.

3 Select Tools > Programs > VNC Viewer.
The Connection Details dialog box appears.

4 In VNC server, type the IP address or computer name of the 
device running the server.
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5 If required, log into the server by typing a password.

The desktop for the device running the VNC server appears.

Launching the Web browser
If you purchased the Networking and Web browser options, you can 
launch a Web browser from the FST-2802. You can use the Web 
browser to view and retrieve intranet or Internet content (such as 
methods and procedures or engineering records) and configure 
network equipment.

Before you launch the Web browser, you must first establish a modem 
dial-out or LAN connection to a network.

To launch the Web browser

1 Establish a modem dial-out or LAN connection.
– For detailed instructions on establishing a modem dial-out 

connection, see “Establishing modem dial-out connections” on 
page 83.

– For detailed instructions on establishing a LAN connection, see 
“Establishing LAN connections” on page 87.

2 Connect a USB keyboard, or press the Keyboard key to launch 
the on-screen keyboard.

3 Select Tools > Programs > Web browser.
The Internet Explorer browser appears.

4 Verify your browser connection by typing the address for the site 
you want to access. If the browser displays the site, the connec-
tion is established.

NOTE:
To optimize performance of the TestPad, secondary features of the 
VNC Viewer such as online help have been disabled.

NOTE:
To optimize performance of the TestPad, secondary features of the 
Web browser such as online help have been disabled.
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Emulating a VT100 terminal
If you purchased the VT100 option, the FST-2802 can emulate a 
VT100 terminal. When you use the TestPad to emulate a VT100 
terminal, the TestPad launches a HyperTerminal session. You can use 
the session to retrieve performance information from network 
elements and configure the elements.

Before starting VT100 emulation, you must first establish a serial 
connection to the network element.

To emulate a VT100 terminal

1 Establish a serial connection. For detailed instructions on estab-
lishing a serial connection, see “Establishing serial connections” 
on page 81.

2 Press the Keyboard key to launch the on-screen keyboard.

3 Select Tools > Programs > VT100.
The HyperTerminal session window appears.

4 The menu for the network element appears after a few seconds. 
Verify that you can retrieve information from the network element.

5 Use the menu selections to retrieve performance information or 
configure the element.

6 Select File > Exit to end the HyperTerminal session.

Using the Remote GUI
If you purchased the Networking option, you can run the TestPad 
remotely from any device with a Web browser using a VNC session. 
You can use the Remote GUI to perform any of the tests available for 
the FST-2802. 

NOTE:
To optimize performance of the TestPad, secondary HyperTerminal 
features such as the ability to add a printer and online help have 
been disabled.
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When you set up the TestPad, you should specify a Remote GUI pass-
word to restrict remote access to the TestPad. For detailed instruc-
tions, see “Specifying a Remote GUI password” on page 35.

Before you run the Remote GUI, the TestPad must be connected to the 
network your PC or laptop is connected to via a modem dial-in, modem 
dial-out, or LAN connection, or locally via a USB connection. You also 
need the IP address or computer name of the TestPad. 

Determining the
TestPad’s IP

address or
computer name

To determine the TestPad’s IP address or computer name 

1 On the TestPad, select Tools > Connectivity.
The Connectivity Menu appears.

2 Select the Network Info tab.

The TestPad’s IP address and computer name appear.

Running the
Remote GUI

To run the Remote GUI

1 Establish a network connection to the TestPad.
– For detailed instructions on establishing a modem dial-out 

connection, see “Establishing modem dial-out connections” on 
page 83.

– For detailed instructions on establishing a modem dial-in 
connection, see “Establishing modem dial-in connections” on 
page 85.

– For detailed instructions on establishing a LAN connection, see 
“Establishing LAN connections” on page 87.

2 From the laptop or PC, launch a Web browser.

3 Type the following address:
http://ip address:5800
Where ip address is the IP address of the TestPad.
A dialog box appears prompting you to enter the Remote GUI 
password. 

4 Type the Remote GUI password, and then select OK.
The Remote GUI for the TestPad appears on your screen.
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5 Verify the connection for the Remote GUI by doing the following:
– Using the Remote GUI, change the default configuration for the 

TestPad.
– Verify the configuration settings in the configuration summary 

bar of the Remote GUI. 

6 To use the Remote GUI:
– Use your mouse to select the elements on the GUI that you 

would typically “tap” on the TestPad. For example, if you want 
to select the Setup button to configure a test, using your 
mouse, simply click the Setup button on the Remote GUI.

– To access the Extended Keys for the TestPad, select the Tools 
button at the bottom right corner of the main screen to display 
the Tools menu, and then select the command that corre-
sponds to the Extended key on the TestPad.

You are running the Remote GUI.

Managing files
You can view, run, delete, rename, copy, and paste files (for example, 
print files and test scripts) on the TestPad from the File Management 
dialog box. For example, you can rename print files, copy print files to 
a PCMCIA card, or delete print files. If you establish a network connec-
tion, you can also transfer files to and from local drives and FTP 
servers.

Selecting files Before you view, run, rename, copy, or delete a file, you must first 
select the file.

To select a file

1 Select Tools > File Management.

NOTE:
If you are running the RFC 2544 script from a Remote GUI session, 
you must use the Windows Task Manager to run the script. See 
“Running the script from a Remote GUI session” on page 169 for 
detailed instructions.
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The File Management dialog box appears with the local drive for 
the TestPad displayed as the current drive.

2 To navigate to the file, select the Current Drive/Folder drop-down 
arrow.

Button bar

Current drive/
folder

File selection 
box
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A drop-down list of drives and folders appears under the current 
drive/folder.

3 Do the following:

a Select + to expand a drive or folder.

b Tap or click the folder to select the folder with the file.

c Tap or click the Current Drive/Folder drop-down arrow to select 
the drive and folder and close the drop-down list.
FST-2802 TestPad User’s Guide Revision A 73



Chapter 2 Basic Operations
Managing files
The drop-down list of drives and folders disappears, the 
selected folder appears in the Current Drive/Folder field, and 
the files in the folder appear in the File Selection box.

4 Select a file from the File Selection box.

The file is selected.

Filtering files You can filter the files in the File Selection box to display only specific 
types of files, such as print files or test scripts.

To filter the displayed files
– Select the File Type drop-down arrow, and then select Print,  

Scripts or All.

NOTE:
The print files you generate and store on the TestPad are stored as 
text (.txt) files.
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Viewing, running,
deleting, or

renaming a file

After you select a file, you can view, run, delete, or rename the file.

To view, run, delete, or rename a file

1 Select Tools > File Management.
The File Management dialog box appears. 

2 Navigate to and select the file.

3 Do one of the following:
– To view or run the file, select the corresponding button on the 

button bar.
– To delete the file, select Del. When prompted to confirm the 

deletion, respond with OK.
– To rename the file, select Ren, type the new name, and then 

select OK.

Copying and
pasting files

You can copy and paste files on the TestPad to any of the available 
drives listed on the File Management dialog box, including PCMCIA 
drives and the FTP drive (which you map to an FTP server). If you 
want to transfer files to and from an FTP server, you must first estab-
lish a network connection, and then log in to the server.

To copy and paste files

1 Navigate to and select the drive and folder with the file you want to 
copy. 

2 If you selected the FTP drive, log into the FTP server (see 
“Connecting to an FTP server” on page 76); otherwise, go to 
step 3.

3 Select the file, and then choose Copy.

4 Navigate to the folder you want to paste the file to. 

5 If you are copying the file to a folder on the FTP server, log into the 
FTP server.

6 Select Paste.

The file is pasted.
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Connecting to an
FTP server

Before you connect to an FTP server from the TestPad, you must 
establish a modem dial-out, modem dial-in, or LAN connection. After 
you establish a network connection, you connect to an FTP server by 
selecting the FTP drive in the File Management dialog box.

To connect to an FTP site

1 Establish a modem dial-out, modem dial-in, or LAN connection 
from the TestPad to the network your device is connected to.
– For detailed instructions on establishing a modem dial-out 

connection, see “Establishing modem dial-out connections” on 
page 83.

– For detailed instructions on establishing a modem dial-in 
connection, see “Establishing modem dial-in connections” on 
page 85.

– For detailed instructions on establishing a LAN connection, see 
“Establishing LAN connections” on page 87.

2 Select Tools > File Management.
The File Management dialog box appears. 

3 Select the FTP drive. The FTP drive is identified as follows:
– If this is the first time you are connecting to an FTP server from 

the TestPad, the drive is identified as:
[FTP (Not Configured)]/

– If you previously connected to an FTP server from the TestPad, 
the drive is identified with an FTP prefix, and the name of the 
last FTP server you connected to. For example, if you 
connected to Microsoft’s FTP server the last time you used the 
TestPad, the FTP drive is identified as:
[FTP.Microsoft.com]/
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The FTP Server button appears on the button bar, and the FTP 
Server Settings dialog box appears.

4 Do one of the following:
– If you are connecting to the server displayed in the Server field, 

proceed to step 5.
– If you are connecting to a different FTP server, tap or click the 

Server field. An Acterna keyboard appears. Type the address 
for the server, and then select OK.

5  In Login Name and Password, type your login and password, and 
then select OK.

The TestPad connects to the FTP server. You can transfer files to and 
from the TestPad.

Connecting to the
TestPad’s FTP

server

You can also log into the TestPad’s FTP server from a remote device 
to transfer files. Before you connect to the TestPad’s FTP server, you 
must establish a modem dial-out, modem dial-in, or LAN connection to 
the remote device.
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To connect to the TestPad’s FTP server

1 Establish a modem dial-out, modem dial-in, or LAN connection 
from the TestPad to the network your device is connected to.
– For detailed instructions on establishing a modem dial-out 

connection, see “Establishing modem dial-out connections” on 
page 83.

– For detailed instructions on establishing a modem dial-in 
connection, see “Establishing modem dial-in connections” on 
page 85.

– For detailed instructions on establishing a LAN connection, see 
“Establishing LAN connections” on page 87.

2 Launch an FTP session on your device.

3 Connect to the TestPad’s FTP server by specifying the following 
parameters:
– Server name: TestPad’s computer name (see “Deter-

mining the TestPad’s IP address or computer name” on 
page 70).

– Login: acterna
– Password: acterna

You are connected to the TestPad’s FTP server, and you can copy and 
paste files to and from the TestPad.
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3

This chapter provides step-by-step instructions for establishing serial 
and network connections to the TestPad. Topics discussed in this 
chapter are as follows:

– “About serial and network connections” on page 80
– “Requirements for serial and network connections” on page 80
– “Establishing serial connections” on page 81
– “Establishing modem dial-out connections” on page 83
– “Establishing modem dial-in connections” on page 85
– “Establishing LAN connections” on page 87
– “Establishing IP socket connections” on page 90
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About serial and network connections
You can establish serial and network connections to the TestPad, 
enabling you to use a variety of tools such as VT100, the Web browser, 
VNC Viewer, and FTP. When you establish serial and network connec-
tions, you must specify connection parameters using the options 
provided on the Connectivity tab (see Figure 12). The tab is displayed 
by selecting the Connectivity option from the Tools menu.

Requirements for serial and network connections
To establish modem dial-out, modem dial-in, LAN, USB direct, and IP 
socket network connections, you must purchase the Networking 
option and the associated connectivity accessories required for the 
connection.

You do not need to purchase the Networking option to establish serial 
connections to the TestPad; however, you may need to purchase 
connectivity accessories.

Figure 12 Connectivity tab
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For descriptions of the connectivity accessories offered as accesso-
ries by Acterna, see Table 3 on page 12.

Establishing serial connections
You can establish a serial connection from a laptop or PC to a TestPad 
using a serial PCMCIA card or a serial cable (connected to the serial 
port of the Y cable).

After you establish a serial connection, you can do the following:

– Emulate a VT100 terminal (see “Emulating a VT100 terminal” on 
page 69).

– Issue remote control commands (see Appendix B).

To establish a serial connection

1 Insert the PCMCIA serial card into a PCMCIA card slot on the 
TestPad, or connect the Y cable to the USB/Serial port.

2 Do one of the following:
– If you are connecting via a serial PCMCIA card, connect a DB-

9 female connector on the serial null modem cable to the 
connector on the cable attached to the card.

– If you are connecting via the Y cable, connect a DB-9 female 
connector on the serial null modem cable to the serial 
connector of the Y cable.

3 Connect the end of the serial null modem cable to the serial port of 
the laptop or PC.

4 Do one of the following:
– If you are establishing the connection to emulate a VT100 

terminal, see “Emulating a VT100 terminal” on page 69.
– If you are establishing the connection to allow a user to issue 

remote control commands or run the Remote GUI, proceed to 
step 5.

5 On the TestPad, select Tools > Connectivity > Serial Remote 
Command Line.
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The Serial Command Line dialog box appears.

6 If a serial card is inserted in the TestPad and the Y cable is 
connected to the USB/Serial port, you must select the serial 
device you are using to establish the connection.
– To establish a connection using a serial card, select Serial 

Card.
– To establish a connection using the serial port of the Y cable, 

select Serial Port.

7 Specify the parameters for the connection, and then select OK. 
Default values for each of the settings are as follows:
– Baud rate: 9600
– Data bits: 8
– Parity: None
– Stop bits: None
– Flow control: None

The connection is established.
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Establishing modem dial-out connections
Establishing a modem dial-out connection from the TestPad involves 
inserting the PCMCIA analog modem card into a PCMCIA card slot, 
configuring the modem dial-out parameters, and then connecting the 
PCMCIA card to a phone jack using the supplied RJ-11 phone cable. 
Finally, you dial out to your Internet Service Provider (ISP). This estab-
lishes the modem dial-out connection.

You must have access to a PSTN network for a modem dial-out 
connection.

After you establish a dial-out connection, you can do the following:

– Launch the Web browser (see “Launching the Web browser” on 
page 68).

– Run the Remote GUI (see “Using the Remote GUI” on page 69).
– Transfer files using FTP (see “Copying and pasting files” on 

page 75).
– Establish an IP socket connection to the TestPad (see “Estab-

lishing IP socket connections” on page 90), and then issue remote 
control commands (see Appendix B).

To establish a modem dial-out connection

1 Insert the PCMCIA modem card into a PCMCIA card slot on the 
TestPad.

2 Connect the PCMCIA modem card to a phone jack using the 
supplied RJ-11 phone cable.

3 On the TestPad, select Tools > Connectivity > Modem Dial Out 
Network.
FST-2802 TestPad User’s Guide Revision A 83



Chapter 3 Serial and Network Connections
Establishing modem dial-out connections
The Modem Dial-out dialog box appears.

4 Specify the following dial-out parameters:

a In Dial Out Device, select one of the available devices.

b To set the IP address, do one of the following:
– To allow a server to assign the IP address, select Server 

assigned IP address.
– To manually assign the IP address, select Specify an IP 

address, and then type the address in IP Address.

c To set the DNS address, do one of the following:
– To allow a DNS server to assign the DNS address, select 

Server assigned DNS address.
– To manually assign the DNS address, select Specify a 

DNS address, and then type the address in DNS Address.

d In Phone #, type the dial-out phone number.

e In Username, type your ISP username.

f In Password, type your ISP password.

5 Select Dial to establish the connection.

The modem dial-out connection is established.
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Establishing modem dial-in connections
Establishing a modem dial-in connection to the TestPad involves 
inserting a PCMCIA analog modem card into a PCMCIA card slot on 
the TestPad, configuring the modem dial-in parameters, and then 
connecting the PCMCIA modem card to a phone jack using the 
supplied RJ-11 phone cable. Finally, you dial-in to the TestPad.

You must have access to a PSTN network for a modem dial-in connec-
tion.

After you establish a dial-in connection, you can do the following:

– Run the Remote GUI (see “Using the Remote GUI” on page 69).
– Transfer files using FTP (see “Copying and pasting files” on 

page 75).
– Establish an IP socket connection to the TestPad (see “Estab-

lishing IP socket connections” on page 90), and then issue remote 
control commands (see Appendix B).

To establish a modem dial-in connection

1 Insert the PCMCIA analog modem card into a PCMCIA card slot 
on the TestPad.

2 Connect the PCMCIA modem card to a phone jack using the 
supplied RJ-11 phone cable.

3 On the TestPad, select Tools > Connectivity > Dial In Network.
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The Dial-in Network dialog box appears.

4 To specify the dial-in parameters, do the following:

a In Dial In Device, select one of the available dial-in devices.

b To set the TCP/IP client address, do one of the following:
– To allow DHCP to assign the address, select Use DHCP to 

assign remote TCP/IP client addresses.
– To use a static address pool, select Use static address 

pool, and then type the range of addresses in the Begin 
and End fields.

5 From the remote device, dial into the TestPad. When you are 
prompted to log on to the TestPad, type the following username 
and password:
– Username: acterna
– Password: acterna
Be certain to type the username and password in lowercase.

You are connected to the TestPad.
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Establishing LAN connections
You can establish a LAN connection from the TestPad to a network via 
an Ethernet connection, or directly to another computer via an 
Ethernet, 802.11, Bluetooth, or USB direct connection. If you are 
connecting to a network with Dynamic Host Configuration Protocol 
(DHCP), you can let DHCP assign a TCP/IP client address, or you can 
use a static address pool and assign a range of valid addresses.

Table 8 lists the technologies and requirements for network and direct 
connections.

After you establish a LAN connection to a network or another 
computer, you can do the following:

– Run the Remote GUI (see “Using the Remote GUI” on page 69).
– Transfer files using FTP (see “Copying and pasting files” on 

page 75).
– Establish an IP socket connection to the TestPad (see “Estab-

lishing IP socket connections” on page 90), and then issue remote 
control commands (see Appendix B).

Table 8 LAN connections

Connection Technology Requirements

Network Ethernet – Ethernet network
– Ethernet PCMCIA card 
– Ethernet LAN cable

Direct Ethernet – Ethernet PCMCIA card
– Ethernet LAN crossover cable

802.11b – 802.11b network
– 802.11b PCMCIA card

Bluetooth – Bluetooth network
– Bluetooth PCMCIA card

USB direct – USB direct connect cable
– Y cable
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– If you establish a LAN connection to a network, you can also 
launch the Web browser (see “Launching the Web browser” on 
page 68).

To establish a LAN connection

1 If you are establishing an Ethernet, 802.11, or Bluetooth connec-
tion, insert the associated PCMCIA card into a PCMCIA card slot 
on the TestPad.

2 If you are establishing an Ethernet or direct USB connection, do 
one of the following:
– To connect to an Ethernet network, connect the Ethernet LAN 

cable to the PCMCIA card, and then connect the other end to 
the network.

– To connect to a laptop or PC via Ethernet, connect the Ethernet 
cross-over cable to the PCMCIA card, and then connect the 
other end to the laptop or PC.

– To establish a USB direct connection to a laptop or PC, 
connect the Y cable to the TestPad, and then connect one end 
of the USB direct connect cable to the USB connector on the Y 
cable and the other end to the laptop or PC.

3 On the TestPad, select Tools > Connectivity > Local Area 
Network.

WARNING: RISK OF DAMAGE TO UNIT
If you are using Bluetooth to establish a LAN connection, do not 
remove the Bluetooth PCMCIA card from the TestPad. If the Test-
Pad is configured for a Bluetooth connection, and you turn the Test-
Pad on without a Bluetooth card in a PCMCIA card slot, the TestPad 
will lock up and may require factory service. We recommend leav-
ing the Bluetooth card in the slot at all times.
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The Network Settings dialog box appears.

4 To set the TCP/IP client address, do one of the following:
– To allow DHCP to assign the address, select Obtain an IP 

address automatically.
– To use a static address, select Use the following IP address, 

and then type the IP address in the IP Address, Subnet Mask, 
and Default Gateway fields.

5 To set the DNS server address, do one of the following:
– To obtain the DNS server address automatically, select Obtain 

DNS server address automatically.
– To use a specific DNS server address, select Use the 

following DNS server address, and then type the address in 
the DNS Server field.

6 If you are connecting via Bluetooth or 802.11b, configure your PC 
or laptop using the following case-sensitive values:

Connection Parameter Value

Bluetooth Friendly Name TestPad

802.11b SSID TestPad

WEP key FST2k
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The connection is established.

Establishing IP socket connections
You can establish an IP socket connection to the TestPad from a 
laptop or PC. Before you establish an IP socket connection to the 
TestPad, you must establish a network connection. You should also 
identify the IP address of the TestPad (see “Determining the TestPad’s 
IP address or computer name” on page 70).

To establish an IP socket connection

1 On the TestPad, select Tools > Connectivity > Socket Remote 
Command Line.
The Socket Port # dialog box appears.

2 In Port #, enter the port number for the connection.

3 Establish a network connection to the TestPad.
– For detailed instructions on establishing a modem dial-out 

connection, see “Establishing modem dial-out connections” on 
page 83.

– For detailed instructions on establishing a modem dial-in 
connection, see “Establishing modem dial-in connections” on 
page 85.

– For detailed instructions on establishing a LAN connection, see 
“Establishing LAN connections” on page 87.

4 On the laptop or PC, launch a terminal emulation application (such 
as HyperTerminal).

802.11b (continued) Static IP address 192.168.252.2

Connection Parameter Value
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5 Connect using the following parameters:
– TCP/IP (Winsock)
– Port number: Port number (specified in step 2).
– IP address: TestPad’s IP address or computer name 

(see “Determining the TestPad’s IP address or computer 
name” on page 70).

The connection is established.
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4

This chapter explains basic testing concepts and procedures common 
to the tests. Topics discussed in this chapter are as follows:

– “Running a test” on page 94
– “Managing test configurations” on page 107
– “Running test scripts” on page 109
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Running a test
Running a test involves configuring the test, connecting the TestPad to 
an access element on the circuit, allowing the TestPad to establish a 
link, starting the test, and then viewing test results.

Step 1:
Configuring a test

Before you start a test, you need to configure the test and if necessary, 
specify link initialization parameters.

To configure a test

1 Select the port for the test you are configuring.

2 On the Application Button bar, select the mode, rate and protocol, 
and application for the test you want to perform (for example 
TERM > 1G Ethernet > Layer 2 Traffic).

3 To configure the test, select SETUP.
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A group of Quick Configuration buttons appears.

4 Select Summary to access the setup tabs.
The Summary tab appears with additional setup tabs for the test 
you selected. 
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5 Review the existing configuration on the Summary tab.
– If the existing configuration is correct, select OK to return to the 

main window, and then proceed to step 8.
– If the configuration needs to be modified or you need to specify 

link initialization parameters for an Ethernet test, proceed to 
step 6.

6 Select the appropriate setup tabs and specify the parameters 
required for the test. 
– For details on Ethernet link initialization and test parameters, 

refer to Chapter 5 “Ethernet Testing”.
– For details on Fibre Channel test parameters, refer to 

Chapter 6 “Fibre Channel Testing”.

7 After you specify the parameters for the test configuration, select 
OK to store the configuration and return to the main window.

8 If you are testing using a second port, repeat step 1 through 
step 7.

The test is configured.

Step 2:
Connecting the

TestPad for
testing

After you configure a test (or tests), you are ready to connect the FST-
2802 to an access element (or elements) on the circuit. 

When you connect the TestPad to perform 1G Ethernet, 
1G Fibre Channel, and 2G Fibre Channel tests, the optical jacks of the 
access element dictate the type of fiber cable you need to use to 
connect to the TestPad. For example, if the access element has 
1310nm (single mode) transmit and receive jacks, you must use a 
single mode fiber cable to connect the TestPad to the access element.

The transmit and receive jacks of the GBIC on the TestPad are color 
coded to allow you to quickly identify whether the interface provides 
1310nm or 850nm capability. Optical fiber cables are also color coded 
by wavelength. See Table 9.

NOTE:
Some setup tabs are available for every test, such as Summary and 
Error. Other tabs only appear for a specific operating mode, rate, or 
application.
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Connecting to a
splitter to monitor

1G/2G traffic

Using the FST-2802, you can monitor 1G and 2G traffic when the 
network is in service using a splitter (see Figure 13).

Table 9 Short and Long wavelength jack and cable colors

Wavelength GBIC Jacks Fiber Cable

1310nm blue yellow

850nm black or beige orange

NOTE:
When performing Ethernet tests on most networks, we recommend 
using two TestPads as end stations on the circuit, one at each end.

For some networks, it may be possible to use a hard loopback at 
the far end of the network instead of a second TestPad. Consult 
your network element specifications to determine if this is possible.

Figure 13 Monitoring traffic using a splitter
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To connect the TestPad to a splitter

1 Using the correct cable for the splitter, connect one end of the 
cable to the Port 1 RX jack of the TestPad, and the other end to 
the TX jack of the splitter.

2 Optional. If you want to monitor traffic on Port 2, repeat step 1 for 
the second port.

The TestPad is connected.

Connecting to
monitor 1G/2G traffic

in single port THRU
mode

You can also monitor 1G and 2G traffic on a circuit in THRU mode. 
Figure 14 illustrates the connection for monitoring 1G Ethernet, 
1G Fibre Channel, or 2G Fibre Channel traffic in THRU mode using a 
single port.

Figure 14 Monitoring 1G or 2G traffic in Single Port THRU 
mode
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To monitor 1G Ethernet, 1G Fibre Channel, or 2G Fibre Channel traffic in 
single port THRU mode

1 Using the correct cable for the switch, connect one end of the 
cable to the TX jack of the TestPad, and the other end to the RX 
jack of the switch.

2 Using the correct cable for the network access element, connect 
one end of the cable to the RX jack of the TestPad, and the other 
end to the TX jack of the network access element.

The TestPad is connected.

Connecting to
monitor 1G/2G traffic

in dual port THRU
mode

If your FST-2802 has dual ports, you can monitor full duplex 
1G Ethernet, 1G Fibre Channel, and 2G Fibre Channel traffic from 
both directions in dual port THRU mode (see Figure 15 on page 100).

NOTE:
When you configure a test to monitor 1G Ethernet, 1G Fibre Chan-
nel, or 2G Fibre Channel traffic in single port THRU mode, you can 
specify that the TestPad should transmit idle frames (the default), or 
loop received frames back through the transmitter.
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When you monitor traffic in dual port THRU mode, the application 
configures the TestPad to pass traffic through from the Port 1 receiver 
to the Port 2 transmitter, and the traffic from the Port 2 receiver to the 
Port 1 transmitter.

To monitor 1G Ethernet, 1G Fibre Channel, or 2G Fibre Channel traffic in 
dual port THRU mode

1 Using the correct cable for the switch, connect one end of the 
cable to the Port 1 TX jack of the TestPad, and the other end to the 
RX jack of the switch.

2 Using a second cable, connect one end of the cable to the Port 1 
RX jack of the TestPad, and the other end to the TX jack of the 
switch.

3 Using the correct cable for the network element, connect one end 
of the cable to the Port 2 TX jack of the TestPad, and the other end 
to the RX jack of the network element.

4 Using a second cable, connect one end of the cable to the Port 2 
RX jack of the TestPad, and the other end to the TX jack of the 
network element.

Figure 15 Monitoring 1G Ethernet, 1G Fibre Channel, or 
2G Fibre Channel traffic in dual port THRU mode
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The TestPad is connected.

Connecting to
monitor 10/100 traffic

in Thru mode

If your FST-2802 has dual ports, you can monitor bidirectional 
10/100 Ethernet traffic in THRU mode. Both 10/100 ports are config-
ured as MDI (medium dependent interface) ports; therefore, for some 
applications, you may need to use a crossover cable on one of the 
ports to convert it to MDI-X (medium dependent interface crossover).

Figure 16 illustrates the connection for monitoring 10/100 Ethernet 
traffic in THRU mode.

To monitor 10/100 Ethernet traffic in THRU mode

1 Using the correct cable for the switch, connect one end of the 
cable to the Port 1 10/100 Mbps jack of the TestPad, and the other 
end to the RX jack of the switch.

2 Using the correct cable for the network access element, connect 
one end of the cable to the TX jack of the network access element, 
and the other end to the Port 2 10/100 Mbps jack of the TestPad.

The TestPad is connected.

Figure 16 Monitoring 10/100 Ethernet traffic in THRU mode
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Connecting for
Ethernet Loopback

testing

Using two FST-2802s, you can generate and transmit Ethernet traffic 
from one TestPad, and then loop the traffic back through a second 
TestPad on the far end of the circuit. See Figure 17.

To connect the TestPads for an Ethernet loopback test

1 Using the correct cable for the access element, connect one end 
of the cable to the TX jack of the first TestPad, and the other end 
to the RX jack of the access element.

2 Connect a second cable from the TX jack of the access element to 
the RX jack of the first TestPad.

3 On the far end of the circuit, connect one end of a cable to the TX 
jack of the access element, and the other end to the RX jack of the 
second TestPad.

4 Connect a second cable from the TX jack of the second TestPad 
to the RX jack of the access element.

5 Optional. If you want to perform a second loopback simulta-
neously using Port 2, repeat step 1 through step 4 for Port 2.

The TestPad is connected.

Figure 17 Loopback test using two FST-2802s
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Connecting for Fibre
Channel loopback

testing

If you are performing a Fibre Channel test on an unswitched network, 
you can also loop traffic back through a hard loopback at the far end 
of the circuit. See Figure 18.

To connect the TestPad for a Fibre Channel loopback test

1 On the near end of the circuit, using the correct cable for the 
access element, connect one end of the cable to the TX jack of the 
TestPad, and the other end to the RX jack of the access element.

2 Connect a second cable from the TX jack of the access element to 
the RX jack of the first TestPad.

3 On the far end of the circuit, establish a hard loopback by 
connecting a cable from the TX jack to the RX jack of the access 
element.

The TestPad is connected.

Connecting for a dual
port loopback

connection

If you are testing a Fibre Channel circuit or an unswitched Ethernet 
circuit using a FST-2802 with two ports, you can also perform a loop-
back using a single FST-2802 by implementing a hard loopback at the 
far end of the circuit. See Figure 19.

Figure 18 Loopback test using a hard loopback
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If you are testing a switched Ethernet circuit, you can implement a 
loopback at the far end of the circuit using a single FST-2802 with two 
ports.

To connect the TestPads for a dual port loopback test

1 Using the correct cable for the line card, connect one end of the 
cable to the TX jack of the first port on the TestPad, and the other 
end to the RX jack of the first port on the line card.

2 Using the correct cable for the line card, connect one end of the 
cable to the RX jack of the first port on the TestPad, and the other 
end to the TX jack of the first port on the line card.

3 Repeat step 1 and step 2 for the second port on the TestPad.

4 On the far end of the circuit, establish hard loopbacks from each 
customer premise equipment back to the ports on the TestPad.

The TestPad is connected.

Connecting for
end-to-end testing

Using two FST-2802s, you can verify that a provisioned path will carry 
traffic from one TestPad to a second TestPad on the far end of a circuit.

Figure 19 Dual port loopback connection
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To connect the TestPads for an end-to-end test

1 Using the correct cable for the access element, connect one end 
of the cable to the TX jack of the first TestPad, and the other end 
to the RX jack of the access element.

2 Connect a second cable from the TX jack of the access element to 
the RX jack of the first TestPad.

3 On the far end of the circuit, connect one end of a cable to the TX 
jack of the access element, and the other end to the RX jack of the 
second TestPad.

4 Connect a second cable from the TX jack of the second TestPad 
to the RX jack of the access element.

5 Optional. If you want to perform a second end-to-end test simulta-
neously using Port 2, repeat step 1 through step 4 for Port 2.

The TestPad is connected.

Figure 20 End-to-end test
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Step 3: Starting a
test

After you configure a test, connect the TestPad to an access element 
on the circuit, and allow the TestPad to establish a link (if you are 
testing on an Ethernet circuit), you can start the test. Each time you 
start a test, the TestPad clears existing alarms, and then starts the test.

To start a test, do one of the following
– Press the Restart key to start the test(s) on each active port.
– Select Tools > Restart Port 1 or Tools > Restart Port 2 to 

start a test on a specific port.
– If you are running the GUI from a remote laptop or PC, select 

Tools > Restart Both Ports, Tools > Restart Port 1, or 
Tools > Restart Port 2.

The test starts.

Step 4: Viewing
test results

After you connect the TestPad to the circuit and receive a valid signal, 
it automatically begins to accumulate results. To view the test results, 
set the Result Group and Result Category for each pane. You may 
want to do this before you connect the TestPad to the circuit.

To view test results

1 On the left results pane, set the Result Group to Port 1 or Port 2.
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2 On the left results pane, set the Result Category. 

3 Repeat step 1 and step 2 for the right results pane.

You can now view results for two different ports and results categories 
simultaneously. For result descriptions, refer to Chapter 7 “Test 
Results”.

Managing test configurations
The TestPad allows you to define and store up to ten test configura-
tions (setups) for each port. You can then use these test configurations 
to run your most common tests.

Storing test
configurations

To store a test configuration

1 After you configure your test, select the Tools button, and then 
select Store/Recall Setups.
FST-2802 TestPad User’s Guide Revision A 107



Chapter 4 Basic Testing
Managing test configurations
The Saved Setups dialog box appears.

2 If your TestPad has two ports, select Port 1 or Port 2 to display 
the existing configurations for the port.

3 Select the configuration to replace, and then select Replace.

4 Type the name of the configuration to be saved, and then select 
OK.

The configuration now appears in the list and is stored.

Loading test
configurations

The TestPad allows you to load a stored test configuration.

To load a test configuration

1 Select Tools > Store/Recall Setups.
The Saved Setups dialog box appears.

2 If your TestPad has two ports, select Port 1 or Port 2 to display 
the configurations for the port.

3 Select the configuration you want to load, and then select Load.

4 Select Exit.
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The test is set up using the configuration you selected.

Running test scripts
If you purchase and install the 2000-SCR automated test script option, 
you can write test scripts using the Tcl/Tk scripting language to auto-
mate your testing processes.

Running a test
script

The AutoMATE option on the Tools Menu provides access to the File 
Management screen, from which you can run your automated test 
scripts.

To run a script

1 Select the Tools > AutoMATE.

NOTE:
If your TestPad has two ports, and you load a saved configuration 
for a different protocol, the TestPad displays a message to inform 
you that it will load the saved configuration onto both ports. For 
example, if both ports on the TestPad are currently setup to test 
Ethernet, and you load a saved Fibre Channel configuration onto 
Port 1, the TestPad will also load the Fibre Channel configuration 
onto Port 2.

NOTE:

Acterna does not provide Tcl/Tk support. For information on Tcl/Tk 
scripting, refer to the web sites published by Scriptics.
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The File Management screen appears.

2 Select the script you want to run.

3 Select Run.

The script begins to run.

Viewing,
renaming, and
deleting script

and results print
files

You can view, delete, and rename test scripts and results print files 
from the File Management screen. For detailed instructions on 
managing files, see “Viewing, running, deleting, or renaming a file” on 
page 75.

NOTE:
You can also run the RFC 2544 script (developed by Acterna) to 
automate Ethernet testing. See “Running the RFC 2544 script” on 
page 165 for detailed information on the RFC 2544 script.
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5

This chapter provides step-by-step instructions for performing 
Ethernet tests using the TestPad. Topics discussed in this chapter are 
as follows:

– “About Ethernet testing” on page 112
– “Ethernet link initialization” on page 112
– “Ethernet traffic” on page 113
– “Out-of-service testing” on page 121
– “In-service testing” on page 174
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About Ethernet testing
Ethernet is a physical (layer 1) and data link (layer 2) technology. 
When you perform Ethernet tests using the FST-2802, the TestPad 
essentially operates as an Ethernet switch port on a circuit. Ethernet 
switches are capable of interpreting Ethernet frames (data); therefore, 
you can use the TestPad to ensure physical and data layer integrity by 
transmitting and analyzing Ethernet frames.

Ethernet link initialization
Before you transmit and receive traffic (Ethernet frames) over a circuit, 
you must initialize an Ethernet link. At a minimum, initializing a link with 
a switch that doesn’t use auto-negotiation involves connecting a 
TestPad or TestPads (which emulate Ethernet switch ports) to a circuit, 
and allowing the TestPad(s) to transmit idle traffic. 

Initializing a link with switches on the circuit that use auto-negotiation 
involves turning auto-negotiation on the TestPad(s), specifying link 
initialization parameters (see “Specifying link initialization parameters” 
on page 123), and then connecting the TestPad(s) to the circuit. The 
TestPad(s) and switches auto-negotiate their capabilities (see “Auto-
negotiation and flow control” on page 113), and then transmit idle 
traffic over the circuit. 

The link is considered active after idle traffic is transmitted. Table 10 
illustrates the possible link status for each link partner when auto-
negotiation is on and off.

Table 10 Possible Link Status for Link Partners

Auto-Negotiation Link Status

Switch A Switch B Switch A Switch B

Off Off Active Active

On On Active Active

Off On Active Inactive

On Off Inactive Active
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By default, auto-negotiation is turned off on the TestPad. If you turn 
auto-negotiation on, you may need to change the default capabilities 
before you connect the TestPad (or TestPads) to the circuit. You may 
also turn flow control off and specify the speed and duplex settings for 
10/100 traffic (see “Specifying link initialization parameters” on 
page 123). 

Auto-negotiation
and flow control

After you turn auto-negotiation on and connect a TestPad to a circuit, 
the TestPad and the switches on the circuit that have auto-negotiation 
on immediately “advertise” their capabilities to each other, and then 
negotiate to the highest common capability. For example, Switch A 
and B in Table 11 advertise and then negotiate to use the following 
capabilities:

Ethernet traffic
After the TestPad and the Ethernet switch complete the auto-negotia-
tion process, the Ethernet link is initialized, and the Link Active LED 
illuminates on the TestPad. You can now use the FST-2802 to transmit 
and analyze Ethernet traffic to verify that the circuit can support stan-
dard Ethernet frames.

Table 11 Negotiated Capabilities of Switch A and Switch B

Capability Switch A Switch B Negotiated Capability

Pause Both Tx and Rx Neither Neither

Full Duplex Yes Yes Yes

Half Duplex Yes Yes Yes

NOTE:
By default, auto-negotiation is off on the FST-2802. If the Ethernet 
devices on the circuit do not support auto-negotiation, leave auto-
negotiation off.
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Before you start testing, you can optionally specify the traffic load type 
for the traffic (see “Traffic loads” on page 117). You can also optionally 
define profiles for the traffic which specify, at the field level, the char-
acteristics of the transmitted and received frames (see “Traffic profiles” 
on page 120).

Because the FST-2802 emulates an Ethernet switch port, for most 
networks, we recommend using two TestPads as end stations on the 
circuit (one TestPad at each end). For a detailed explanation of 
Ethernet switching, see “Ethernet switching” on page 115.

Ethernet frame
formats

Ethernet frames are variable length frames ranging in size from 64 to 
1518 bytes (excluding the preamble). When you configure tests for the 
FST-2802, you specify one of two frame formats: DIX or 802.3.

DIX frames Figure 21 illustrates the structure of a DIX frame. Overhead fields are 
a fixed-length; the payload field can range in size from 46 to 1500 
bytes.

Each DIX frame is comprised of the following fields:

– Preamble/SFD. Data that allows the receiver to synchronize with 
the incoming transmissions and locate the start of an Ethernet 
frame. The SFD (Start of Frame Delimiter) indicates that the desti-
nation address of the frame is about to begin.

– Destination address. Address of the network element the frame 
is being transmitted to.

– Source address. Address of the network element originating the 
frame.

– Type. The type of Layer 3 protocol in the payload of the frame.

Figure 21 Ethernet DIX frame

Destination
Address

Source
Address Type Data (Payload) FCS

66 2 46-1500 4
# bytes:

Preamble

8
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– Payload. The actual information being transmitted in the frame (all 
other fields are considered overhead).

– FCS. Frame Check Sequence. A value calculated by the origi-
nating device and inserted into the frame. The receiving device 
performs the same calculation, and compares its FCS value with 
the FCS value in the frame. If the values don’t match (suggesting 
the frame is errored), an FCS error is declared. Switching devices 
will discard the frame.

802.3 frames The FST-2802 can also transmit 802.3 frames (illustrated in Figure 28 
on page 160). A Length field replaces the Type field of a DIX frame, 
and simply indicates the length of the data payload in bytes. 

VLAN tagged frames If you purchase the VLAN Tagging option, you can transmit and 
analyze virtual LAN (VLAN) tagged DIX or 802.3 frames, which include 
an additional VLAN field. The VLAN field contains the protocol ID, 
priority, and VLAN ID. In Ethernet, the protocol ID is fixed at 81-00 
hexadecimal.

Figure 22 on page 115 illustrates the structure of a VLAN tagged 
Ethernet frame.

Ethernet
switching

In general, many out-of-service tests can be performed using a single 
TestPad. The TestPad generates traffic, and using a hard loopback at 
the far end of the circuit, the traffic is returned to the TestPad. The 
TestPad then analyzes the traffic for integrity. In a switched (layer 2) 
Ethernet network, this test methodology does not work because of the 
way Ethernet switches handle traffic.

Figure 22 Ethernet frame with VLAN tag

Destination
Address

Source
Address

Length/
Type Data (Payload) FCS
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Before you transmit traffic for a test using a hard loopback, you 
configure the outgoing traffic using a destination address that matches 
the source address of the transmitting port on the TestPad so that all 
traffic leaving the port returns to the port. When an Ethernet switch 
receives a frame on Port A from a TestPad port with source address 
00404D000001, the switch remembers that because traffic generated 
from source address 00404D000001 comes in on Port A, all future 
traffic with destination address 00404D000001 should also be 
forwarded to Port A. However, if the switch then receives the frame 
from Port B with a source address of 00404D000001, the switch 
assumes that source address 00404D000001 comes in via Port A, and 
therefore, the frame has already been received. The switch decides 
the frame must be errored and discards the frame (see Figure 23 on 
page 116).

Due to this function of Ethernet switches, a second FST-2802 must be 
used on the far end of the circuit instead of a hard loopback. The traffic 
originating port on the TestPad (for example, source address 
00404D000001) sends the frame with a source address of 
00404D000001 to the far end TestPad port’s destination address (for 
example, source address 00404D000002). Then, the TestPad on the 
far end swaps the destination address and the source address, 
ensuring the frame is returned to the originating TestPad port (see 
Figure 24 on page 117).

Figure 23 Hard loopback on a network with Layer 2 switches

(MAC address 00404D000001)

Discarded Frame
If the switch receives a frame from B to A
with a destination address of
00404D000001, the switch discards the
frame.

DA=00404D000001
SA=00404D000001

FST-2802

PORT 1 PORT 2

1 Gbps / 2 Gbps 1 Gbps / 2 Gbps
10/100 Mbps

TX RX TX RX

Ethernet Device
RXTX

Ethernet Sw itchA B
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Traffic loads By default, the FST-2802 transmits traffic in a constant load. You can 
also optionally transmit Ethernet and Fibre Channel traffic in a bursty 
or ramp load by configuring the load on the Traffic tab (see “Config-
uring the traffic load” on page 128).

Figure 24 Loopback application using two FST-2802s

Ethernet Sw itchA B

DA=00404D000001
SA=00404D000002

F S T - 2 8 0 2  s w a p s  t h e  f r a m e ’s  s o u r c e  a n d  d e s t i n a t io n  a d d r e s s  b e f o r e
lo o p in g  t h e  f r a m e  b a c k  t o  p o r t  B .

FST-2802
(MAC address 00404D00002)

(MAC address 00404D000001)
FST-2802

PORT 1 PORT 2

1 Gbps / 2 Gbps 1 Gbps / 2 Gbps
10/100 Mbps

TX RX TX RX

PORT 1 PORT 2

1 Gbps / 2 Gbps 1 Gbps / 2 Gbps
10/100 Mbps

TX RX TX RX

DA=00404D000002
SA=00404D000001

NOTE:
Constant, Bursty, and Ramped traffic loads do not apply when you 
transmit ping packets or test patterns. When you configure the FST-
2802 to transmit ping traffic, you can send a single, multiple, or con-
tinuous stream of ping packets. When you configure the FST-2802 
to transmit test patterns, the test patterns are transmitted continu-
ously.
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Constant traffic When the TestPad transmits a constant load of traffic, frames are 
transmitted constantly at the bandwidth you specify when you 
configure your test. See Figure 25.

When you setup a constant traffic load, you can specify the bandwidth 
as a percentage of the line rate (%BW) or in total Mbps.

Bursty traffic When the TestPad transmits bursty traffic, frames are transmitted at 
100% bandwidth, followed by no frame transmissions for a specific 
time interval. See Figure 26.

When you configure bursty traffic, you can specify the burst bandwidth 
as a percentage of the line rate, or by specifying the burst gap interval. 
If you specify the burst bandwidth as a percentage of the line rate, and 
then specify the number of frames per burst, the TestPad automatically 
calculates the burst gap for you.

Figure 25 Constant traffic

Bandwidth
(configurable
either as % 
or in Mbps)

Time

Figure 26 Bursty traffic

Time

Gap between bursts

Bandwidth

100%
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You can also specify the number of bursts (fixed or continuous) for 
bursty traffic. The maximum number of fixed bursts is 65,535. If you 
select a BERT pattern for the traffic payload (in the transmit profile), 
you can specify the frame size (fixed or random).

Ramped traffic When the TestPad transmits ramped traffic, frames are transmitted at 
a user-specified percentage of bandwidth for a user-specified time 
interval. After the time interval expires, the bandwidth is increased by 
the percentage specified and the process is repeated. This allows you 
to easily verify the maximum throughput of a link. See Figure 27.

For example, if you specify a time step of 10 seconds, and a load step 
of 5% bandwidth, every ten seconds the TestPad will increase the 
traffic by an additional 5% of the line rate.

You can also specify criteria to tell the TestPad to stop ramping if an 
error (or errors) occur in a load step. For example, you can set up the 
ramp load to stop ramping if a single errored frame or dropped frame 
occurs during a load step. For Ethernet traffic, you can also set up the 
ramp load to stop ramping traffic if a single pause frame occurs in a 
load step. This allows you to determine the threshold at which errors 
occur on a specific link.

Figure 27 Ramp traffic

Time

Bandwidth

Time step

Load step
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Traffic profiles When you configure the FST-2802 to generate or monitor traffic, you 
can specify the frame characteristics of the traffic by defining a 
transmit or receive profile.

Transmit profiles When you set up the TestPad, you can optionally define up to three 
transmit profiles to specify at the field level the characteristics of trans-
mitted Ethernet frames such as the destination address for the traffic, 
the frame format, and the frame length. Before you transmit Ethernet 
traffic, you select the appropriate profile for your test.

Although the payload is not part of the transmit profile, you also specify 
the payload for the frames on the Tx Profiles tab.

If you purchase the VLAN tagging option, you can setup the profile to 
transmit tagged frames. 

A fourth profile is available for loopback tests using two FST-2802’s. 
When you perform a loopback test using the Loop Up button on the 
traffic originating FST-2802, the destination address in the loopback 
profile is populated automatically. See “Defining transmit profiles” on 
page 136 for details on defining a transmit profile.

Receive profiles Before you monitor, terminate, or loopback Ethernet traffic, you can 
optionally define or select a receive profile to filter the traffic. You can 
then view results for the filtered traffic on the Results Display in the 
Filter Stats and Filter Counts result categories. See “Defining receive 
profiles” on page 133 for details on defining a receive profile.

NOTE:
When you configure the FST-2802 to transmit ping packets or test 
patterns, you do not need to define a profile.
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Out-of-service testing
Using the FST-2802, you can generate and analyze Ethernet traffic 
when the network is out of service. To perform out-of-service tests, 
you first establish connectivity, and then transmit Ethernet traffic 
(generated from a TestPad) over a circuit.

Establishing
connectivity

Establishing connectivity involves connecting a TestPad (or TestPads) 
to an access element on a circuit. If an Ethernet device is on the circuit, 
and the TestPad is set up for auto-negotiation, the TestPad and the 
device automatically go through the auto-negotiation process (see 
“Auto-negotiation and flow control” on page 113). After auto-negotia-
tion is complete, an Ethernet link is established, and idle traffic is trans-
mitted over the circuit.

To establish connectivity

1 If your TestPad has two ports, select the port you are establishing 
connectivity for; otherwise, proceed to step 2.

2 Using the application buttons, select one of the following applica-
tions for the port:
– TERM > 10/100 Ethernet > Layer 2 Traffic
– TERM > 10/100 Ethernet > Layer 3 PING
– THRU > 10/100 Ethernet
– TERM > 1G Ethernet > Layer 1 BERT
– TERM > 1G Ethernet > Layer 2 Traffic
– TERM > 1G Ethernet > Layer 2 Patterns
– TERM > 1G Ethernet > Layer 3 PING
– THRU > 1G Ethernet > Layer 1 BERT
– THRU > 1G Ethernet > Layer 2 Traffic
– THRU > 1G IP Over Ethernet

NOTE:
Bandwidth transmission is accurate within ±2% if the frame size is 
≤120 bytes or the utilization is ≥80%. Otherwise, bandwidth trans-
mission is accurate within ±1%.
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3 If you need to turn auto-negotiation on, change the default capabil-
ities, turn flow control off, or specify 10/100 Ethernet speed or 
duplex settings, specify the link initialization parameters (see 
“Specifying link initialization parameters” on page 123).
– If you want to establish connectivity for a second port, select 

the port, and then repeat step 2 and step 3.

4 Using the correct cable for the access element, connect one end 
of the cable to the TX jack of the first TestPad, and the other end 
to the RX jack of the access element. 
– If you are establishing connectivity for a second port, repeat 

this step for the second port.

5 Connect a second cable from the TX jack of the access element to 
the RX jack of the first TestPad. 
– If you are establishing connectivity for a second port, repeat 

this step for the second port.

6 If you are establishing connectivity for a 1G Ethernet test, verify 
that a signal is present by checking the SIGNAL LED on the front 
panel for each active port. If the LED is illuminated, a signal is 
present.

7 If another Ethernet device is on the circuit, verify that the TestPad 
has obtained synchronization by checking the SYNC LED for each 
active port. If the LED is illuminated, the TestPad has obtained 
synchronization.

8 If you are establishing connectivity for a 1G Ethernet test, select 
Laser OFF to turn the laser on for the currently selected port. The 
Laser OFF button changes to Laser ON.
– If you are establishing connectivity for a second port, select the 

other port, and then select Laser OFF to turn the laser on for 
the second port.

9 If you turned auto-negotiation on, allow the TestPad and the 
access element to auto-negotiate their capabilities for each active 
port.

NOTE:
Auto-negotiation must be off when you transmit patterns; therefore, 
the TestPad automatically turns Auto-Negotiation off when you con-
figure a pattern test.
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10 Verify that the link is established for each active port by checking 
the LINK ACTIVE LED on the front panel. If the LED is illuminated, 
the link is established for the port.

Specifying link
initialization
parameters

When you specify link initialization parameters, you can:

– Turn flow control off to ignore pause frames sent to the TestPad by 
devices at the far end of a circuit.

– Specify the speed and duplex settings for 10/100 Ethernet traffic.
– Turn auto-negotiation on to tell the TestPad to negotiate its capa-

bilities with another switch before transmitting idle traffic. If you 
need to validate the auto-negotiation capabilities of the switch you 
are negotiating with, you can change each of the TestPad’s default 
capabilities.

To specify link initialization parameters

1 If your TestPad has two ports, select the port you are specifying 
parameters for; otherwise, proceed to step 2.

2 Using the application buttons, select one of the following applica-
tions for the port:
– TERM > 10/100 Ethernet > Layer 2 Traffic
– TERM > 10/100 Ethernet > Layer 3 PING
– THRU > 10/100 Ethernet > Layer 2 Traffic
– TERM > 1G Ethernet > Layer 1 BERT
– TERM > 1G Ethernet > Layer 2 Traffic
– TERM > 1G Ethernet > Layer 2 Patterns
– TERM > 1G Ethernet > Layer 3 PING

NOTE:
The FST-2802 does not support auto-negotiation when testing 1G 
Ethernet on copper links. If you insert a copper GBIC into the Test-
Pad while auto-negotiation is on, a message appears informing you 
that auto-negotiation is not supported.
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3 Select SETUP > Link Init.

4 If you are configuring the link for 10/100 Ethernet, do the following:

NOTE:
The Speed and Duplex parameters only appear on the Link Init tab 
when you configure a link for 10/100 Ethernet traffic.

To… Do this…

Turn auto-negotiation on – Under AutoNeg, select On. The 
AutoNeg button appears.

– By default, the TestPad advertises 
it is capable of transmitting and 
receiving Full and Half duplex traf-
fic for both 100 Base Tx and 10 
Base T. If you need to change the 
default capabilities, select 
AutoNeg. A dialog box with auto-
negotiation capabilities appears.

– Select the capabilities for 100 
Base Tx and 10 Base T. 

– Proceed to step 7.
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5 If you are configuring the link for 1G Ethernet, do the following:

Turn auto-negotiation off – Under AutoNeg, select Off.
– Specify the speed (10 or 100) and 

duplex (Half or Full) settings. 
– Proceed to step 7.

Turn flow control off Under Flow Control, select Off.

To… Do this…

Turn auto-negotiation on – Under AutoNeg, select On. The 
AutoNeg button appears.

– By default, the TestPad advertises 
it is capable of transmitting and 
interpreting received pause 
frames, and it advertises both full 
and half-duplex transmission. If 
you need to change the default 
capabilities, select AutoNeg. A 
dialog box with auto-negotiation 
capabilities appears.

– Proceed to step 6.

Turn auto-negotiation off Under AutoNeg, select Off.

Turn flow control off Under Flow Control, select Off.

To… Do this…
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6 If you turned auto-negotiation on and selected AutoNeg in step 5, 
a window appears listing the 1G Ethernet auto-negotiation capa-
bilities.

If you need to change the default settings, do one or more of the 
following:

To… Select…

Change FDX 
capability

Yes: If you select Yes, the TestPad will support 
full-duplex (bi-directional) transmission. Yes is 
the default FDX capable setting.
No: If you select No, the TestPad will not support 
full-duplex transmission.

Change HDX 
capability

Yes: If you select Yes, the TestPad will advertise 
half-duplex transmission. Yes is the default HDX 
capable setting.
No: If you select No, the TestPad will not adver-
tise half-duplex transmission.
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7 Select OK to return to the main window.

8 Optional. If you want to specify link initialization parameters for a 
second port, select the port, and then repeat step 2 through 
step 7.

The link initialization parameters are defined.

Troubleshooting
1G connectivity

The inside green LEDs for SIGNAL, SYNC, and LINK ACTIVE illumi-
nate sequentially when the TestPad detects a signal, obtains synchro-
nization, and then recognizes a link is active. All three LEDs must 
illuminate to indicate you have established connectivity.

Table 12 lists symptoms and potential issues with devices on the 
circuit which prevent the link from being established.

Change pause 
capability

Neither: If you select Neither, the TestPad will 
advertise it is not capable of transmitting or 
receiving (interpreting) pause frames.
Both: If you select Both, the TestPad will adver-
tise a capability to transmit and receive (inter-
pret) pause frames. Both is the default pause 
capable setting.
Tx Only: If you select Tx Only, the TestPad will 
advertise it is capable of transmitting pause 
frames, but it is not capable of receiving (inter-
preting) pause frames. 
Rx Only: If you select Rx Only, the TestPad will 
advertise it is capable of receiving (interpreting) 
pause frames, but it is not capable of transmit-
ting pause frames.

To… Select…
FST-2802 TestPad User’s Guide Revision A 127



Chapter 5 Ethernet Testing
Out-of-service testing
Configuring the
traffic load

By default, the FST-2802 transmits a constant load of traffic at 100%. 
You can optionally configure the FST-2802 to transmit a different 
constant load, or bursty or ramped traffic. See “Traffic loads” on 
page 117 for a detailed description of each load type.

Table 12 Troubleshooting 1G connectivity

Symptom… Potential issues…

SIGNAL does not illumi-
nate

– The access device transmitter is off or 
faulty. Verify the optical power level 
coming into the device from the net-
work.

– The GBIC is not properly seated. Verify 
that the “GBIC detected” result appears 
in the Summary result category. If “Not 
Detected” appears, reseat the GBIC.

SIGNAL illuminates, but 
SYNC does not illuminate

– The far end TestPad is not connected 
to the circuit.

– The near end element on the network 
side has a faulty receiver, or the far end 
element on the network side has a 
faulty transmitter.

SIGNAL and SYNC illumi-
nate, but LINK ACTIVE 
does not illuminate

– The far end TestPad is not acquiring 
synchronization.

– The far end TestPad is acquiring syn-
chronization; however, there is a prob-
lem with auto-negotiation. Verify that 
auto-negotiation is turned ON on both 
devices with at least one common 
capability or OFF on both devices.

– You have configured the TestPad(s) for 
an Unframed (Layer 1) BERT test. The 
LINK ACTIVE LED does not illuminate 
when performing this test.

NOTE:
You do not need to configure the traffic load for ping, 1G pattern, or 
BER pattern tests; the FST-2802 automatically configures the traffic 
load for you.
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To configure the traffic load

1 If your TestPad has two ports, select the port you are configuring 
the traffic load for; otherwise, proceed to step 2.

2 Using the application buttons, select one of the following applica-
tions:
– TERM > 10/100 Ethernet > Layer 2 Traffic
– TERM > 1G Ethernet > Layer 2 Traffic

3 Select SETUP > Traffic.

4 Under Load Type, select one of the following:

To transmit Select

A constant load of traffic Const, and then proceed to step 5 on 
page 130.

A bursty load of traffic Bursty, and then proceed to step 6 on 
page 131.

A ramped load of traffic Ramp, and then proceed to step 7 on 
page 132.
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5 If you selected Const in step 4, you can specify the bandwidth as 
a percentage of the line rate, or in Mbps.

To configure a constant load, do the following:

a Under Load Unit, select %BW to specify the bandwidth as a 
percentage of the line rate, or Mbps to specify the bandwidth in 
total Mbps.

b In Const Load, type the percentage or Mbps.

c Proceed to step 8 on page 133.
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6 If you selected Bursty in step 4, you can specify the burst band-
width as a percentage of the line rate, or by specifying the burst 
gap interval.

To configure a bursty load, under Burst Config, do the following:

a Select one of the following:

b If you are transmitting a BERT pattern in the payload of the 
frames, under Frame Size, select Fixed or Random. 

c Under No of Bursts, select Fixed, and then specify the fixed 
number of bursts (up to 65,535), or select Continuous.

To… Select…

Specify the gap between 
bursts

Burst Gap, and then do the 
following:
– Select the time interval 

(sec, msec, usec, or nsec)
– Type the gap and burst 

times in the corresponding 
fields.

Specify the load as a percent-
age of the bandwidth

%BW, and then type the load 
and frames per burst (up to 
16,500,000) in the correspond-
ing fields.
FST-2802 TestPad User’s Guide Revision A 131



Chapter 5 Ethernet Testing
Out-of-service testing
d Proceed to step 8 on page 133.

7 If you selected Ramp in step 4, you must specify a percentage of 
bandwidth and a time interval for each step in the ramp.

To specify the ramp traffic parameters, do the following:

a In Time Step (sec), type the number of seconds to transmit 
each step in the ramp.

b In Load Step (%BW), type the percentage of bandwidth to 
transmit for each step in the ramp.

c Optional. If you want to stop the load from ramping when a 
specific number of errored frames, pause frames (for Ethernet 
tests only), or dropped frames occur in a step, under Stop Load 
Increment, select the corresponding option, and then type the 
number of frames in a step which will stop the ramp. 
The TestPad will continue to transmit traffic when the ramp 
stops; however, the traffic bandwidth will not be incremented. A 
message will appear in the message display to let you know the 
ramp was halted.
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d Proceed to step 8 on page 133.

8 Select OK to return to the main window, or select another tab to 
continue configuring your test.

9 Optional. If you want to configure the traffic load for a second port, 
select the port, and then repeat step 2 through step 8.

The traffic load is configured.

Defining receive
profiles

Defining a receive profile involves selecting the profile to define, and 
then specifying the characteristics of the frames you want to monitor. 
You can define up to four receive profiles on the Rx Profiles setup tab.

To define a receive profile

1 If your TestPad has two ports, select the port for the profile; other-
wise, proceed to step 2.

2 Using the application buttons, select one of the following applica-
tions:
– MON > 10/100 Ethernet > Layer 2 Traffic
– THRU > 10/100 Ethernet > Layer 2 Traffic (dual port units 

only)
– TERM > 10/100 Ethernet > Layer 2 Traffic
– MON > 1G Ethernet > Layer 2 Traffic 
– THRU > 1G Ethernet > Layer 2 Traffic (dual port units only)
– TERM > 1G Ethernet > Layer 2 Traffic

NOTE:
If you select Dropped Frames as the trigger, you must loop up the 
far-end FST-2802 to receive valid results. If you do not loop up the 
far-end FST-2802, and you select the Dropped Frames trigger, the 
ramp will stop soon after it starts because the near-end FST-2802 
will compare the number of frames transmitted to the number of 
frames received to determine whether frames were dropped. In 
other words, the ramp will stop because the test is not configured 
properly; not because elements in the network dropped the frames.
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3 Select SETUP > Rx Profiles.

4 If you are filtering traffic with a BERT pattern in the payload, under 
Rx Payload, select Tx = Rx to monitor traffic with the same BERT 
pattern specified in the Transmit (Tx) profile, or select a BERT 
pattern for the filter.

5 Under Settings, in Profiles, select the profile you want to define.
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6 Specify the frame characteristics for the traffic filtered using the 
profile.

In… Do this…

DA Type – If you want to monitor frames sent to a sin-
gle destination address and network 
device, select Unicast, and then type the 
destination address in Dest Address 
using a 6 byte hexadecimal format.

– If you want to monitor frames sent to a sin-
gle destination address which then distrib-
utes the frames to multiple network 
devices, each with its own destination 
address, select Multicast, and then spec-
ify the destination address using a 6 byte 
hexadecimal format.

– If you want to monitor frames sent to all 
network devices on the link, select Broad-
cast.

– If you want to monitor all frames regard-
less of their destination address type, 
select Don’t Care.

SA – If you want to monitor frames sent from a 
specific source address, select Yes, and 
then type the source address in Source 
Address using a 6 byte hexadecimal for-
mat. 

– If you want to monitor all frames regard-
less of their source address, select Don’t 
Care.

Frame – If you want to monitor DIX frames, select 
DIX, and then specify the DIX protocol 
using a 2 byte hexadecimal format.

– If you want to monitor 802.3 frames, select 
802.3, and then specify the data length.

– If you want to monitor all frames regard-
less of their format, select Don’t Care.

NOTE: If you purchased the VLAN Tagging 
option, you must select Tagged or Non-
Tagged for the VLAN Tag filter to specify a 
frame type for the Frame filter.
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7 Select OK.

8 Optional. If you want to define a receive profile for a second port, 
select the port, and then repeat step 2 through step 7.

The profile is stored and the main window appears.

Defining transmit
profiles

Defining a transmit profile involves selecting the profile to define, and 
then specifying the characteristics for each frame the TestPad trans-
mits using the profile. Although the frame payload is not part of the 
profile, you also select the type of payload to transmit (Acterna or 
BERT) on the Tx Profiles tab.

To define a transmit profile

1 If your TestPad has two ports, select the port for the profile; other-
wise, proceed to step 2.

2 Using the application buttons, select one of the following applica-
tions:
– TERM > 10/100 Ethernet > Layer 2 Traffic
– TERM > 1G Ethernet > Layer 2 Traffic

VLAN Tag – If you want to monitor tagged frames, 
select Tagged, and then specify the VLAN 
ID and User Priority using a decimal for-
mat. If you want to monitor all VLAN 
tagged frames regardless of their User Pri-
ority, select Don’t Care as the User Prior-
ity filter value.

– If you want to monitor non-tagged frames, 
select Non-Tagged.

– If you want to monitor all frames regard-
less of their tagged status, select Don’t 
Care. If you select Don’t Care, the TestPad 
automatically sets the frame type for the 
profile to Don’t Care.

NOTE: The VLAN Tag field only appears if you 
purchased the VLAN Tagging option for the 
FST-2802.

In… Do this…
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3 Select SETUP > Tx Profiles.

4 Under Payload, select one of the following:
– Acterna. To transmit frames with a time stamp and sequence 

number, select Acterna. You must select an Acterna payload 
to measure round trip delay and count lost frames.

– BERT Pattern. To populate the payload by repeating a specific 
BER pattern, select BERT Pattern, and then select 2^23-1, Inv 
2^23-1, 2^31-1, Inv 2^31-1, ALL ONES, ALL ZEROS, or 
USER DEFINED. If you selected USER DEFINED, type the 
user defined BER pattern using a 4 byte hexadecimal format.
You must select the BERT Pattern payload to perform BER 
testing on a switched (layer 2) network (see “BER testing on 
switched (layer 2) networks” on page 146). 
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5 Under Settings, in Profiles, select the profile you want to define, 
and then specify the frame characteristics for the traffic trans-
mitted using the profile. 

In… Do this…

DA Type Select the type of transmission for the frames 
transmitted using the profile:
–  Unicast (to a single destination address 

and network device)
– Multicast (to a single destination address 

which then distributes the frames to multi-
ple network devices, each with its own 
destination address)

– Broadcast (to all network devices on the 
link)

Dest Address Type the destination address for Unicast or 
Multicast transmissions. Enter the destination 
address in a 6 byte hexadecimal format. No 
destination address is required for Broadcast 
transmissions.

Frame Select the frame format (802.3 or DIX). The 
default format is DIX.

Protocol Type the protocol ID for the data in the frames 
using a 2 byte hexadecimal format. 
NOTE: When transmitting Acterna payload 
frames, the EtherType is automatically set to 
x0800 and cannot be changed.

VLAN Tag – If you want to transmit tagged frames, 
select Tagged, and then specify the VLAN 
ID and User Priority using a decimal for-
mat.

– If you want to transmit non-tagged frames, 
select Non-Tagged.

NOTE: The VLAN Tag field only appears if 
you purchased the VLAN Tagging option for 
the FST-2802.
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6 Select OK.

7 Optional. If you want to define a transmit profile for a second port, 
select the port, and then repeat step 2 through step 6.

The profile is stored and the main window appears.

End-to-end testing End-to-end testing allows you to verify that a provisioned path will 
carry Ethernet traffic generated from one TestPad to a second TestPad 
on the far end of a circuit. See Figure 20 on page 105 for an illustration 
of end-to-end testing.

When you perform an end-to-end test on a switched (layer 2) Ethernet 
network, you must specify the far end TestPad port’s source address 
as the destination address for traffic generated by the first TestPad, 
and you must specify the first TestPad port’s source address as the 
destination address for traffic generated by the far end TestPad.

Length Select the frame length by selecting the arrow 
to the right of the field to display a drop-down 
menu of lengths appears. The default length 
is 64 bytes. You can select:
– An RFC 2544 recommended length (64, 

128, 256, 512, 1024, 1280, or 1518).
– User Defined, and then specify a length 

ranging from 64 to 1518 bytes (or 64 to 
1522 bytes for VLAN tagged frames).

– Jumbo Frame, and then specify a length 
ranging from 1519 to 10,000 bytes (or 
1523 to 10,000 bytes for VLAN tagged 
frames).

In… Do this…

NOTE:
You can easily determine the factory-assigned (default) source 
address and the user-assigned source address for a TestPad port 
by displaying the Summary tab. The addresses appear in the 
Default Source Address and User Source Address fields.
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In a point-to-point unswitched (layer 1) network, you do not have to 
specify the source address and destination addresses for the TestPad 
ports.

To perform an end-to-end test

1 Establish connectivity (see “Establishing connectivity” on 
page 121), and then do one of the following.
– If you are performing the test on a switched Ethernet network, 

proceed to step 2.
– If you are performing the test on an unswitched point-to-point 

network, proceed to step 5 on page 142.

2 Select SETUP > Tx Profiles.

3 Under Payload, select one of the following:
– Acterna. To transmit frames with a time stamp and sequence 

number, select Acterna. You must select an Acterna payload 
to measure round trip delay.

– BERT Pattern. To populate the payload by repeating a specific 
BER pattern, select BERT Pattern, and then select the pattern 
to transmit in the payload.
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4 Select or define a profile:

For additional information on frame profiles, see “Defining transmit 
profiles” on page 136.

To… Do this…

Use an existing profile 
with the source 
address of the Test-
Pad port on the far 
end as the destina-
tion address for the 
traffic.

Under Selections, select the profile.

Define a profile with the 
far end TestPad port’s 
source address as 
the destination 
address for the traffic.

– Under Settings, select the profile to 
define from the Profiles field.

– In Dest Address, select the arrow to 
the right of the field to display a key-
pad. Using the keypad, type the 
source address of the TestPad port on 
the far end, and then select OK to 
enter the address in the field.

– Be sure Unicast is selected as the 
address type for the profile.
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5 Do one of the following to configure the traffic load:
– If you specified or defined a transmit profile in step 4, select 

Traffic, and then configure the load (see “Configuring the 
traffic load” on page 128).

– If you didn’t specify or define a transmit profile (because you 
are performing the test on an unswitched point-to-point 
network), select SETUP > Traffic, and then configure the load.

6 Select OK to return to the main window.
– If you are performing an end-to-end test using a second port, 

repeat steps step 1 through step 6 for the second port before 
proceeding to step 7.

7 On the TestPad on the far end of the circuit, do the following:
– If you are performing the test on a switched Ethernet network, 

repeat step 2 through step 6.
– If you are performing the test on an unswitched point-to-point 

network, repeat step 5 and step 6.

8 If you are transmitting 1G Ethernet traffic, for each active port on 
both TestPads, turn the laser on by selecting the Laser OFF 
button.
The Laser OFF button changes to Laser ON.

9 For each active port on both TestPads, select Start Traffic to 
transmit traffic over the circuit.
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10 View and verify results for each transmitting port on the Results 
Display of the receiving TestPad.

BER testing on
unswitched

(layer 1) networks

If you are testing on an unswitched 1G Ethernet network, when you 
perform an end-to-end test, you can transmit BER patterns in the bit 
stream to determine the ratio of erroneous bits to the total bits 
received.

To perform BER test on an unswitched network

1 If your TestPad has two ports, select the port for the profile; other-
wise, proceed to step 2.

2 Using the application buttons, select one of the following applica-
tions:
– MON > 1G Ethernet > Layer 1 BERT
– THRU > 1G Ethernet > Layer 1 BERT (dual port units only)
– TERM > 1G Ethernet > Layer 1 BERT

3 Select SETUP > Pattern.

NOTE:
The FST-2802 does not support Layer 1 BER testing of 1G Ethernet 
on copper links. If you insert a copper GBIC into the TestPad when 
it is configured for a Layer 1 BER test, a message appears inform-
ing you that Layer 2 BER testing is not supported.
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The Pattern tab appears.

4 Select one of the following patterns:

To… Select…

– Test random jitter at a BER of 10-12 

– Test asymmetry of transition times
HFPAT

– Test low frequency random jitter
– Test PLL tracking errors

LFPAT

Test random and deterministic jitter (combined) MFPAT

Emulate a worst case scenario for deterministic 
jitter

RDPAT

Stress timing margins in the received eye by 
exposing the data sampling circuits to large 
systematic phase jumps

JTPAT

Emulate a worse case scenario for power sup-
ply noise within network transceivers

SNPAT
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5 Optional. If you want to insert bit errors or code violations into the 
bit stream, select the Error tab, and then do the following:

6 Select OK to return to the main window.
– If you want to perform a BER test from a second port, select 

the port, and then repeat step 2 through step 6 for the second 
port.

7 For each active port, establish connectivity (see “Establishing 
connectivity” on page 121).

8 If you are performing the BERT in single port THRU mode (using 
the MON application button), for each active port on the far end 
TestPad, select Connect RX to TX.

9 For each active port, start the traffic using the Start BERT Pattern 
button.

10 For each active port, verify that the Pattern Sync LED is illumi-
nated in the LED result category.

11 Optional. To insert bit errors or code violations into the bit stream, 
for each active port, select the Bit Error or CV Error button.

To… Select…

Setup the TestPad to allow you 
to insert BIT errors into the bit 
stream

BIT.
– If you want the TestPad to 

beep each time it receives a 
bit error (or errors), under 
Beep On Error, select ON.

– If you want to insert a rate of 
bit errors, select Rate, and 
then select the error rate.

Setup the TestPad to allow you 
to insert code violations into the 
bit stream 

Code Violations.
– If you want the TestPad to 

beep each time it receives 
code violation (or violations), 
under Beep On Error, select 
ON.

– If you want to insert a rate of 
code violations, select Rate, 
and then select the rate.
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12 Verify the Error Stats: Bit Errors and Bit Error Rate results for each 
active port on a Results Display.

BER testing on
switched (layer 2)

networks

If you are testing on a switched Ethernet network, when you perform 
an end-to-end test you can transmit BER patterns in the frame payload 
to determine the ratio of erroneous bits to the total bits received.

To transmit a BER pattern on a switched network

1 If your TestPad has two ports, select a port for the test; otherwise, 
proceed to step 2.

2 Using the application buttons, select one of the following applica-
tions:
– TERM > 10/100 Ethernet > Layer 2 Traffic
– TERM > 1G Ethernet > Layer 2 Traffic

3 Select SETUP > Rx Profiles, and then define the receive profile 
for the traffic you want to BERT (see “Defining receive profiles” on 
page 133).

4 Select the Tx Profiles tab, and then do the following:

a Under Payload, select Bert Pattern.

b Select 2^23-1, Inv 2^23-1, 2^31-1, Inv 2^31-1, ALL ONES, 
ALL ZEROS, or USER DEFINED. If you selected USER 
DEFINED, type the user defined BER pattern using a 4 byte, 
hexadecimal format.

5 Optional. If you want to insert a framed bit error into the traffic, 
select the Error tab, and then do the following:

a Select Framed Bit.

b If you want the TestPad to beep each time it receives a framed 
bit (or bits), under Beep On Error, select ON.

c If you want to insert a rate of framed bits, select Rate, and then 
select the error rate.

6 Select OK to return to the main window.

7 Optional. If you want to transmit a BER pattern from the second 
port, select the second port, and then repeat step 4 through 
step 6.
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8 Establish connectivity (see “Establishing connectivity” on 
page 121).

9 For each active port, select Start BERT Pattern to transmit the 
pattern over the circuit.

10 For each active port, verify that the FRAME LED is illuminated.

11 Optional. To insert one or more framed bits into the traffic, for each 
active port, select the Framed Bit Error button.

12 For each active port, verify the Error Stats: Bit Errors and Bit Error 
Rate results on a Results Display.

Measuring service
disruption time

When you perform an end-to-end test, you can measure the service 
disruption time resulting from a switch in service to a protect line.

To measure service disruption time

1 Setup and configure an end-to-end test (see “End-to-end testing” 
on page 139).

NOTE:
When performing a BERT on a switched (layer 2) network, Bit 
Errors and Bit Error Rate results may indicate one or more physical 
layer (layer 1) bit errors.
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2 On the far end FST-2802, select SETUP > Traffic.

3 Configure the traffic load (see “Configuring the traffic load” on 
page 128). When measuring service disruption time, we recom-
mend transmitting a constant load at 100 percent by specifying the 
following parameters:

a Load Type: Const

b Load Unit: %BW

c Const Load: 100

4 Select OK to return to the main window.

5 If you are transmitting 1G Ethernet traffic, turn the laser on by 
selecting the Laser OFF button.
The Laser OFF button changes to Laser ON.

6 Select Start Traffic to transmit traffic over the circuit.

7 On the near end FST-2802, clear the service disruption time by 
selecting the Reset Svc Disruption action button.

8 Initiate the switch to the protect line.

9 Optional. If you want to measure service disruption time from a 
second port, select the port, and then repeat step 1 through 
step 8.
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10 For each active port, verify the Link Stats: Svc Disruption (ms) 
result on a Results Display.

Transmitting
patterns

Using the FST-2802, you can stress the jitter and noise characteristics 
of Gigabit Ethernet components and systems by transmitting contin-
uous random test patterns (CRPAT), continuous jitter test patterns 
(CJPAT), and the compliant supply noise pattern (CSPAT). To transmit 
a pattern, you select the pattern on the Pattern tab, and then you 
establish connectivity to an Ethernet link. Finally, you transmit the 
pattern over the link.

To transmit a pattern

1 If your TestPad has two ports, select a port for the test; otherwise, 
proceed to step 2.

2 On the application button bar, select TERM > 1G Ethernet > 
Layer 2 Patterns.

3 Select SETUP > Summary to display the setup tabs, and then 
select Pattern. 

NOTE:
These patterns are designed to test physical layer networks. By def-
inition, these framed patterns populate the Ethernet header with 
invalid address information; therefore, these frames will not traverse 
a layer 2, switched network.
For the same reason, if the pattern frames are transmitted to a far-
end TestPad that is looped-up, the far-end TestPad tries to swap the 
source address and destination address for the pattern frames (see 
the discussion of “Ethernet switching” on page 115). As a result, the 
patterns received by the near-end TestPad are modified, and the 
results are not valid. Therefore, you must run pattern tests using an 
end-to-end configuration at all times.
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The Pattern tab appears.

4 Select a pattern:

5 Select OK to return to the main window.

6 Establish connectivity (see “Establishing connectivity” on 
page 121). The TestPad automatically turns auto-negotiation off 
when you select a pattern test.

7 Turn the laser on by selecting the Laser OFF button. 
The Laser OFF button changes to Laser ON.

8 Select Start Pattern to transmit the pattern over the circuit.

To… Select…

Emulate a worst case scenario for deter-
ministic jitter by transmitting frames with 
a broad spectral content.

CRPAT

Stress the timing margins in the received 
eye by exposing the data sampling cir-
cuits to large systematic phase jumps.

CJPAT

Emulate a worse case scenario for power 
supply noise within network transceivers.

CSPAT
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9 Optional. If you want to transmit patterns from a second port, 
select the port, and then repeat step 2 through step 8.

10 For each active port, verify results on the Results Display of the 
TestPad. At a minimum, verify the following Pattern Stats results:
– Transmitted Frames
– Received Frames
– FCS Errored Frames

Loopback testing Loopback testing allows you to generate and transmit Ethernet traffic 
from one TestPad, and then loop the traffic back through a second 
TestPad on the far end of a circuit. See Figure 24 on page 117 for an 
illustration of Ethernet Loopback testing.

Using the Line
Loopback feature

You can manually perform a line loopback in a switched Ethernet 
network by specifying the source address of the TestPad port on the 
far end as the first TestPad port’s destination address (when you 
define or select the loopback profile), and then selecting the LLB 
button on the far end TestPad to loop frames back to the originating 
TestPad.

In a point-to-point unswitched network, you do not have to specify the 
destination address for the far end TestPad port.

To manually perform a line loopback

1 If your TestPad has two ports, select the port for the loopback test; 
otherwise, proceed to step 2.

2 Establish connectivity (see “Establishing connectivity” on 
page 121).

3 Do one of the following:
– If you are performing the loopback on a point-to-point network, 

proceed to step 5.
– If you are performing the loopback on a switched Ethernet 

network, on the transmitting TestPad, configure the traffic for 
each active port (see step 2 through step 6 of “End-to-end 
testing” on page 139).
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4 If you are performing a line loopback for 1G Ethernet, on the far 
end TestPad, turn the laser on by selecting Laser OFF.
The Laser OFF button changes to Laser ON.

5 On the far end TestPad, select LLB OFF to put the TestPad into 
loopback mode.
The LLB OFF button changes to LLB ON.

6 On the transmitting TestPad, select Start Traffic to transmit traffic 
over the circuit to the TestPad on the far end.
When the far end TestPad receives the traffic, it will swap the 
destination address and source address of every frame it receives 
before looping the frames back to the transmitting TestPad.

NOTE:
If you want to filter the traffic looped back to the near end TestPad, 
the parameters you specify in the transmit profile for the near end 
TestPad must match the parameters specified in the receive profile 
for the far end TestPad. 
For example, if you want to loop back VLAN tagged frames for a 
specific VLAN ID and User Priority, the same VLAN ID and User 
Priority must be specified in both profiles.
If you want to loop back all frames, select Don’t Care for each of 
the receive profile parameters. 
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7 Optional. If you want to perform a line loopback from the second 
port, select the port, and then repeat step 3 through step 6.

8 Verify results for each active port on the Results Display of the 
transmitting TestPad. At a minimum, verify the following results:
– Link Stats: Total Util%, Avg, Total Util %, Cur, and Total Util % 

Peak.
– Error Stats: All results are 0.

Using the Automatic
Loopback feature

You can perform an automatic loopback by selecting the Loop Up 
button on the traffic generating TestPad. A confirmation message from 
the TestPad on the far end appears in the message display of the first 
TestPad informing you that the far end TestPad is in loopback mode. 
The destination address in the loopback profile for the first TestPad is 
also automatically populated with the source address of the TestPad 
on the far end.

When you configure TestPads for an automatic loopback test, you can 
optionally specify text identifiers for each TestPad (for example, “Joe’s 
2802” and “Sam’s 2802”). When the TestPads send confirmation 
messages to each other indicating the status of the loopback, the 
message will identify each TestPad using the text identifier.

WARNING:
The TestPad allows you to change setup parameters while testing 
in loopback mode. Be aware that certain changes may bring down 
the link.

NOTE:
If you want to filter the traffic looped back to the near end TestPad, 
the parameters you specify in the transmit profile for the near end 
TestPad must match the parameters specified in the receive profile 
for the far end TestPad. 
For example, if you want to loop back VLAN tagged frames for a 
specific VLAN ID and User Priority, the same VLAN ID and User 
Priority must be specified in both profiles.

If you want to loop back all frames, select Don’t Care for each of 
the receive profile parameters. 
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To perform an automatic loopback

1 If your TestPad has two ports, select the port for the loopback test; 
otherwise, proceed to step 2.

2 Establish connectivity (see “Establishing connectivity” on 
page 121).

3 Do one of the following:
– If you are performing the loopback on a point-to-point network, 

proceed to step 4.
– If you are performing the loopback on a switched Ethernet 

network, on the transmitting TestPad, configure the traffic for 
the test (see step 3 through step 6 of “End-to-end testing” on 
page 139), and then proceed to step 4.

4 Optional. If you want to provide an identifier in the confirmation 
messages sent between TestPads, for each TestPad, do the 
following:

a Select SETUP > Summary to display the setup tabs.

b Select ID to display the ID tab, and then select Edit to display a 
keypad.

c Using up to ten characters, type the identifier for the TestPad, 
and then select OK to store the identifier and return to the ID 
tab.

d Select OK to return to the main window.

5 On the traffic generating TestPad, select Loop Up to put the 
receiving TestPad on the far end into loopback mode.

NOTE:
If you want to filter the traffic looped back to the near end TestPad, 
the parameters you specify in the transmit profile for the near end 
TestPad must match the parameters specified in the receive profile 
for the far end TestPad. 
For example, if you want to loop back VLAN tagged frames for a 
specific VLAN ID and User Priority, the same VLAN ID and User 
Priority must be specified in both profiles.
If you want to loop back all frames, select Don’t Care for each of 
the receive profile parameters. 
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A confirmation message from the TestPad on the far end appears 
in the message display of the first TestPad informing you that the 
far end TestPad is in loopback mode. The destination address 
field of the loopback profile is automatically updated with the 
source address of the far end TestPad.

6 If you are performing a line loopback for 1G Ethernet, on the traffic 
generating TestPad, turn the laser on by selecting Laser OFF.
The Laser OFF button changes to Laser ON.

7 On the traffic generating TestPad, select Start Traffic to transmit 
traffic over the circuit to the TestPad on the far end.
When the far end TestPad receives the traffic, it will swap the 
destination address and source address of every frame it receives 
before looping the frames back to the traffic generating TestPad.

8 Optional. If you want to perform a loopback from the second port, 
select the port, and then repeat step 3 through step 7.

9 Verify results for each active port on the Results Display of the 
traffic generating TestPad. At a minimum, verify the following 
results:
– Link Stats: Total Util%, Avg, Total Util %, Cur, and Total Util % 

Peak.
– Error Stats: All results are 0.

10 When the test is complete, for each active port, select Loop Down 
to take the receiving port on the far end TestPad out of loopback 
mode.
A confirmation message from the TestPad on the far end appears 
in the message display of the first TestPad informing you that the 
port on the far end TestPad is out of loopback mode.
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Inserting an FCS
error

You can insert an FCS error when you perform end-to-end and loop-
back tests. 

To insert an FCS error

1 If your TestPad has two ports, select the port for the error inser-
tion; otherwise, proceed to step 2.

2 Using the application buttons, select one of the following applica-
tions:
– TERM > 10/100 Ethernet > Layer 2 Traffic
– TERM > 1G Ethernet > Layer 2 Traffic

3 Select SETUP > Summary to display the setup tabs, and then 
select Error.

NOTE:
For 1G testing, if you insert an FCS error on an unswitched point-to-
point network using two FST-2802s, and you want to receive the 
FCS back at the originating TestPad, put the TestPad on the far end 
of the circuit in Monitor mode, and then select the Set Rx to Tx but-
ton to transmit received traffic back to the originating TestPad.
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4 To specify the error parameters, do the following:

5 Select OK to store the error parameters and return to the main 
window.

6 If you are inserting an FCS error into 1G traffic, turn the laser on 
by selecting Laser OFF.
The Laser OFF button changes to Laser ON.

7  Select Start Traffic to transmit traffic over the circuit.

8 Select the FCS Error action button to insert the error or burst of 
errors.

9 Optional. If you want to insert errors from the second port, select 
Port 2, and then repeat step 3 through step 8.

The error is inserted into the traffic and is handled as follows:

– For end-to-end applications, the error is transmitted to the TestPad 
on the far end of the circuit.

– For loopback applications using a hard loopback, the error is typi-
cally looped back to the TestPad. Consult your network element 
documentation to determine if the network element drops errored 
traffic.

To… Do this…

Specify that the TestPad 
should beep whenever 
an FCS error occurs

Under Beep on Error, select ON.

Insert a single FCS 
error

Select SINGLE.

Insert a burst of FCS 
errors

Select BURST.
A BURST (Qty) field appears.
– Select the arrow to the right of the 

BURST (Qty) field to display a key-
pad.

– Using the keypad, type the number of 
FCS errors to insert in the burst.
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– For loopback applications using a second TestPad in loopback 
mode on the far end of the circuit, the far end TestPad drops each 
frame with a FCS error. The dropped FCS error (or errors) is inter-
preted by the near end TestPad as a single out-of-sequence 
(OOS) frame, and each individual error is counted as a lost frame. 
See “Ethernet switching” on page 115 for an explanation of how 
the FST-2802 handles Ethernet frames in a switched network.

Measuring round
trip delay

When you perform loopback tests, you can measure round trip delay 
by transmitting an Acterna payload with frames of an RFC 2544 
recommended length. The Acterna payload carries frames with time 
stamps, enabling the FST-2802 to calculate the round drip delay.

To measure round trip delay

1 Setup and configure a loopback test (see “Loopback testing” on 
page 151).

2 On the near end TestPad, select SETUP > Tx Profiles, and then 
do the following:
– Under Payload, select Acterna. The Acterna payload transmits 

frames with a time stamp and sequence number. You must 
select an Acterna payload to measure round trip delay.

– In Length, select an RFC recommended length (64, 128, 256, 
512, 1024, 1280, or 1518).

3 Select OK to return to the main window.

4 If you are measuring round trip delay for 1G Ethernet traffic, select 
Laser OFF to turn the laser on.
The Laser OFF button changes to Laser ON.

5 Select Start Traffic to transmit traffic over the circuit.

NOTE:
When you measure round trip delay, you must implement a loop-
back on the far end of the circuit, and then transmit and receive an 
Acterna payload with test frames from a FST-2802 on the near end 
of the circuit. If you do not use a loopback and transmit an Acterna 
payload with frames of an RFC 2544 length, the test results will be 
invalid.
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6 Optional. If you want to measure round trip delay from a second 
port, select the port, and then repeat step 2 through step 5.

7 For each active port, verify results on the Results Display of the 
transmitting TestPad. At a minimum, verify the following Link Stats 
results:
– Delay, Max (us)
– Delay, Min (us)
– Delay, Avg (us)

Ping testing Using the FST-2802, you can verify connectivity with another layer 3 
or IP device by sending ping request packets to the device. The device 
then responds to the ping request with a ping reply (if the device is 
responsive), or with another message indicating the reason no ping 
reply was sent. 

Ping testing tells you if the destination device is responsive, how long 
it took the ping packet to travel to the destination device and back to 
the FST-2802, and if ping packets were dropped or lost along the way.

The FST-2802 handles ping packets as follows:

– Successful ping requests. If a ping request is successful, an 
Echo Reply message appears in the message display of the 
user interface.

– Unsuccessful ping requests. If a ping request is unsuccessful, 
an error message appears in the message display of the user 
interface.

– Fragmented ping responses. If the FST-2802 sends a ping 
request and then receives a fragmented response to the request, 
the ping is considered successful if the first fragment is received 
without an error. The remaining fragments are discarded.

– Fragmented ping requests. If the FST-2802 receives a frag-
mented ping request, it responds with a ping response equal in 
length to the first fragment of the request.

– Ping packets with header options. If the FST-2802 receives a 
ping packet with options in the header, the packet is discarded.

– Multiple or continuous ping packets. If you configure the FST-
2802 to transmit multiple or continuous ping packets, the packets 
are sent at a rate of one packet per second.
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– Lost ping packets. If the FST-2802 does not receive a response 
to a ping packet within 3 seconds, the packet is considered lost.

To send ping packets to an Ethernet device

1 If your TestPad has two ports, select the port for the test; other-
wise, proceed to step 2.

2 Using the application buttons, select one of the following applica-
tions:
– TERM > 10/100 Ethernet > Layer 3 PING
– TERM > 1G Ethernet > Layer 3 PING

3 Establish a link (see “Establishing connectivity” on page 121).

4 Select SETUP > Framing, and then specify the following:

a In Frame Type, select DIX, 802.3 w/LLC, or 802.3 w/LLC and 
SNAP. 
Figure 21 on page 114 illustrates a standard DIX frame. 
Figure 28 on page 160 illustrates an 802.3 frame with LLC and 
SNAP. 

The frame type you select dictates the allowable ping packet 
size you can specify in step 5 on page 161.

b Optional. If you want to transmit VLAN tagged ping packets, in 
VLAN Tagging, select Tagged, and then specify the VLAN ID 
and User Priority for the packets.

Figure 28 Ethernet 802.3 frame with LLC and SNAP

Destination
Address

Source
Address Length Ping Packet FCS

66 2 38-1492 4
# bytes:

3 5

Preamble

8

LLC SNAP
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5 Select the PING tab.

Specify the following ping packet parameters:

a In IP Address to PING, type the IP address of the device you 
are verifying connectivity to.

b In Ping Packet Size, select one of the following:

To… Select…

Define packets which 
fit within a standard 
Ethernet frame

User defined, and then type the packet 
length. Allowable packet lengths for 
each frame type are:
– DIX: 46 - 1500 bytes
– 802.3 w/LLC: 43 - 1497 bytes
– 802.3 w/LLC and SNAP: 38 - 1492 

bytes
FST-2802 TestPad User’s Guide Revision A 161



Chapter 5 Ethernet Testing
Out-of-service testing
c Under Network Connection, specify the following addresses:

Define packets which 
fit in Jumbo frames

Jumbo Frame, and then type the 
packet length. Allowable packet lengths 
for each frame type are:
– DIX: 1501 - 9982 bytes
– 802.3 w/LLC: 1498 - 9979 bytes
– 802.3 w/LLC and SNAP: 1493 - 

9974 bytes

NOTE: Some routers do not support 
Jumbo frames; others might require 
provisioning to support Jumbo 
frames. Consult the provisioning doc-
umentation for your specific router to 
determine whether your router can 
support Jumbo frames.

In… Specify…

Default Gateway The address for the router through which 
ping traffic will be sent if the destination 
for the traffic is outside of the local sub-
net.

IP Source Address The FST-2802’s static IP source 
address.

Subnet Mask The subnet mask address for the traffic.

To… Select…
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d Optional. If you want to specify the time to live (TTL) or type of 
service (TOS), or if you want to set the fragmentation flag for 
the traffic, select Advanced to display the Ping Advanced 
Settings dialog box, and then proceed to step 6; otherwise, 
proceed to step 8.

6  Do one or all of the following:

7 Select OK to return to the PING tab.

8 Select the Traffic tab, and then choose one of the following:

To… Do this…

Specify the time after which a 
fragmented ping request or 
response can be deleted by any 
device on a circuit

In Time to Live (TTL), type the 
number of seconds. The default 
time to live setting is 64 hops.

Transmit ping packets which 
may be fragmented

In Don’t Fragment Flag, select 
May Fragment.

Specify the type of service for 
the ping packets

In Type of Service (ToS), type 
the type of service value.

To… Choose…

Send a single ping 
packet

SINGLE. Single is the default value.
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9 Select OK to return to the main window.

10 If you are transmitting ping packets for a 1G test, turn the laser on 
by selecting Laser OFF.
The Laser OFF button changes to Laser ON.

11 Select the PING action button to transmit one or more ping 
packets with an Echo Request.

12 Check the message display to verify the response message.
– If the ping was successful, an Echo Reply message appears.
– If the ping was unsuccessful, one of the following messages 

appears:

Send a fixed number of 
ping packets

MULTIPLE, and then type the number of 
packets. The default number of packets 
is 4; the maximum number of packets is 
1024.

Send a continuous 
stream of ping packets

CONTINUOUS

To… Choose…

NOTE:
The FST-2802 sends multiple and continuous pings at a rate of 1 
ping per second.

Type Code Message

3 Destination Unreachable

3 0 Network Unreachable

3 1 Host Unreachable

3 4 Fragmentation Needed

8 0 Echo Request

11 Time Exceeded

11 0 TTL Exceeded During Transit

11 1 TTL Exceeded During Reassembly
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13 Optional. If you want to send ping packets from a second port, 
select the port, and then repeat step 3 through step 12.

14 At a minimum, verify the following test results for each active port 
on the Results Display:
– Ping Stats
– Error Stats (for FCS Errored Frames)

Running the RFC
2544 script

Using the FST-2802, you can run a script which automates the test 
procedures recommended in RFC 2544. The script prompts you to 
select key parameters for throughput, latency, frame loss rate, and 
back to back frame tests, runs the tests, and then automatically gener-
ates a text file of results for the tests.

When you run the RFC 2544 script, the script automatically configures 
the FST-2802 to transmit an Acterna payload using the loop profile 
with DIX frames and no VLAN tagging. If you want to transmit 802.3 or 
VLAN-tagged frames, you must specify these settings in the loop 
profile before running the script.

Running the script
from the TestPad

To run the RFC 2544 script

1 If your TestPad has two ports, select the port for the script; other-
wise, proceed to step 2.

2 Using two FST-2802’s, establish connectivity (see “Establishing 
connectivity” on page 121).

3 If you want to transmit 802.3 or tagged frames, select SETUP > Tx 
Profiles, and then proceed to step 4; otherwise, proceed to 
step 5.

4 To transmit 802.3 or tagged frames, do the following:

a Under Selections, select LP.

b If you want to transmit 802.3 frames, in Frame, select 802.3.

c If you want to transmit tagged frames, select Tagged, and then 
specify the VLAN ID and User Priority.

d Select OK to return to the main window.
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5 If you are running the script with 1G Ethernet traffic, turn the laser 
on by selecting Laser OFF.
The Laser OFF button changes to Laser ON.

6 Verify that the LINK ACTIVE LED is illuminated on the LED display 
panel.

7 Select the RFC 2544 button, and then wait for the RFC 2544 Test 
Configuration dialog box to appear. Depending on the number of 
processes you have running on the TestPad, it may take several 
seconds for the dialog box to appear.

8 Do one of the following:

If… Select…

An existing configuration 
meets your test require-
ments

– The test configuration, and then 
choose Run. A screen appears 
which displays the status of key 
events for the test script.

– Proceed to step 14. 
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9 If you selected Modify in step 8, review the existing parameters for 
the script configuration, and then do one of the following:
– To run the script using the existing parameters, select Start. 

Proceed to step 13.
– To modify the parameters, select Next.

The RFC 2544 Test Setup Info dialog box appears, providing 
instructions on how to navigate through the test script. Proceed 
to step 10.

10 Select Next.
The Frame Lengths to Test dialog box appears. Select the frame 
lengths to test using the script.

11 Select Next.
The Test Options dialog box appears. Select the tests you want 
the script to run.

You want to modify the 
parameters for an exist-
ing configuration

The script configuration you want to 
modify, and then choose Modify. The 
Configuration Name dialog box appears. 
Select OK to accept the existing name 
and display a dialog box listing the exist-
ing parameters for the configuration. 
Proceed to step 9.

You want to create a new 
script configuration

New. The Configuration Name dialog 
box appears. Type a name for the new 
configuration, and then select OK to dis-
play a dialog box which provides instruc-
tions on navigating through the script. 
Proceed to step 10.

If… Select…

NOTE:
If you want to run the Latency test, you must also run the Through-
put test.
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12 Use Next to navigate through a series of dialog boxes which allow 
you to specify parameters for the tests you selected.

13 After you specify the final test parameter, select Next to run the 
script.
A screen appears which displays the status of key events for the 
test script.

14 When the script is complete, the Save As dialog box appears, 
allowing you to save the test results to a text file. The default path 
for the text file is:
Acterna\Files\FST-2802

15 Type the file name, specify the path for the text file, and then 
select Close.
A final dialog box appears showing the end of the script text.

16 Select Close to close the dialog box and return to the main 
screen.

17 Optional. If you want to run the script from a second port, select 
the second port, and then repeat step 2 through step 16.

The test script is complete.

To test… Specify…

Throughput – the trial duration (in seconds)

Latency – the trial duration (in seconds)

Frame Loss – the trial duration (in seconds)
– the bandwidth granularity (as a per-

centage)

Back to Back Frames – the number of trials
– the burst granularity
– the maximum trial time

NOTE:
You can stop the test script at any time by selecting Abort Script.
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Running the script
from a Remote GUI

session

When you run the RFC 2544 script from a Remote GUI session, you 
must use the Windows Task Manager to run the script.

To run the RFC 2544 script from a Remote GUI session

1 Run the Remote GUI from your laptop or PC (see “Running the 
Remote GUI” on page 70).

2 Follow step 2 through step 6 of “Running the script from the 
TestPad” on page 165.

3 On the main screen of the FST-2802 user interface, select 
RFC 2544, and then immediately select Send Ctrl-Alt-Del. See 
Figure 29. 

The Windows Security dialog box appears. See Figure 30.

Figure 29 RFC 2544 and Send Ctrl-Alt-Del buttons

Send Ctrl-Alt-Del button
RFC 2544 button

NOTE:
You can also send the Ctrl-Alt-Del key sequence using your VNC 
application. For details, refer to the support documents and mailing 
lists published on the VNC web site.
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4 Immediately select the Task Manager button. 
The Windows Task Manager dialog box appears briefly (see 
Figure 31 on page 171). 

Figure 30 Windows Security dialog box

Task Manager 
button
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5 Wait for the RFC 2544 Test Configuration dialog box to appear. 
See Figure 32 on page 172.

Figure 31 Windows Task Manager dialog box

NOTE:
Do not end, switch, or start a new task. The Task Manager will auto-
matically display the RFC 2544 Test Configuration dialog box.
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6 Follow step 8 through step 15 of “Running the script from the 
TestPad” on page 165 to run the script.

7 Select Close to close the final scripting dialog box and return to 
the Windows Task Manager.

8 Close the Windows Task Manager.

The test script is complete.

Assigning a
source address to

a TestPad port

A factory-assigned source (MAC) address is assigned to each 
TestPad port before shipment. A second, user-specified source 
address is available for each port which allows you to use the FST-
2802 to emulate another device by assigning the device’s source 
address to a port on the TestPad. After you assign another device’s 
source address to a port, you can verify that the device’s source 
address passes through the network and returns to the TestPad port 
by transmitting traffic from the port with the device’s source address.

Figure 32 RFC 2544 Test Configuration dialog box
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To assign a user-specified source address

1 If your TestPad has two ports, select the port you want to assign a 
source address to; otherwise, proceed to step 2.

2 Select SETUP > Summary.

3 Select the ID tab.

Do the following:
– Select User Source Address.
– Type the address.

4 Select OK to return to the main window.

The source address is assigned.

NOTE:
Assigning a user-specified source address to a port does not 
change the port’s factory-assigned source address.
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In-service testing 
Using the FST-2802, you can monitor Ethernet traffic when the 
network is in service. To perform in-service tests, you simply connect 
the TestPad to a network device on the circuit, and then monitor the 
Ethernet traffic on the circuit.

Monitoring 1G
traffic using a

splitter

You can monitor 1G Ethernet traffic on a circuit by connecting the 
TestPad to a splitter (see Figure 13 on page 97).

To monitor Ethernet traffic using a splitter

1 If your TestPad has two ports, select the port you want to monitor 
traffic on; otherwise, proceed to step 2.

2 On the application button bar, select one of the following applica-
tions:
– MON > 1G Ethernet > Layer 1 BERT
– MON > 1G Ethernet > Layer 2 Traffic

3 Using the correct cable for the splitter, connect one end of the 
cable to the RX jack of the TestPad, and the other end to the TX 
jack of the splitter.

4 Optional. If you want to monitor traffic from a second port, select 
the port, and then repeat step 3.

5 For each active port, verify the Error Stats results on the Results 
Display.

Monitoring 1G
Ethernet traffic in
single port THRU

mode

If you have a single port configuration, you can monitor 1G Ethernet 
traffic in THRU mode (see Figure 14 on page 98). By default, the 
TestPad transmits idle frames when you monitor traffic in single port 
THRU mode. You can optionally specify that the TestPad should loop 
the frames received to the transmitter when you configure the test.

To monitor 1G Ethernet traffic in single port THRU mode

1 On the application button bar, select MON > 1G Ethernet > 
Layer 2 Traffic.
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2 If you want to loop the frames received through to the transmitter 
(instead of transmitting idle frames), select the Connect RX to TX 
button. 

3 Using the correct cable for the switch, connect one end of the 
cable to the TX jack of the TestPad, and the other end to the RX 
jack of the switch.

4 Using the correct cable for the network access element, connect 
one end of the cable to the RX jack of the TestPad, and the other 
end to the TX jack of the network access element.

5 Verify the Error Stats results on the Results Display.

Monitoring 1G
Ethernet traffic in

dual port THRU
mode

If you have a dual port configuration, you can monitor full duplex 1G 
Ethernet traffic from both directions in THRU mode (see Figure 14 on 
page 98). When you monitor 1G Ethernet traffic in THRU mode, the 
TestPad routes all traffic received on Port 1 to the transmit jack on Port 
2, and all traffic received on Port 1 to the transmit jack on Port 1.

To monitor 1G Ethernet traffic in dual port THRU mode

1 Using the correct cable for the switch, connect one end of the 
cable to the Port 1 TX jack of the TestPad, and the other end to the 
RX jack of the switch.

2 Using the correct cable for the network access element, connect 
one end of the cable to the Port 1 RX jack of the TestPad, and the 
other end to the TX jack of the network access element.

3 Using the correct cable for the switch, connect one end of the 
cable to the Port 2 TX jack of the TestPad, and the other end to the 
RX jack of the switch.

4 Using the correct cable for the network access element, connect 
one end of the cable to the Port 2 RX jack of the TestPad, and the 
other end to the TX jack of the network access element.

5 For each port, do the following:

a Select the port.

b On the application button bar, select THRU > 1G Ethernet > 
Layer 1 BERT or Layer 2 Traffic.
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c If you selected the Unframed BERT application, select 
SETUP > Pattern, and then choose the BERT pattern for the 
traffic you are monitoring.

6 Select Laser OFF to turn the laser on for both ports. The Laser 
OFF button changes to Laser ON.

7 Verify the Error Stats results for each active port.

Monitoring IP
addresses on

1G Ethernet traffic

If you purchase the Layer 2 IP Address Filter option, you can monitor 
1G Ethernet traffic to view layer 2 statistics for specific IP addresses. 
In addition to the layer 2 statistics, the TestPad displays an IP 
Checksum Errors result in the Error Stats category which indicates 
whether IP checksum errors are detected within an IP packet.

To monitor IP addresses on 1G Ethernet traffic

1 If your TestPad has two ports, select a port; otherwise, proceed to 
step 2.

2 On the application button bar, select one of the following applica-
tions:
– MON > 1G IP Over Ethernet
– THRU > 1G IP Over Ethernet (dual port units only)

3 Connect the TestPad to the circuit.

4 In the left result pane, select the IP List category, and then select 
the Refresh IP List button.
The first eight IP addresses detected appear on buttons in the 
result pane.

NOTE:
When you select a MON (monitor) or TERM (terminate) application 
after testing in THRU mode, the TestPad will automatically config-
ure both ports for the test you selected (using the default test 
parameters).
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5 To view results for a specific IP address, select the button with the 
IP address in the left result pane, and then display one of the 
following result categories in the right result pane:
– Filter Stats
– Filter Counts
– Error Stats

6 To view the next eight IP addresses, select the Refresh IP List 
button.

Monitoring 10/100
traffic in dual port

THRU mode

If your FST-2802 has a dual port configuration, you can monitor 
10/100 Ethernet traffic in THRU mode (see Figure 16 on page 101). 
When you monitor 10/100 traffic in dual port THRU mode, each port 
on the TestPad auto-negotiates with its link partner. Therefore, you 
may need to specify link initialization parameters before establishing 
the link and monitoring traffic.

To monitor 10/100 Ethernet traffic in THRU mode

1 On the application button bar, select THRU > 10/100 Ethernet > 
Layer 2 Traffic.

NOTE:
The FST-2802 does not pass Jumbo frames when monitoring 
10/100 traffic in THRU mode. Frames ranging from 64 to 1518 
bytes are supported.
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2 If the TestPad is establishing links with switches that support auto-
negotiation, select SETUP > Link Init; otherwise, proceed to 
step 4.

3 To turn auto-negotiation on and specify the link initialization 
parameters, do the following:

a Under AutoNeg, select On. The AutoNeg button appears.

b By default, the TestPad advertises it is capable of transmitting 
and receiving Full and Half duplex traffic for both 100 Base Tx 
and 10 Base T. If you need to change the default capabilities, 
select AutoNeg. A dialog box with auto-negotiation capabilities 
appears.

c Select the capabilities for 100 Base Tx and 10 Base T.

d By default, flow control is on. If you want to turn it off, under 
Flow Control, select Off.

e Select OK to store the link auto-negotiation parameters and 
return to the main screen.

4 Using the correct cable for the switch, connect one end of the 
cable to the Port 1 10/100 Mbps jack of the TestPad, and the other 
end to the RX jack of the switch.
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5 Using the correct cable for the network access element, connect 
one end of the cable to the TX jack of the network access element, 
and the other end to the Port 2 10/100 Mbps jack of the TestPad.

6 Verify the Error Stats results.

NOTE:
When testing 10/100 Ethernet in THRU mode, both 10/100 ports 
are configured as medium dependent interfaces (MDI). Depending 
on your test application, you may need to use a cross-over cable to 
convert one of the ports to a medium dependent interface cross-
over (MDI-X) port.
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6

This chapter provides step-by-step instructions for performing Fibre 
Channel tests using the TestPad. Topics discussed in this chapter are 
as follows:

– “About Fibre Channel testing” on page 182
– “Link initialization” on page 182
– “Fibre Channel traffic” on page 182
– “Out-of-service testing” on page 185
– “In-service testing” on page 215
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About Fibre Channel testing
Using the FST-2802, you can turn up and troubleshoot Fibre Channel 
services on point-to-point unswitched networks. The FST-2802 
enables you to verify connectivity, measure throughput, and verify that 
quality of service statistics conform to those specified in a customer’s 
Service Level Agreement. If you purchased the Dual Port configura-
tion, you can verify two Fibre Channel interfaces simultaneously using 
a single FST-2802.

Link initialization
Before you transmit and receive traffic (Fibre Channel frames) over a 
circuit, you must initialize a Fibre Channel link. Initializing a link 
involves connecting a TestPad or TestPads to a circuit, and then 
allowing the TestPad(s) to transmit idle traffic. The link is considered 
active after idle traffic is transmitted and the LINK ACTIVE LED illumi-
nates on the LED display panel.

Fibre Channel traffic
After the Fibre Channel link is initialized you can use the FST-2802 to 
transmit and analyze Fibre Channel traffic. Before you start testing, 
you can optionally specify the traffic load type for the traffic (see 
“Traffic loads” on page 184). You can also optionally define profiles for 
the traffic which specify, at the field level, the characteristics of the 
transmitted and received frames (see “Traffic profiles” on page 184).

Fibre Channel
frame format

Fibre Channel frames are variable length frames ranging in size from 
28 bytes (24 byte header plus a 4 byte CRC with no payload) to 2076 
bytes, excluding the Start of Frame delimiter, optional headers, and the 
End of Frame delimiter.
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Acterna test packet (ATP) frames require an additional eight bytes for 
the IEEE 802.3 LLC/SNAP header, 20 bytes for the IP header, and 20 
bytes for the Test Frame information (such as the sequence number 
and time stamp); therefore, when you transmit an Acterna payload, the 
ATP frames are always at least 76 bytes long.

Frames with a BERT payload require an additional 4 bytes; therefore, 
when you transmit frames with a BERT payload, the frames are always 
at least 32 bytes long.

When you define a transmit profile for your test, you can configure the 
header fields listed in Figure 33. Overhead fields are a fixed-length; 
the payload field can range in size from zero to 2048 bytes.

Each Fibre Channel frame is comprised of the following fields:

– Destination Identifier. Address of the N_port the frame is being 
transmitted to.

– Source Identifier. Address of the N_port transmitting the frame.
– Sequence Identifier. Identifier for each sequence of traffic. The 

FST-2802 transmits a single, unidirectional sequence of traffic 
from each active port; therefore, this number is the same for each 
transmitted frame. You can assign a sequence identifier for all 
frames transmitted from a port when you define a transmit profile.

– Originator Exchange Identifier. Identifier of the N_Port which 
originated an Exchange.

– Responder Exchange Identifier. Identifier of the N_Port to which 
an Exchange originator wishes to communicate.

– Payload. The actual information being transmitted in the frame (all 
other fields are considered overhead).

Figure 33 Fibre Channel frame

Data (Payload) CRC

0 - 2048 4# bytes: 24

Header
(Destination ID, Source ID, Sequence ID,

Originator Exchange ID, Responder Exchange ID
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– CRC. Cyclic Redundancy Check. A value calculated by the origi-
nating device and inserted into the frame. The receiving device 
performs the same calculation, and compares its CRC value with 
the CRC value in the frame. If the values don’t match (suggesting 
the frame is errored), a CRC error is declared.

Traffic loads By default, the FST-2802 transmits traffic in a constant load. You can 
also optionally transmit Fibre Channel traffic in a bursty or ramp load 
by configuring the load on the Traffic tab before transmitting the traffic. 
For a detailed description and illustrations of each load type, see 
“Traffic loads” on page 117 of Chapter 5 “Ethernet Testing”. For step-
by step instructions on configuring a traffic load, see “Configuring the 
traffic load” on page 188.

Traffic profiles When you configure the FST-2802 to generate, monitor, or loopback 
traffic, you can specify the frame characteristics of the traffic by 
defining a transmit or receive profile.

Transmit profiles When you set up the TestPad, you can optionally define up to three 
transmit profiles to specify at the field level the characteristics of trans-
mitted Fibre Channel frames such as the destination ID for the traffic 
and the frame length. Before you transmit Fibre Channel traffic, you 
select the appropriate profile for your test.

Although the payload is not part of the transmit profile, you also specify 
the payload for the frames on the Tx Profiles tab.

NOTE:
Constant, Bursty, and Ramped traffic loads do not apply when you 
transmit test patterns or unframed BERT patterns. When you con-
figure the FST-2802 to transmit patterns, the patterns are transmit-
ted continuously.

NOTE:
When you configure the FST-2802 to transmit test patterns or 
unframed BERT patterns, you do not need to define a transmit pro-
file.
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A fourth profile is available for loopback tests using two FST-2802’s on 
an unswitched (layer 1) network. When you perform a loopback test 
using the Loop Up button on the traffic originating FST-2802, the desti-
nation ID in the loopback profile is populated automatically. See 
“Defining transmit profiles” on page 194 for details on defining a 
transmit profile.

Receive profiles Before you monitor or terminate Fibre Channel traffic, you can option-
ally define or select a receive profile to filter the traffic. You can then 
view results for the filtered traffic on the Results Display in the Filter 
Stats and Filter Counts result categories. See “Defining receive 
profiles” on page 192 for details on defining a receive profile.

Out-of-service testing
Using the FST-2802, you can generate and analyze Fibre Channel 
traffic when the network is out of service. To perform out-of-service 
tests, you first establish connectivity, and then transmit Fibre Channel 
traffic (generated from a TestPad) over a circuit.

Establishing
connectivity

Establishing connectivity involves connecting a TestPad (or TestPads) 
to an access element on a circuit, allowing the TestPad(s) to transmit 
idle traffic, and then verifying that the LINK ACTIVE LED illuminates.

To establish connectivity

1 If your TestPad has two ports, select the port you are establishing 
connectivity for; otherwise, proceed to step 2.

NOTE:
A resolution of 1% can only be achieved using frames ≥368 bytes. 
This is because the TestPad inserts IDLE’s (4 bytes) to control 
bandwidth as follows: 
IDLE (4 bytes) / Overhead (32 bytes) + Frame (368 bytes) = 1%

The resolution declines as the frame size decreases, with a worse 
case scenario of 6.7% at 28 bytes.
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2 Using the application buttons, select one of the following applica-
tions:
– TERM > 1G Fibre Channel > Layer 1 BERT
– TERM > 1G Fibre Channel > Layer 2 Traffic
– TERM > 1G Fibre Channel > Layer 2 Patterns
– TERM > 2G Fibre Channel > Layer 1 BERT
– TERM > 2G Fibre Channel > Layer 2 Traffic
– TERM > 2G Fibre Channel > Layer 2 Patterns

3 If you establishing connectivity for a second port, select the 
second port, and then repeat step 2; otherwise, proceed to step 4.

4 Using the correct cable for the access element, connect one end 
of the cable to the TX jack of the TestPad, and the other end to the 
RX jack of the access element.
– If you are establishing connectivity for a second port, repeat 

this step for the second port.

5 Connect a second cable from the TX jack of the access element to 
the RX jack of the TestPad. 
– If you are establishing connectivity for a second port, repeat 

this step for the second port.

6 For each active port, verify that a signal is present by checking the 
SIGNAL LED on the front panel. If the LED is illuminated, a signal 
is present.

7 If another Fibre Channel device is on the circuit, verify that the 
TestPad has obtained synchronization by checking the SYNC LED 
(for each active port). If the LED is illuminated, the TestPad has 
obtained synchronization.

8 For each active port, turn the laser on using the Laser OFF 
button. The Laser OFF button changes to Laser ON.

9 For each active port, verify that the link is established by checking 
the LINK ACTIVE LED on the front panel. If the LED is illuminated, 
the link is established for the port.
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Troubleshooting
connectivity

The inside green LEDs for SIGNAL, SYNC, and LINK ACTIVE illumi-
nate sequentially when the TestPad detects a signal, obtains synchro-
nization, and then recognizes a link is active. All three LEDs must 
illuminate to indicate you have established connectivity.

Table 13 lists symptoms that indicate a link has not been established 
and potential issues with devices on the circuit which prevent the link 
from being established.

Table 13 Troubleshooting connectivity

Symptom… Potential issues…

SIGNAL does not illumi-
nate

– The access device transmitter is off or 
faulty. Verify the optical power level 
coming into the device from the net-
work.

– The GBIC is not properly seated. Verify 
that the “GBIC detected” result appears 
in the Summary result category. If “Not 
Detected” appears, reseat the GBIC.

SIGNAL illuminates, but 
SYNC does not illuminate

– The far end TestPad is not connected 
to the circuit.

– The near end element on the network 
side has a faulty receiver, or the far end 
element on the network side has a 
faulty transmitter.

– The near end and far end devices are 
configured for different rates (1G and 
2G Fibre Channel).

SIGNAL and SYNC illumi-
nate, but LINK ACTIVE 
does not illuminate

– The far end TestPad is not acquiring 
synchronization.

– You have configured the TestPad(s) for 
an Unframed (Layer 1) BERT test. The 
LINK ACTIVE LED does not illuminate 
when performing this test.
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Configuring the
traffic load

By default, the FST-2802 transmits a constant load of traffic at 100%. 
You can optionally configure the FST-2802 to transmit a different 
constant load, or bursty or ramped traffic. See “Traffic loads” on 
page 117 of Chapter 5 “Ethernet Testing” for a detailed description of 
each load type.

To configure the traffic load

1 If your TestPad has two ports, select the port you are configuring 
the traffic load for; otherwise, proceed to step 2.

2 Using the application buttons, select one of the following applica-
tions:
– TERM > 1G Fibre Channel > Layer 2 Traffic
– TERM > 2G Fibre Channel > Layer 2 Traffic

3 Select SETUP > Traffic.

NOTE:
You do not need to configure the traffic load for 1G pattern, 
2G pattern, or BER pattern tests; the FST-2802 automatically con-
figures the traffic load for you.
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4 Under Load Type, select one of the following:

5 If you selected Const in step 4, you can specify the bandwidth as a 
percentage of the line rate, or in Mbps.

To configure a constant load, do the following:

a Under Load Unit, select %BW to specify the bandwidth as a 
percentage of the line rate, or Mbps to specify the bandwidth in 
total Mbps.

b In Const Load, type the percentage or Mbps.

c Proceed to step 8 on page 192.

To transmit Select

A constant load of traffic Const, and then proceed to step 5 on 
page 189.

A bursty load of traffic Bursty, and then proceed to step 6 on 
page 190.

A ramped load of traffic Ramp, and then proceed to step 7 on 
page 191.
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6 If you selected Bursty in step 4, you can specify the burst band-
width as a percentage of the line rate, or by specifying the burst 
gap interval.

To configure a bursty load, under Burst Config, do the following:

a Select one of the following:

b Under No of Bursts, select Fixed, and then specify the fixed 
number of bursts (up to 65,535), or select Continuous.

c Proceed to step 8 on page 192.

To… Select…

Specify the gap between 
bursts

Burst Gap, and then do the 
following:
– Select the time interval 

(sec, msec, usec, or nsec)
– Type the gap and burst 

times in the corresponding 
fields.

Specify the load as a percent-
age of the bandwidth

%BW, and then type the load 
and frames per burst (up to 
16,500,000) in the correspond-
ing fields.
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7 If you selected Ramp in step 4, you must specify a percentage of 
bandwidth and a time interval for each step in the ramp.

To specify the ramp traffic parameters, do the following:

a In Time Step (sec), type the number of seconds to transmit 
each step in the ramp.

b In Load Step (%BW), type the percentage of bandwidth to 
transmit for each step in the ramp.

c Optional. If you want to stop the load from ramping when 
errored frames or dropped frames occur, under Stop Load 
Increment, select the corresponding option, and then type the 
number of frames which will stop the ramp.
The TestPad will continue to transmit traffic when the ramp 
stops; however, the traffic bandwidth will not be incremented. A 
message will appear in the message display to let you know the 
ramp was halted.
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d Proceed to step 8 on page 192.

8 Select OK to return to the main window, or select another tab to 
continue configuring your test.

9 Optional. If you want to configure the traffic load for a second port, 
select the port, and then repeat step 3 through step 8.

The traffic load is configured.

Defining receive
profiles

Defining a receive profile involves selecting the profile to define, and 
then specifying the characteristics of the frames you want to monitor. 
You can define up to four receive profiles on the Rx Profiles setup tab.

To define a receive profile

1 If your TestPad has two ports, select the port for the profile; other-
wise, proceed to step 2.

2 Using the application buttons, select one of the following applica-
tions:
– MON > 1G Fibre Channel > Layer 2 Traffic
– THRU > 1G Fibre Channel > Layer 2 Traffic (dual port units 

only)
– TERM > 1G Fibre Channel > Layer 2 Traffic
– MON > 2G Fibre Channel > Layer 2 Traffic
– THRU > 2G Fibre Channel > Layer 2 Traffic (dual port units)
– TERM > 2G Fibre Channel > Layer 2 Traffic

NOTE:
If you select Dropped Frames as the trigger, you must loop up the 
far-end FST-2802 to receive valid results. If you do not loop up the 
far-end FST-2802, and you select the Dropped Frames trigger, the 
ramp will stop soon after it starts because the near-end FST-2802 
will compare the number of frames transmitted to the number of 
frames received to determine whether frames were dropped. In 
other words, the ramp will stop because the test is not configured 
properly; not because elements in the network dropped the frames.
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3 Select SETUP > Rx Profiles.

4 If you are filtering traffic with a BERT pattern in the payload, under 
Rx Payload, select Tx = Rx to monitor traffic with the same BERT 
pattern specified in the Transmit (Tx) profile, or select a BERT 
pattern for the filter.

5 Under Settings, in Profiles, select the profile you want to define.

6 Specify the frame characteristics for the traffic filtered using the 
profile. 

In… Do this…

Des ID Filter – If you want to monitor frames sent to a 
specific port, select Yes, and then type the 
destination ID in Destination ID using a 3 
byte format.

– If you want to monitor all frames regard-
less of their destination, select Don’t Care.

Src ID Filter – If you want to monitor frames sent from a 
specific port, select Yes, and then type the 
source ID in Source ID using a 3 byte for-
mat.

– If you want to monitor all frames regard-
less of their source, select Don’t Care.
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7 Select OK.

8 Optional. If you want to define a receive profile for a second port, 
select the port, and then repeat step 3 through step 7.

The profile is stored and the main window appears.

Defining transmit
profiles

Defining a transmit profile involves selecting the profile to define, and 
then specifying the characteristics for each frame the TestPad trans-
mits using the profile. Although the frame payload is not part of the 
profile, you also select the type of payload to transmit (Acterna or 
BERT) on the Tx Profiles tab.

To define a transmit profile

1 If your TestPad has two ports, select the port for the profile; other-
wise, proceed to step 2.

Data Filter – If you want to monitor frames of a specific 
data type, select Yes, and then type the 
code representing the type in Data Type 
using a 1 byte format.

– If you want to monitor all frames regard-
less of their data type, select Don’t Care.

Seq Filter – If you want to monitor frames in a specific 
sequence, select Yes, and then type the 
sequence count in Sequence Cnt using a 
2 byte, hexadecimal format.

– If you want to monitor all frames regard-
less of sequence, select Don’t Care.

Routing Filter – If you want to monitor frames with the 
same routing control code, select Yes, and 
then type the code in Routing Ctrl using a 
1 byte format.

– If you want to monitor all frames regard-
less of their routing control code, select 
Don’t Care.

In… Do this…
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2 Using the application buttons, select one of the following applica-
tions:
– TERM > 1G Fibre Channel > Layer 2 Traffic
– TERM > 2G Fibre Channel > Layer 2 Traffic

3 Select SETUP > Tx Profiles.

4 If you want to transmit frames without a payload, proceed to 
step 5. If you want to transmit an Acterna payload or BERT 
pattern, under Payload, select one of the following:
– Acterna. To transmit frames with a time stamp and sequence 

number, select Acterna. You must select an Acterna payload 
to measure round trip delay and count lost frames.

– BERT Pattern. If you want to perform a BER test on a 
switched (layer 2) network, select BER Pattern to populate the 
payload by repeating a specific BER pattern, and then select 
the BER pattern to transmit in the payload.
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5 Under Settings, in Profiles, select the profile you want to define, 
and then specify the frame characteristics for the traffic trans-
mitted using the profile. 

6 Select OK.

7 Optional. If you want to define a transmit profile for a second port, 
select the port, and then repeat step 3 through step 6.

The profile is stored and the main window appears.

In… Do this…

Destination ID Type the destination ID of the port the frames 
will be transmitted to using a 3 byte format.

Originator ID Type the originator exchange ID for the 
frames using a 2 byte hexadecimal format.

Length Select the arrow to the right of the field to dis-
play a drop-down menu of field lengths. The 
default length is 512 bytes. You can select:
– 28 (no payload), 76, 512, 1024, 1536, or 

2076 for Acterna payloads.
– 28 (no payload), 32, 512, 1024, 1536, or 

2076 for BERT payloads.
– User Defined, and then specify a length 

ranging from 28 to 2076 bytes for BERT 
payloads, or 76 to 2076 bytes for an 
Acterna payload.

NOTE: If you select a 28 byte (no payload) 
frame length for an Acterna payload, no 
results associated with a payload will be avail-
able since no payload is transmitted in the 
frames.

Sequence ID Type the sequence ID for the frames using a 
2 byte hexadecimal format.

Source ID Type the source ID for the port transmitting 
the frames using a 3 byte format.

Responder ID Type the responder ID for the frames using a 
2 byte hexadecimal format.
196 FST-2802 TestPad User’s Guide Revision A



Chapter 6 Fibre Channel Testing
Out-of-service testing
End-to-end testing End-to-end testing allows you to verify that a provisioned path will 
carry Fibre Channel traffic generated from one TestPad to a second 
TestPad on the far end of a circuit (see Figure 20 on page 105).

To perform an end-to-end test

1 Establish connectivity (see “Establishing connectivity” on 
page 185), and then do one of the following.
– If you are performing the test on a switched (layer 2) Fibre 

Channel network, proceed to step 2.
– If you are performing the test on an unswitched (layer 1) point-

to-point network, proceed to step 5 on page 199.

2 Select SETUP > Tx Profiles.

3 Under Payload, select one of the following:
– Acterna. To transmit frames with a time stamp and sequence 

number, select Acterna. You must select an Acterna payload 
to measure round trip delay and count lost frames.

– BERT Pattern. To populate the payload by repeating a specific 
BERT pattern, select BERT Pattern, and then select the 
pattern to transmit in the payload. You must select the BERT 
Pattern payload to perform BER testing on a switched (layer 2) 
network.
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4 Select or define a profile:

For additional information on transmit profiles, see “Defining 
transmit profiles” on page 194.

To… Do this…

Select an existing pro-
file with the source ID 
of the TestPad on the 
far end as the desti-
nation ID for the traf-
fic.

Under Selections, select the profile.

Define a profile with the 
far end TestPad’s 
source ID as the des-
tination ID for the traf-
fic.

– Under Settings, select the profile to 
define from the Profiles field.

– In Destination ID, select the arrow to 
the right of the field to display a key-
pad. Using the keypad, type the 
source ID of the TestPad on the far 
end, and then select OK to enter the 
ID in the field.
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5 Do one of the following to configure the traffic load:
– If you specified or defined a transmit profile in step 4, select 

Traffic, and then configure the load (see “Configuring the 
traffic load” on page 188).

– If you didn’t specify or define a transmit profile (because you 
are performing the test on an unswitched point-to-point 
network), select SETUP > Traffic, and then configure the load.

6 Select OK to return to the main window.
– If you are performing an end-to-end test using a second port, 

repeat step 1 through step 6 for the second port before 
proceeding to step 7.

7 On the TestPad on the far end of the circuit, do the following:
– If you are performing the test on a switched (layer 2) network, 

repeat step 2 through step 6.
– If you are performing the test on an unswitched (layer 1) point-

to-point network, repeat step 5 and step 6.

8 On both TestPads, turn the laser on by selecting the Laser OFF 
button for each active port.
The Laser OFF button changes to Laser ON.

9 On both TestPads, for each active port, select Start Traffic to 
transmit traffic over the circuit.
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10 View and verify results for each transmitting TestPad on the 
Results Display of the receiving TestPad.

BER testing on
unswitched

(layer 1) networks

If you are testing on an unswitched network, when you perform an 
end-to-end test, you can transmit BER patterns in the bit stream to 
determine the ratio of erroneous bits to the total bits received.

To perform BER test on an unswitched network

1 If your TestPad has two ports, select the port for the profile; other-
wise, proceed to step 2.

2 Using the application buttons, select one of the following applica-
tions:
– MON > 1G Fibre Channel > Layer 1 BERT
– TERM > 1G Fibre Channel > Layer 1 BERT
– THRU > 1G Fibre Channel > Layer 1 BERT (dual port units 

only)
– MON > 2G Fibre Channel > Layer 1 BERT
– THRU > 2G Fibre Channel > Layer 1 BERT (dual port units 

only)
– TERM > 2G Fibre Channel > Layer 1 BERT

3 Select SETUP > BERT, and then select one of the following 
patterns:

To… Select…

– Test random jitter at a BER of 10-12 

– Test asymmetry of transition times
HFPAT

– Test low frequency random jitter
– Test PLL tracking errors

LFPAT

Test random and deterministic jitter (combined) MFPAT

Emulate a worst case scenario for deterministic 
jitter

RDPAT

Stress timing margins in the received eye by 
exposing the data sampling circuits to large 
systematic phase jumps

JTPAT
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4 Optional. If you want to insert bit errors or code violations into the 
bit stream, select the Error tab, and then do the following:

5 Select OK to return to the main window.
– If you want to perform a BER test from a second port, select 

the second port, and then repeat step 2 through step 5 for the 
second port.

6 For each active port, establish connectivity (see “Establishing 
connectivity” on page 185).

7 If you are performing the BERT in single port THRU mode (using 
the MON application button), for each active port on the far end 
TestPad, select Connect RX to TX.

8 For each active port, start the traffic using the Start BERT Pattern 
button.

Emulate a worse case scenario for power sup-
ply noise within network transceivers

SNPAT

To… Select…

Setup the TestPad to allow you 
to insert BIT errors into the bit 
stream

BIT.
– If you want the TestPad to 

beep each time it receives a 
bit error (or errors), under 
Beep On Error, select ON.

– If you want to insert a rate of 
bit errors, select Rate, and 
then select the rate.

Setup the TestPad to allow you 
to insert code violations into the 
bit stream 

Code Violations.
– If you want the TestPad to 

beep each time it receives a 
code violation (or violations), 
under Beep On Error, select 
ON.

– If you want to insert a rate of 
code violations, select Rate, 
and then select the rate.

To… Select…
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9 For each active port, verify that the Pattern Sync LED is illumi-
nated in the LED result category.

10 Optional. To insert bit errors or code violations into the bit stream, 
for each active port, select the Bit Error or CV Error button.

11 Verify the Error Stats: Bit Errors and Bit Error Rate results for each 
active port on a Results Display.

BER testing on
switched (layer 2)

networks

If you are testing on a switched Fibre Channel network, when you 
perform an end-to-end test you can transmit BER patterns in the frame 
payload to determine the ratio of erroneous bits to the total bits 
received.

To transmit a BER pattern on a switched network

1 If your TestPad has two ports, select a port for the test; otherwise, 
proceed to step 2.

2 Using the application buttons, select one of the following applica-
tions:
– MON > 1G Fibre Channel > Layer 2 Traffic
– THRU > 1G Fibre Channel > Layer 2 Traffic (dual port units 

only)
– TERM > 1G Fibre Channel > Layer 2 Traffic
– MON > 2G Fibre Channel > Layer 2 Traffic
– THRU > 2G Fibre Channel > Layer 2 Traffic (dual port units 

only)
– TERM > 2G Fibre Channel > Layer 2 Traffic

3 Select SETUP > Rx Profiles, and then define the receive profile 
for the traffic you want to BERT (see “Defining receive profiles” on 
page 192).

4 Select the Tx Profiles tab, and then do the following:

a Under Payload, select Bert Pattern, and then select 2^23-1, 
Inv 2^23-1, 2^31-1, Inv 2^31-1, ALL ONES, ALL ZEROS, or 
USER DEFINED. 

b If you selected USER DEFINED, type the user defined BER 
pattern using a 4 byte hexadecimal format.
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5 Optional. If you want to insert a framed bit error into the traffic, 
select the Error tab, and then do the following:

a Select Framed Bit.

b If you want the TestPad to beep each time it receives a framed 
bit (or bits), under Beep On Error, select ON.

c If you want to insert a rate of framed bits, select Rate, and then 
select the error rate.

6 Select OK to return to the main window.

7 Optional. If you want to transmit a BER pattern from the second 
port, select the second port, and then repeat step 2 through 
step 6.

8 Establish connectivity (see “Establishing connectivity” on 
page 185).

9 For each active port, select Start Traffic to transmit the pattern 
over the circuit.

10 For each active port, verify that the FRAME LED is illuminated.

11 Optional. To insert one or more framed bits into the traffic, for each 
active port, select the Framed Bit Error button.

12 For each active port, verify the Error Stats: Bit Errors and Bit Error 
Rate results on a Results Display.

Measuring service
disruption time

When you perform an end-to-end test, you can measure the service 
disruption time resulting from a switch in service to a protect line.

To measure service disruption time

1 Setup and configure an end-to-end test (see “End-to-end testing” 
on page 197).

NOTE:
When performing a BERT on a switched (layer 2) network, Bit 
Errors and Bit Error Rate results may indicate one or more physical 
layer (layer 1) bit errors.
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2 On the far end FST-2802, select SETUP > Traffic.

3 When measuring service disruption time, we recommend transmit-
ting a constant load at 100 percent by specifying the following 
parameters:

a Load Type: Const

b Load Unit: %BW

c Const Load: 100

4 Select OK to return to the main window.

5 Turn the laser on by selecting the Laser OFF button.
The Laser OFF button changes to Laser ON.

6 Select Start Traffic to transmit traffic over the circuit.

7 On the near end FST-2802, clear the service disruption time by 
selecting the Reset Svc Disruption action button.

8 Initiate the switch to the protect line.

9 Optional. If you want to measure service disruption time from a 
second port, select the second port, and then repeat step 2 
through step 8.

10 Verify the Link Stats: Svc Disruption (ms) result for each active 
port on a Results Display.
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Transmitting
patterns

Using the FST-2802, you can stress the jitter and noise characteristics 
of Fibre Channel components and systems by transmitting continuous 
random test patterns (CRPAT), continuous jitter test patterns (CJPAT), 
and the compliant supply noise pattern (CSPAT). To transmit a pattern, 
you select the pattern on the Pattern tab, and then you establish 
connectivity to a Fibre Channel link. Finally, you transmit the pattern 
over the link.

To transmit a pattern

1 If your TestPad has two ports, select a port for the test; otherwise, 
proceed to step 2.

2 On the application button bar, select one of the following applica-
tions:
– TERM > 1G Fiber Channel > Layer 2 Patterns
– TERM > 2G Fiber Channel > Layer 2 Patterns

3 Select SETUP > Summary to display the setup tabs, and then 
select Pattern. 

NOTE:
These patterns are designed to test physical layer networks. By def-
inition, these framed patterns populate the Fibre Channel header 
with invalid address information; therefore, these frames will not 
traverse a layer 2, switched network. You must run pattern tests 
using an end-to-end configuration at all times.
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The Pattern tab appears.

4 Select a pattern:

5 Select OK to return to the main window.

6 Establish connectivity (see “Establishing connectivity” on 
page 185).

7 Turn the laser on by selecting the Laser OFF button. 
The Laser OFF button changes to Laser ON.

8 Select Start Pattern to transmit the pattern over the circuit.

9 Optional. If you want to transmit patterns from a second port, 
select the port, and then repeat step 2 through step 8.

To… Select…

Emulate a worst case scenario for deter-
ministic jitter by transmitting packets with 
a broad spectral content

CRPAT

Stress the timing margins in the received 
eye by exposing the data sampling cir-
cuits to large systematic phase jumps.

CJPAT

Emulate a worse case scenario for power 
supply noise within network transceivers.

CSPAT
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10 For each active port, verify results on the Results Display of the 
TestPad. At a minimum, verify the following Pattern Stats results:
– Transmitted Frames
– Received Frames
– FCS Errored Frames

Loopback testing Loopback testing allows you to generate and transmit Fibre Channel 
traffic from one TestPad, and then loop the traffic back through a 
second TestPad (see Figure 17 on page 102) or a hard loopback on 
the far end of a circuit (see Figure 18 on page 103).

Using the Line
Loopback feature

You can manually perform a line loopback using two TestPads by 
selecting the LLB button on the far end TestPad to loop frames back 
to the originating TestPad.

To manually perform a line loopback

1 If your TestPad has two ports, select the port for the loopback test; 
otherwise, proceed to step 2.

2 Establish connectivity (see “Establishing connectivity” on 
page 185).
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3 Do one of the following:
– If you are performing the loopback on a point-to-point, 

unswitched (layer 1) network, proceed to step 4.
– If you are performing the loopback on a switched (layer 2) 

network, on the transmitting TestPad, configure the traffic port 
(see step 3 through step 6 of “End-to-end testing” on 
page 197).

4 On the far end TestPad, turn the laser on by selecting Laser OFF.
The Laser OFF button changes to Laser ON.

5 On the far end TestPad, select LLB OFF to put the TestPad into 
loopback mode.

NOTE:
If you want to filter the traffic looped back to the near end TestPad, 
the parameters you specify in the transmit profile for the near end 
TestPad must match the parameters specified in the receive profile 
for the far end TestPad. 
For example, if you want to loop back frames for a specific Routing 
Control code, the same Routing Control code must be specified in 
both profiles.
If you want to loop back all frames, select Don’t Care for each of 
the receive profile parameters.
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The LLB OFF button changes to LLB ON.

6 On the transmitting TestPad, select Start Traffic to transmit traffic 
over the circuit to the TestPad on the far end.

7 Optional. If you want to perform a line loopback from a second 
port, select the second port, and then repeat step 2 through 
step 6.

8 For each active port, verify results on the Results Display of the 
transmitting TestPad. At a minimum, verify the following results:
– Link Stats: Total Util%, Avg, Total Util %, Cur, and Total Util % 

Peak.
– Error Stats: All results are 0.

Using the Automatic
Loopback feature

You can perform an automatic loopback on an unswitched network by 
selecting the Loop Up button on the traffic generating TestPad. A 
confirmation message from the TestPad on the far end appears in the 
message display of the first TestPad informing you that the far end 
TestPad is in loopback mode. The destination ID in the loopback 
profile for the first TestPad is also automatically populated with the 
source ID of the TestPad on the far end.
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When you configure TestPads for an automatic loopback test, you can 
optionally specify text identifiers for each TestPad (for example, “Joe’s 
2802” and “Sam’s 2802”). When the TestPads send confirmation 
messages to each other indicating the status of the loopback, the 
message will identify each TestPad using the text identifier.

To perform an automatic loopback

1 If your TestPad has two ports, select the port for the loopback test; 
otherwise, proceed to step 2.

2 Establish connectivity (see “Establishing connectivity” on 
page 185).

3 On the far end TestPad, select SETUP > Summary, and then do 
the following:
– Select the Tx Profiles tab.
– Under Settings, in Profiles, select Loop Profile.
– In Source ID, type the source ID for the traffic looped back to 

the traffic generating TestPad.

4 Optional. If you want to provide an identifier in the confirmation 
messages sent between TestPads, for each TestPad, do the 
following:

a Select SETUP > Summary to display the setup tabs.

NOTE:
After you establish the loop, you can change the source ID specified 
for the traffic in the far end TestPad’s loopback profile. This will not 
bring down the loop.

NOTE:
If you want to filter the traffic looped back to the near end TestPad, 
the parameters you specify in the transmit profile for the near end 
TestPad must match the parameters specified in the receive profile 
for the far end TestPad. 
For example, if you want to loop back frames for a specific Routing 
Control code, the same Routing Control code must be specified in 
both profiles.
If you want to loop back all frames, select Don’t Care for each of 
the receive profile parameters.
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b Select ID to display the ID tab, and then select Edit to display a 
keypad.

c Using up to ten characters, type the identifier for the TestPad, 
and then select OK to store the identifier and return to the ID 
tab.

d Select OK to return to the main window.

5 On the traffic generating TestPad, select Loop Up to put the 
receiving TestPad on the far end into loopback mode.
A confirmation message from the TestPad on the far end appears 
in the message display of the first TestPad informing you that the 
far end TestPad is in loopback mode. The destination ID field of 
the loopback profile is automatically updated with the source ID of 
the far end TestPad.

6 On the traffic generating TestPad, turn the laser on by selecting 
Laser OFF.
The Laser OFF button changes to Laser ON.

7 On the traffic generating TestPad, select Start Traffic to transmit 
traffic over the circuit to the TestPad on the far end.

8 Optional. If you want to perform a loopback from a second port, 
select the port, and then repeat step 2 through step 7.

9 Verify results for each active port on the Results Display of the 
traffic generating TestPad. At a minimum, verify the following 
results:
– Link Stats: Total Util%, Avg, Total Util %, Cur, and Total Util % 

Peak.
– Error Stats: All results are 0.

10 When the test is complete, for each active port, select Loop Down 
to take the receiving port on the far end TestPad out of loopback 
mode.
A confirmation message from the TestPad on the far end appears 
in the message display of the first TestPad informing you that the 
port on the far end TestPad is out of loopback mode.

Inserting a CRC
error

You can insert a CRC error when you perform end-to-end and loop-
back tests.
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To insert a CRC error

1 If your TestPad has two ports, select the port for the error inser-
tion; otherwise, proceed to step 2.

2 Using the application buttons, select one of the following applica-
tions:
– TERM > 1G Fibre Channel > Layer 2 Traffic
– TERM > 2G Fibre Channel > Layer 2 Traffic

3 Select SETUP > Summary to display the setup tabs, and then 
select Error.

NOTE:
If you insert a CRC error on an unswitched point-to-point network 
using two FST-2802s, and you want to receive the CRC back at the 
originating TestPad, put the TestPad on the far end of the circuit in 
THRU mode. See “Monitoring Fibre Channel traffic in single port 
THRU mode” on page 215 for information on THRU mode.
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4 To specify the error parameters, do the following:

5 Select OK to store the error parameters and return to the main 
window.

6 Turn the laser on by selecting Laser OFF.
The Laser OFF button changes to Laser ON.

7  Select Start Traffic to transmit traffic over the circuit.

8 Select the CRC Errors action button to insert the error or burst of 
errors.

9 Optional. If you want to insert errors from a second port, select the 
port, and then repeat step 3 through step 8.

The error is inserted into the traffic and is handled as follows:

– For end-to-end applications, the error is transmitted to the TestPad 
on the far end of the circuit.

– For loopback applications, the error is typically looped back to the 
TestPad. Consult your network element documentation to deter-
mine if the network element drops errored traffic.

To… Do this…

Specify that the TestPad 
should beep whenever 
a CRC error occurs

Under Beep on Error, select ON.

Insert a single CRC 
error

Select SINGLE.

Insert a burst of CRC 
errors

Select BURST.
A BURST (Qty) field appears.
– Select the arrow to the right of the 

BURST (Qty) field to display a key-
pad.

– Using the keypad, type the number of 
CRC errors to insert in the burst.
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Measuring round
trip delay

When you perform loopback tests, you can measure round trip delay 
by transmitting an Acterna payload with frames of a pre-defined length 
(28, 76, 512, 1024, 1536, or 2076 bytes). The Acterna payload carries 
frames with time stamps, enabling the FST-2802 to calculate the round 
drip delay.

To measure round trip delay

1 Setup and configure a loopback test (see “Loopback testing” on 
page 207).

2 Select SETUP > Tx Profiles, and then do the following:
– Under Payload, select Acterna. The Acterna payload transmits 

frames with a time stamp and sequence number. You must 
select an Acterna payload to measure round trip delay.

– In Length, select a pre-defined frame length (28, 76, 512, 
1024, 1536, or 2076 bytes).

3 Select OK to return to the main window.

4 Turn the laser on by selecting Laser OFF.
The Laser OFF button changes to Laser ON.

5 Select Start Traffic to transmit traffic over the circuit.

6 Optional. If you want to measure round trip delay from the second 
port, select Port 2, and then repeat step 2 through step 5.

7 Verify results for each active port on the Results Display of the 
transmitting TestPad. At a minimum, verify the following Link Stats 
results:
– Delay, Max (us)
– Delay, Min (us)
– Delay, Avg (us)

NOTE:
When you measure round trip delay, you must implement a loop-
back on the far end of the circuit, and then transmit and receive an 
Acterna payload with test frames from a FST-2802 on the near end 
of the circuit. If you do not use a loopback, the test results will be 
invalid.
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In-service testing 
Using the FST-2802, you can monitor Fibre Channel traffic when the 
network is in service. To perform in-service tests, you simply connect 
the TestPad to a network device on the circuit, and then monitor the 
Fibre Channel traffic on the circuit.

Monitoring traffic
using a splitter

You can monitor Fibre Channel traffic on a circuit by connecting the 
TestPad to a splitter (see Figure 13 on page 97).

To monitor Fibre Channel traffic using a splitter

1 If your TestPad has two ports, select a port for the test; otherwise, 
proceed to step 2.

2 On the application button bar, select one of the following applica-
tions:
– MON > 1G Fibre Channel > Layer 1 BERT
– MON > 1G Fibre Channel > Layer 2 Traffic
– MON > 2G Fibre Channel > Layer 1 BERT
– MON > 2G Fibre Channel > Layer 2 Traffic

3 Optional. If you want to monitor traffic from the second port, select 
the second port.

4 Using the correct cable for the splitter, connect one end of the 
cable to the RX jack of the TestPad, and the other end to the TX 
jack of the splitter.
– If you are monitoring traffic on a second port, repeat this step 

for the second port.

5 Verify the Error Stats results for each active port.

Monitoring Fibre
Channel traffic in
single port THRU

mode

You can monitor Fibre Channel traffic on a circuit in THRU mode (see 
Figure 14 on page 98). 
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To monitor Fibre Channel traffic in single port THRU mode

1 On the application button bar, select one of the following applica-
tions:
– MON > 1G Fibre Channel > Layer 1 BERT
– MON > 1G Fibre Channel > Layer 2 Traffic
– MON > 2G Fibre Channel > Layer 1 BERT
– MON > 2G Fibre Channel > Layer 2 Traffic

2 If you want to loop the frames received through to the transmitter 
(instead of transmitting idle frames), select the Connect RX to TX 
button.

3 Using the correct cable for the switch, connect one end of the 
cable to the TX jack of the TestPad, and the other end to the RX 
jack of the switch.

4 Using the correct cable for the network access element, connect 
one end of the cable to the RX jack of the TestPad, and the other 
end to the TX jack of the network access element.

5 Select Laser OFF to turn the laser on. The Laser OFF button 
changes to Laser ON.

6 Verify the Error Stats results on the Results Display.

Monitoring Fibre
Channel traffic in

dual port THRU
mode

If you have a dual port configuration, you can monitor full duplex Fibre 
Channel traffic from both directions in THRU mode (see Figure 14 on 
page 98). When you monitor traffic in dual port THRU mode, the 
TestPad routes all traffic received on Port 1 to the transmit jack on Port 
2, and all traffic received on Port 2 to the transmit jack on Port 1.

To monitor Fibre Channel traffic in dual port THRU mode

1 Using the correct cable for the switch, connect one end of the 
cable to the Port 1 TX jack of the TestPad, and the other end to the 
RX jack of the switch.

2 Using the correct cable for the network access element, connect 
one end of the cable to the Port 1 RX jack of the TestPad, and the 
other end to the TX jack of the network access element.
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3 Using the correct cable for the switch, connect one end of the 
cable to the Port 2 TX jack of the TestPad, and the other end to the 
RX jack of the switch.

4 Using the correct cable for the network access element, connect 
one end of the cable to the Port 2 RX jack of the TestPad, and the 
other end to the TX jack of the network access element.

5 For each port, do the following:

a Select the port.

b On the application button bar, select THRU > 1G Fibre 
Channel > Layer 2 Traffic, or THRU > 2G Fibre Channel > 
Layer 2 Traffic.

6 Select Laser OFF to turn the laser on for both ports. The Laser 
OFF button changes to Laser ON.

7 Verify the Error Stats results for each active port.

NOTE:
When you select a MON (monitor) or TERM (terminate) application 
after testing in THRU mode, the TestPad will automatically config-
ure both ports for the test you selected (using the default test 
parameters), and the port selection buttons will be enabled allowing 
you to control each port independently.
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7

This chapter describes test results for the FST-2802. Topics discussed 
in this chapter are as follows:

– “About test results” on page 220
– “Summary results” on page 220
– “LED results” on page 222
– “Signal results” on page 223
– “Time results” on page 224
– “AutoNeg Status results” on page 224
– “Link Stats results” on page 227
– “Link Counts results” on page 228
– “Filter Stats results” on page 231
– “Filter Counts results” on page 232
– “Error Stats results” on page 234
– “Pattern Stats results” on page 237
– “Ping Stats results” on page 237
– “L1 Bert Stats results” on page 238
– “L2 Bert Stats results” on page 239
– “Custom results” on page 240
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About test results
After you connect the TestPad, results for the configured test automat-
ically accumulate. The result categories available depend on their 
applicability to the test you configured. For example, if you configured 
a port for an unframed BERT test, the Summary, LED, Signal, Time, 
Error Stats, and L1 BERT Stats categories are available for the port. 
Ping Stats, Pattern Stats, L2 BERT Stats categories are not available 
because they are not applicable when performing an unframed BERT 
test.

To view the results for your test, select a port and category in each 
result pane.

Summary results
The Summary category automatically displays error results that are 
non-zero, key results that are out-of-specification, or key informational 
results. This allows quick access to the results without having to 
search each category.

If an errored or out of specification result appears, the pane has a red 
background. If only informational results appear, the pane has a white 
background. If all Summary results are within the recommended spec-
ifications, no alarms are present, and no informational results apply, 
the ALL SUMMARY RESULTS OK message appears in the result 
pane with a green background (see Figure 34).
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When errors are detected, the summary result window lists each error 
that occurred, and the result pane is red (see Figure 35).

Figure 34 All Summary Results OK display

Figure 35 Summary results
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The TestPad offers two types of LED results:

– Current and historical status and alarm LED results, displayed on 
the LED display panel.

– LED test results displayed in the Results Display of the user inter-
face for the LED result category.

About status and
alarm LEDs

Current and historical Status and Alarm LEDs are provided on the LED 
display panel. The inside column of LEDs indicate the current condi-
tion or state of the link; the outside column of LEDs indicate the histor-
ical condition of the link.

Status LEDs The inside green LEDs for SIGNAL, SYNC, LINK ACTIVE, and 
FRAME illuminate sequentially when the TestPad detects a signal, 
obtains synchronization, recognizes a link is active, and then detects 
frames. If a signal, synchronization, link or frame detection is lost, the 
green Status LED extinguishes, and the red Alarm LED in the history 
column illuminates indicating an error condition has occurred.

Alarm LEDs The red Alarm LEDs illuminate when an error condition, such as a loss 
of a signal or synchronization occurs. For the SIGNAL, SYNC, LINK 
ACTIVE, and FRAME categories, the red LED illuminates in the 
outside (History) column.

Figure 36 Dual port LED display panel

1 Gbps/2 Gbps
SIGNAL
SYNC

LINK ACTIVE
FRAME

SUMMARY

History

10/100 Mbps
SYNC

LINK ACTIVE
FRAME

SUMMARY

Port 1 Port 2
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For the SUMMARY category, the red LED illuminates in the inside 
column whenever a summary error occurs. To view summary errors on 
a results pane, select the Summary results category.

LED results
category

You can also view LED results by selecting the LED results category. 
Table 14 describes the LED results.

Signal results
The Signal results category displays the GBIC Status result, which 
displays one of the following:

– If a supported GBIC is in the GBIC port, the type of Gigabit 
Interface Converter (GBIC) the TestPad detects is displayed.

– If a GBIC which is not supported by the TestPad is in the GBIC 
port, the result indicates that the GBIC is not supported.

– If no GBIC is detected, the result indicates that there is no 
GBIC.

Table 14 LED results

LED When illuminated, indicates:

Frame Detect The TestPad has detected frames.

Link Active The link is active.

L1 Patt Sync The data contained on the incoming bit stream is 
synchronized with a BERT pattern.

L2 Patt Sync The data contained inside the frame payload is syn-
chronized with a BERT pattern.

Signal Present A signal is present (1G and 2G tests only).

Sync Acquired Synchronization has been acquired.

Pause Frame 
Detect*

The TestPad has detected valid pause frames.
* Only available when testing Ethernet.

VLAN Frame 
Detect

The TestPad has detected VLAN Ethernet frames 
as defined in IEEE 802.p/q. This LED only appears 
for TestPads with the VLAN Tagging option.
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To view the GBIC Status result, use the Result Group button to set the 
port for the GBIC, and then set the result category to Signal.

Time results
The Time category lists the current time, date, and the amount of time 
that has elapsed since the last test restart. Table 15 describes Time 
results. To view time results, set the result category to Time.

AutoNeg Status results
The AutoNeg Status category displays results associated with the 
auto-negotiation of capabilities between two Ethernet devices. 
Table 16 describes 1G AutoNeg Status results; Table 17 describes 10/
100 AutoNeg Status results. To view AutoNeg Status results, set the 
result category to AutoNeg Status.

NOTE:
The Signal results category is only available for 1G Ethernet, 
1G Fibre Channel, and 2G Fibre Channel tests.

Table 15 Time results

Test Result Description

Date The current day and month.

Elapsed Time The elapsed time in hours, minutes, and seconds 
since the last test restart on the port.

Time The current time of day in hours, minutes, and sec-
onds.

NOTE:
AutoNeg Status results only appear when auto-negotiation is turned 
ON on the TestPad.
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Table 16 1G AutoNeg Status results

Test Result Description

FDX Capable Indicates that the Ethernet link partner is full duplex 
capable.

HDX Capable Indicates that the Ethernet link partner if half duplex 
capable.

Link Adv Status Indicates that the FST-2802 has received a valid 
auto-negotiation capability advertisement from the 
Ethernet link partner and sent an acknowledge-
ment.

Link Config ACK Indicates that the Ethernet link partner has acknowl-
edged the receipt of a valid auto-negotiation capa-
bility advertisement from the FST-2802.

Pause Capable Indicates the flow control capabilities of the Ethernet 
link partner. Those capabilities are:
– TX Only:

The Ethernet link partner will transmit PAUSE 
frames to alert the FST-2802 to reduce the 
transmitted bandwidth momentarily, however it 
will not reduce its transmitted bandwidth if it 
receives PAUSE frames.

– RX Only:
The Ethernet link partner will reduce its transmit-
ted bandwidth momentarily if it receives PAUSE 
frames but it will not transmit PAUSE frames to 
alert the FST-2802 to reduce the transmitted 
bandwidth.

– TX and RX: 
The Ethernet link partner will transmit PAUSE 
frames to alert the FST-2802 to reduce the 
transmitted bandwidth momentarily and it will 
reduce its transmitted bandwidth momentarily if 
it receives PAUSE frames 

– Neither TX and RX:
The Ethernet link partner will not transmit 
PAUSE frames to alert the FST-2802 to reduce 
the transmitted bandwidth and it will not reduce 
its transmitted bandwidth if it receives PAUSE 
frames.
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Table 17 describes 10/100 AutoNeg Status results.

Remote Fault If supported by the Ethernet link partner, indicates a 
reason for auto-negotiation failure. If auto-negotia-
tion succeeded, the result will read “NO”.

Table 17 10/100 AutoNeg Status results

Test Result Description

100Base-TX 
FDX

Indicates whether the Ethernet link partner is full 
duplex capable at 100Base-TX (YES or NO).

100Base-TX 
HDX

Indicates whether the Ethernet link partner is half 
duplex capable at 100Base-TX (YES or NO).

10Base-T FDX Indicates whether the Ethernet link partner is full 
duplex capable at 10Base-TX (YES or NO).

10Base-T HDX Indicates whether the Ethernet link partner is half 
duplex capable at 10Base-TX (YES or NO).

Duplex Indicates the negotiated duplex setting for the link 
(half or full).

Link Adv Status Indicates that the FST-2802 has received a valid 
auto-negotiation capability advertisement from the 
Ethernet link partner and sent an acknowledge-
ment.

Link Config ACK Indicates that the Ethernet link partner has acknowl-
edged the receipt of a valid auto-negotiation capa-
bility advertisement from the FST-2802.

Remote Fault If supported by the Ethernet link partner, indicates a 
reason for auto-negotiation failure. If auto-negotia-
tion succeeded, the result will read “NO”.

Speed (Mbps) Indicates the negotiated speed setting for the link 
(10 or 100 Mbps).

Table 16 1G AutoNeg Status results (Continued)

Test Result Description
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Link Stats results
The Link Stats category lists link statistics such as the average frame 
rate, peak frame rate, and the maximum, minimum, and average 
round trip delay measurements. Table 18 describes Link Stats results. 
To view Link Stats results, set the result category to Link Stats. 

Table 18 Link Stats results

Test Result Description

Delay, Avg (us) The average round trip delay calculated in micro-
seconds. You must originate an Acterna payload to 
measure round trip delay. A unit in loopback mode 
will display invalid results because it is not originat-
ing the traffic.

Delay, Max (us) The maximum round trip delay calculated in micro-
seconds. You must originate an Acterna payload to 
measure round trip delay. A unit in loopback mode 
will display invalid results because it is not originat-
ing the traffic.

Delay, Min (us) The minimum round trip delay calculated in micro-
seconds. You must originate an Acterna payload to 
measure round trip delay. A unit in loopback mode 
will display invalid results because it is not originat-
ing the traffic.

Frame Rate, Avg The average rate of received frames, expressed in 
frames per second. The average is calculated over 
the time period elapsed since the last test restart.

Frame Rate, Cur The current rate of received frames, expressed in 
frames per second. This measurement is an aver-
age taken over the prior second of test time.

Frame Rate, Min The minimum rate of received frames over a one 
second period, expressed in frames per second.

Frame Rate, 
Peak

The maximum rate of received frames over a one 
second period, expressed in frames per second.

Frame Size, Avg The average frame size of frames received since 
frame detection.

Frame Size, Max The maximum frame size of frames received since 
frame detection.
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Link Counts results
The Link Counts category lists link counts such as the number of 
received frames, number of transmitted frames, and number of 
unicast, multicast, or broadcast frames. The Received Frames result 
includes errored frames; all other results count valid frames only.

To view Link Counts results, set the result category to Link Counts.

Frame Size, Min The minimum frame size of frames received since 
frame detection.

Rx Mbps, Cur The current bandwidth utilized by the received traffic 
expressed in megabits per second. This measure-
ment is an average taken over the prior second of 
test time.

Svc Disruption 
(ms)

The service disruption time (maximum inter-frame 
gap) when service switches to a protect line calcu-
lated in milli-seconds.

Total Util %, Avg The average bandwidth utilized by the received traf-
fic, expressed as a percentage of the line rate of 
available bandwidth since the last test restart. The 
average is calculated over the time period elapsed 
since the last test restart.

Total Util %, Cur The current bandwidth utilized by the received traffic 
expressed as a percentage of the line rate of avail-
able bandwidth. This measurement is an average 
taken over the prior second of test time.

Total Util %, Peak The peak bandwidth utilized by the received traffic 
since the last test restart expressed as a percent-
age of the line rate of available bandwidth.

Tx Mbps, Cur The current bandwidth utilized by the transmitted 
traffic expressed in megabits per second. This mea-
surement is an average taken over the prior second 
of test time.

Table 18 Link Stats results (Continued)

Test Result Description
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Table 19 Link Counts results

Test Result Description

>1023 Byte Frames A count of Ethernet frames with a length 
greater than 1023 bytes.

>2140 Byte Frames A count of Fibre Channel frames with a 
length greater than 2140 bytes.

1024-2140 Byte Frames A count of Fibre Channel frames with 
lengths between 1024 and 2140 bytes, 
inclusive.

128-252 Byte Frames A count of Fibre Channel frames with 
lengths between 128 and 252 bytes, inclu-
sive.

128-255 Byte Frames A count of Ethernet frames with lengths 
between 128 and 255 bytes, inclusive.

256-508 Byte Frames A count of Fibre Channel frames with 
lengths between 256 and 508 bytes, inclu-
sive.

256-511 Byte Frames A count of Ethernet frames with lengths 
between 256 and 511 bytes, inclusive.

28-64 Byte Frames A count of Fibre Channel frames with 
lengths between 28 and 64 bytes, inclu-
sive.

512-1020 Byte Frames A count of Fibre Channel frames with 
lengths between 512 and 1020 bytes, 
inclusive.

512-1023 Byte Frames A count of Ethernet frames with lengths 
between 512 and 1023 bytes, inclusive.

64 Byte Frames A count of Ethernet frames with a length of 
64 bytes.

65-127 Byte Frames A count of Ethernet frames with lengths 
between 65 and 127 bytes, inclusive.

68-124 Byte Frames A count of Fibre Channel frames with 
lengths between 68 and 124 bytes, inclu-
sive.

Broadcast Frames The number of Ethernet broadcast frames 
received since the last test restart.
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Multicast Frames The number of Ethernet multicast frames 
received since the last test restart.

PAUSE Frames A count of PAUSE frames received from a 
remote Ethernet device. PAUSE frames 
are utilized for flow control and alert the 
transmitting device that it must reduce the 
outgoing frame rate or risk a receiver over-
flow on the far end, resulting in dropped 
traffic.

Received Frames A count of frames received since the last 
test restart, including errored frames.

Rx Acterna Frames A count of received Acterna frames, 
excluding errored frames.

Rx Collisions A count of the number of times the Test-
Pad has received a jam signal while it was 
not transmitting frames. Result only 
appears for half-duplex 10/100 Ethernet 
tests.

Transmitted Frames A count of frames transmitted since the 
last test restart. This result does not 
appear when testing in Monitor mode.

Tx Collisions A count of the number of times the Test-
Pad has transmitted a frame, and then 
received a jam signal in the time slot for 
the frame. Result only appears for half-
duplex 10/100 Ethernet tests.

Tx Defers A count of the number of times the trans-
mitter prepared to send traffic, and then 
was forced to defer based on link activity. 
Result only appears for half-duplex 10/100 
Ethernet tests.

Tx Late Collisions A count of the number of times the Test-
Pad has transmitted a frame, and then 
experiences a collision more than 64 byte 
times after the transmission begins. Result 
only appears for half-duplex 10/100 Ether-
net tests.

Table 19 Link Counts results (Continued)

Test Result Description
230 FST-2802 TestPad User’s Guide Revision A



Chapter 7 Test Results
Filter Stats results
Filter Stats results
The Filter Stats category lists link statistics for filtered traffic such as 
the average frame rate, peak frame rate, and the maximum, minimum, 
and average round trip delay measurements. Table 20 describes Filter 
Stats results. To view Filter Stats results, set the result category to 
Filter Stats. 

Unicast Frames The number of Ethernet unicast frames 
received since the last test restart.

VLAN Frames A count of VLAN frames as defined in 
IEEE 802.p/q. This result only appears for 
TestPads with the VLAN Tagging option.

Table 19 Link Counts results (Continued)

Test Result Description

Table 20 Filter Stats results

Test Result Description

Frame Rate, Avg The average rate of filtered frames, expressed in 
frames per second. The average is calculated over 
the time period elapsed since the last test restart.

Frame Rate, Cur The current rate of filtered frames, expressed in 
frames per second. This measurement is an aver-
age taken over the prior second of test time.

Frame Rate, Min The minimum rate of filtered frames over a one sec-
ond period, expressed in frames per second.

Frame Rate, 
Peak

The maximum rate of filtered frames over a one 
second period, expressed in frames per second.

Frame Size, Max The maximum frame size of filtered frames received 
since frame detection.

Frame Size, Min The minimum frame size of filtered frames received 
since frame detection.

Delay, Avg The average round trip delay calculated in micro-
seconds. You must transmit an Acterna payload to 
calculate round trip delay.
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The Filter Counts results category displays counts for filtered traffic 
such as the number of received frames, and the number of received 
frames with an Acterna payload. Table 21 describes Filter Counts 
results. To view Filter Counts results, set the result category to Filter 
Counts.

Delay, Max The maximum round trip delay calculated in micro-
seconds. You must transmit an Acterna payload to 
calculate round trip delay.

Delay, Min The minimum round trip delay calculated in micro-
seconds. You must transmit an Acterna payload to 
calculate round trip delay.

Util %, Avg The average bandwidth utilized by the filtered traffic, 
expressed as a percentage of the line rate of avail-
able bandwidth since the last test restart. The aver-
age is calculated over the time period elapsed since 
the last test restart.

Util %, Cur The current bandwidth utilized by the filtered traffic 
expressed as a percentage of the line rate of avail-
able bandwidth. This measurement is an average 
taken over the prior second of test time.

Util %, Peak The peak bandwidth utilized by the filtered traffic 
since the last test restart expressed as a percent-
age of the line rate of available bandwidth.

Table 20 Filter Stats results (Continued)

Test Result Description

Table 21 Filter Counts results

Test Result Description

>1023 Byte Frames A count of filtered Ethernet frames with a 
length greater than 1023 bytes.

>2140 Byte Frames A count of filtered Fibre Channel frames 
with a length greater than 2140 bytes.
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1024-2140 Byte Frames A count of filtered Fibre Channel frames 
with lengths between 1024 and 2140 
bytes, inclusive.

128-252 Byte Frames A count of filtered Fibre Channel frames 
with lengths between 128 and 252 bytes, 
inclusive.

128-255 Byte Frames A count of filtered Ethernet frames with 
lengths between 128 and 255 bytes, inclu-
sive.

256-508 Byte Frames A count of filtered Fibre Channel frames 
with lengths between 256 and 508 bytes, 
inclusive.

256-511 Byte Frames A count of filtered Ethernet frames with 
lengths between 256 and 511 bytes, inclu-
sive.

28-64 Byte Frames A count of filtered Fibre Channel frames 
with lengths between 28 and 64 bytes, 
inclusive.

512-1020 Byte Frames A count of filtered Fibre Channel frames 
with lengths between 512 and 1020 bytes, 
inclusive.

512-1023 Byte Frames A count of filtered Ethernet frames with 
lengths between 512 and 1023 bytes, 
inclusive.

64 Byte Frames A count of filtered Ethernet frames with a 
length of 64 bytes.

65-127 Byte Frames A count of filtered Ethernet frames with 
lengths between 65 and 127 bytes, inclu-
sive.

68-124 Byte Frames A count of filtered Fibre Channel frames 
with lengths between 68 and 124 bytes, 
inclusive.

Broadcast Frames The number of filtered Ethernet broadcast 
frames received since the last test restart.

Multicast Frames The number of filtered Ethernet multicast 
frames received since the last test restart.

Table 21 Filter Counts results (Continued)

Test Result Description
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Error Stats results
The Error Stats category lists error statistics such as the number of 
symbol errors, FCS errored frames, and runts. Table 22 describes 
Error Stats results. To view Error Stats results, set the result category 
to Error Stats.

Rx Acterna Frames A count of filtered frames with an Acterna 
payload, excluding errored frames.

Unicast Frames The number of filtered Ethernet unicast 
frames received since the last test restart.

Valid Rx Frames A count of filtered frames received since 
the last test restart, including errored 
frames.

VLAN Frames A count of filtered VLAN frames as defined 
in IEEE 802.p/q. This result only appears 
for TestPads with the VLAN Tagging 
option.

Table 21 Filter Counts results (Continued)

Test Result Description

Table 22 Error Stats results

Test Result Description

Code Violation 
Rate

The rate of frames with code violations, expressed 
in frames per second. This measurement is an aver-
age taken over the prior second of test time.

Code Violations A count of each invalid 10-bit code word in the bit 
stream.

Code Violation 
Secs

A count of the number of seconds during which 
code violations occurred.

CRC Errored 
Frames

A count of Fibre Channel frames containing Cyclic 
Redundancy Check (CRC) errors.

Errored Frames A summed count of FCS Errored Frames (Ether-
net), CRC Errored Frames (Fibre Channel), Runts, 
Jabbers, Undersized Frames, and Oversized 
Frames.
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FCS Errored 
Frames*

A count of Ethernet frames containing Frame Check 
Sequence (FCS) errors. When receiving Ethernet 
jumbo frames containing FCS errors, the FCS error 
count does not increment. Instead, these frames 
are counted as Jabbers.
* For Ethernet ping applications, the FCS Errored 
Frames result is the only result displayed in the 
Error Stats category. The other Error Stats results 
are not applicable.

Fibre Runts A count of received Fibre Channel frames that have 
a byte value less than the minimum 28 byte frame 
length containing CRC errors.

Fibre Jabbers A count of received Fibre Channel frames that have 
a byte value greater than the maximum 2140 frame 
length and an errored CRC.

Frame Loss 
Ratio

The ratio of frames lost to the number of frames 
expected.

Jabbers A count of received Ethernet frames that have a 
byte value greater than the maximum 1518 frame 
length (or 1522 bytes for VLAN tagged frames) and 
an errored FCS.

Lost Frames A count of lost Acterna test frames. For example, if 
the TestPad detects sequence numbers: 1, 2, 3, 6, 
7, 8, (frames 4 and 5 were not detected), the lost 
frame count is incremented by two (frames 4 and 5 
are lost). If the TestPad then detects sequence 
numbers 9, 10, 14, 15, 16 (frames 11, 12, and 13 
are missing), the lost frame count is incremented by 
three, resulting in a total count of five lost frames.

NOTE: If the TestPad receives errored frames con-
taining errors in the sequence number field, the Lost 
Frames count will be incorrect.

Table 22 Error Stats results (Continued)

Test Result Description
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Out of Seq 
Frames

A count of each instance where the TestPad detects 
out of sequence Acterna test frames. For example, 
if the TestPad detects sequence numbers: 1, 2, 3, 6, 
7, 8, (frame 6 is detected immediately following 
frame 3), the out of sequence count is incremented 
by one, resulting in a count of one instance of out of 
sequence frames. If the TestPad then detects 
sequence numbers 9, 10, 14, 15, 16 (frame 14 is 
detected immediately following frame 10), the out of 
sequence number is incremented again by one, 
resulting in a total count of two instances of out of 
sequence frames.

Oversized 
Frames

A count of frames over the maximum 1518 byte 
(Ethernet) or 2140 byte (Fibre Channel) frame 
length with no FCS or CRC errors. 
NOTE: If the TestPad is set up to transmit jumbo 
Ethernet frames, frames exceeding 1518 bytes (or 
1522 bytes for VLAN tagged frames) are not consid-
ered oversized.

Runts A count of Ethernet frames under the minimum 64 
byte frame length containing Frame Check 
Sequence (FCS) errors.

Symbol Errors A count of invalid 10-bit code words received on the 
physical layer. This result will not increment more 
than one time per frame.

Undersized 
Frames

A count of frames under the minimum 64 byte 
(Ethernet) or 24 byte (Fibre Channel) frame length 
with no FCS or CRC errors.

Table 22 Error Stats results (Continued)

Test Result Description
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Pattern Stats results
The Pattern Stats category displays results associated with the trans-
mission of patterns over a circuit. Table 23 describes Pattern Stats 
results. To view Pattern Stats results, transmit a pattern over a circuit, 
and then set the result category to Pattern Stats.

Ping Stats results
The Ping Stats category displays results associated with the transmis-
sion of Ethernet Ping packets. Table 24 describes Ping Stats results. 
To view Ping Stats results transmit a ping packet (or packets) over a 
circuit, and then set the result category to Ping Stats.

Table 23 Pattern Stats results

Test Result Description

Received 
Frames

The number of valid and errored frames received 
since the link was established.

Transmitted 
Frames

The number of frames transmitted since the link 
was established.

Table 24 Ping Stats results

Test Result Description

Lost Pings Count of Ping requests sent by the FST-2802 for 
which replies were not received within 3 seconds.

Ping Requests Rx Count of the Ping requests received by the FST-
2802 (in other words, requests sent to the FST-
2802’s IP address) from another Layer 3 device on 
the network.

Ping Requests Tx Count of the ping requests sent from the FST-
2802.

Ping Responses 
Rx

Count of the replies received in response to the 
ping requests sent by the FST-2802.
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L1 Bert Stats results
The L1 Bert Stats category displays results associated with the trans-
mission of BER patterns on a layer 1 (unswitched) network. Table 25 
describes L1 Bert Stats results. To view L1 Bert Stats results, transmit 
a BER pattern over a layer 1 network, and then set a result category 
to L1 Bert Stats.

Ping Responses 
Tx

Count of the Ping replies sent by the FST-2802 in 
response to the ping requests sent to the FST-
2802. Each time a ping request is received, the 
FST-2802 replies and this counter is incremented 
by one.

Delay, Avg (ms) The round trip delay for all pings sent and suc-
cessfully received by the FST-2802 since the last 
test restart. Calculated in milliseconds. 

Delay (ms) The round trip delay for the last ping sent and suc-
cessfully received by the FST-2802. Calculated in 
milliseconds. 

Delay, Max (ms) The maximum round trip delay for the pings sent 
and successfully received by the FST-2802. Cal-
culated in milliseconds. 

Delay, Min (ms) The minimum round trip delay for the pings sent 
and successfully received by the FST-2802. Cal-
culated in milliseconds. 

Table 24 Ping Stats results (Continued)

Test Result Description

Table 25 L1 Bert Stats results

Test Result Description

BIT Error Rate The ratio of pattern bit errors to received pattern 
bits since initially acquiring pattern synchroniza-
tion.

BIT Errored Sec-
onds

The number of seconds during which one or more 
pattern bit errors occurred since initial pattern syn-
chronization.
238 FST-2802 TestPad User’s Guide Revision A



Chapter 7 Test Results
L2 Bert Stats results
L2 Bert Stats results
The L2 Bert Stats category displays results associated with the trans-
mission of BER patterns on a layer 2 (switched) network. Table 26 
describes L2 Bert Stats results. To view L2 Bert Stats results, transmit 
traffic with a BER pattern in the payload over a layer 2 network, and 
then set a result category to L2 Bert Stats.

BIT Errors A count of the number of received bits in a recog-
nized pattern that do not match the expected 
value.

Total Bits 
Received

The total number of bits received since initial pat-
tern synchronization.

Table 25 L1 Bert Stats results (Continued)

Test Result Description

Table 26 L2 Bert Stats results

Test Result Description

BIT Error Rate The ratio of pattern bit errors to received pattern 
bits since initially acquiring frame synchronization.
NOTE: This ratio is determined using only the bits 
in the payload of the frame.

BIT Errored Sec-
onds

The number of seconds during which one or more 
pattern bit errors occurred since initial frame syn-
chronization.

BIT Errors A count of the number of received bits in a recog-
nized pattern that do not match the expected value 
since initially acquiring frame synchronization.

Total Bits 
Received

The total number of bits received since initial frame 
synchronization.
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Custom results
In addition to the standard result categories provided on the TestPad, 
you can define your own Custom result category with test results from 
a variety of categories. This allows you to quickly review key results 
without navigating through each individual category. 

To view results for the Custom category
– On a result pane, set the result group to Custom Port 1 or 

Custom Port 2.

The Custom Results category appears, listing the results you selected 
when you defined the category (see “Defining the Custom result cate-
gory” on page 45).
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8

This chapter describes how to identify and correct problems related to 
the FST-2802. Topics discussed in this chapter are as follows:

– “About troubleshooting” on page 242
– “Resolving problems” on page 242
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About troubleshooting
You may experience problems while using the FST-2802. Many of 
these problems are easily remedied. If you experience significant 
problems with the FST-2802, contact the Technical Assistance Center 
(see “Technical assistance” on page xxiii).

Resolving problems
The following section describes common problems that you may 
encounter while using the FST-2802. Before getting technical assis-
tance, verify that you have exhausted all possibilities.

Installing and
setting up

The unit will not power up. 
– Check the power source and restart the unit.
– Verify that the unit is locked between the UIM and the FST-2802. 

The unit will not power up if the TestPad is not properly assem-
bled. See “Connecting and swapping application modules” on 
page 28.

– Verify that you are connecting the FST-2802 application module to 
a Version 6 UIM.

Operating the
TestPad

Test results do not print.
– Verify that the printer cable is properly connected to the TestPad. 

Refer to “Connecting a printer” on page 49 for instructions on 
connecting a printer to the TestPad. 

– If you are printing to a serial printer, verify that the printer is config-
ured properly. See “Configuring a serial printer” on page 50.

– Verify that the printer is turned on and that it is loaded with paper.

Performing tests Test results are inconsistent. 

The primary reason for inconsistent test results is improper hookup of 
the test connectors. 
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– Verify that the TestPad is connected properly for the test. Refer to 
“Step 2: Connecting the TestPad for testing” on page 96 for infor-
mation about test connections.

– Verify that the TestPad is configured properly for the test you are 
performing.

I cannot perform a loopback test using a hard loopback at the far end of the 
network.
– If you are testing on switched Ethernet network, you must use two 

TestPads as end stations on a circuit. For a detailed explanation of 
Ethernet switching, refer to “Ethernet switching” on page 115.

– If you are testing on an unswitched Ethernet network, you can use 
a hard loopback at the far end of the circuit.
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Appendix A Specifications
A

This appendix describes the TestPad’s specifications. Topics 
discussed in this appendix are as follows:

– “Physical specifications” on page 246
– “Environmental specifications” on page 246
– “Power specifications” on page 247
– “Electrical specifications” on page 247
– “GBIC specifications” on page 248
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Physical specifications
The physical characteristics for the TestPad are described in Table 27.

Environmental specifications
The environmental characteristics for the TestPad are described in 
Table 28.

Table 27 Physical specifications

Item Description

Height 7.2 inches (18.3 cm)

Width 13.6 inches (34.5 cm)

Depth 2.2 inches (5.6 cm)

Weight 5.5 lbs with battery (2.5 kg)

Table 28 Environmental specifications

Item Description

Temperature

Operating
Storage

32° F to 113° F (0° C to +40° C)
-4° F to 158° F (-20° C to +70° C)

Humidity 5% to 85% relative humidity, non-condensing

Shock/drop height 40 inches onto concrete
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Power specifications
The power characteristics for the TestPad are described in Table 29.

Electrical specifications
The FST-2802 10/100 Base-TX interface conforms to IEEE 802.3 
electrical requirements. The electrical specifications for the 10 Mb/s 
interface are described in Table 30; the electrical specifications for the 
100 Mb/s interfaces are described in Table 31.

Table 29 Power specifications

Item Description

Battery Rechargeable10.8V Nickel-Metal Hydride (NiMH) 

Operating time Single port configuration:
– Typically provides a minimum of 1 hour of 

operation.
Dual port configuration:
– Typically provides a minimum of 40 minutes of

operation.

Recharging 
period

Minimum of 1.5 hours

AC adapter 19VDC, 2.95 amps / 100-240 VAC, 50-60 Hz

Table 30 10 Mb/s interface electrical specifications

Specification Description

Cable Cat-5 (or better) 100 Ohm STP cable, ≤100 
meters.

Twisted pair differential 
Output voltage

Input squelch threshold

Input voltage range

2.2 MIN Vpk, 2.5 TYP Vpk, 2.8 MAX Vpk

.310 MIN Vpk, .540 MAX Vpk

3.3V MAX

Output jitter ±5.5 ns pk-pk MAX
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GBIC specifications
Each of the optional SX and LX GBICs offered by Acterna complies 
with the Revision 5.5 GBIC specification. The copper and long-haul 
GBICs comply with the Revision 5.4 GBIC specification. Please refer 
to your GBIC manufacturer’s site for detailed specifications.

For a complete list of GBICs offered by Acterna, see “GBIC accesso-
ries” on page 9.

Input jitter ±13.5 ns pk-pk MAX

Table 31 100 Mb/s interface electrical specifications

Specification Description

Cable Cat-5 (or better) 100 Ohm STP cable, ≤100 
meters.

Twisted pair differential 
Output voltage

Input squelch threshold

Input voltage range

.950 MIN Vpk, 1.000 TYP Vpk, 1.050 MAX 
Vpk

.166 MIN Vpk, .500 MAX Vpk

3.3V MAX

Output jitter ±.7 ns pk-pk MAX

Input jitter ±3.0 ns pk-pk MAX

Table 30 10 Mb/s interface electrical specifications 

Specification Description
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B

This appendix describes remote control operation and lists each of the 
available remote control commands. This guide also provides prepa-
ration, setup, and syntax instructions for the FST-2802 remote opera-
tion. Topics discussed in this appendix are as follows:

– “About the remote control function” on page 250
– “Characteristics of remote control commands” on page 250
– “Configuration commands” on page 251
– “Result commands” on page 269
– “Event commands” on page 285
– “Miscellaneous commands” on page 287
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About the remote control function
You can connect to the TestPad via modem dial-in or dial-out, 
Ethernet, USB, and serial connections. Figure 37 illustrates a typical 
connection between a device and a TestPad.

For details on establishing connections to the FST-2802 for remote 
control operation, see Chapter 3 “Serial and Network Connections”.

Characteristics of remote control commands
You type remote control commands into a terminal emulation applica-
tion, such as HyperTerminal. When typing commands:

– Use lower-case characters
– Press Backspace to erase the last character entered
– Type commands in the same sequence as you would perform 

them when using the TestPad.
– Be sure to specify the port_ID for each command. For single port 

units, the port_ID is always port_1. For dual port units, you must 
specify port_1 or port_2.

Figure 37 PC to TestPad connection

PC

Network

Network
connection

Direct serial
connection

Laptop
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Configuration commands
The availability of a command depends on your current test configura-
tion. For example, the commands for a 1G pattern test are not avail-
able if you are performing a 10/100 ping test.

Configuration commands
Use configuration commands to set or query the parameters of the test 
configuration for a port. These parameters can be a test type or a 
specific value. 

This section describes the command syntax for each type of configu-
ration command.

config Displays or modifies a configuration parameter.

Syntax config:<cfg_id?><port_id>

Displays the value of cfg_id for the port specified.

config:<cfg_id><port_id> [value]

Changes the value of cfg_id to value on the port specified.

Remark If you do not specify value, the FST-2802 displays the current value 
for the parameter.

Example The following command sets the 1G pattern to CRPAT on port 1.

config:ethernet_pattern port_1 crpat
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Configuration commands
Table 32 lists system configuration identifiers and values.

Table 32 System configuration identifiers and values

Configuration ID Meaning Configuration Values

error_burst_quantity Sets the number of burst 
frames.

1 to 32767

error_insert_type Sets the type of FCS error to 
insert.

single_insert, 
quantity_burst_insert

error_type Sets the type of error to 
insert.

ethernet_fcs

ether_fibre_bert_traffic Starts transmission of layer 1 
BERT patterns. 

ether_fibre_l1_bert_patt
ern

Sets the layer 1 BERT pat-
tern to the value specified.

Accepts one of the following 
BERT patterns:
– hfpat

– lfpat
– mfpat

– rdpat

– jtpat
– snpat

ether_fibre_l2_bert_tx_e
ql_rx

Sets the transmitted BERT 
pattern to the pattern speci-
fied in the receive profile.

on, off

ether_fibre_rx_l2_bert_p
att 

Sets the BERT pattern for 
the receive profile to the 
value specified.

Accepts one of the following 
BERT patterns:
– 2_23_1

– 2_23_1_inv 
– 2_31_1 

– 2_31_1_inv 

– all_ones 
– all_zeros 

– User_Define

ether_fibre_rx_l2_user_p
att 

Sets the user defined BERT 
pattern for the transmit pro-
file. Valid only when 
ether_fibre_rx_l2_ber
t_patt is set to User 
Define.

Accepts a hexadecimal value 
from 0 to FFFFFFFFFF, for 
example, e57f.
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ether_fibre_tx_l2_bert_p
att 

Sets the BERT pattern for 
the transmit profile to the 
value specified.

Accepts one of the following 
BERT patterns:
– 2_23_1
– 2_23_1_inv 

– 2_31_1 

– 2_31_1_inv 
– all_ones 

– all_zeros 

– User_Define

ether_fibre_tx_l2_user_p
att

Sets the user defined BERT 
pattern for the transmit pro-
file. Valid only when 
ether_fibre_tx_l2_ber
t_patt is set to User 
Define.

Accepts a hexadecimal value 
from 0 to FFFFFFFFFF, for 
example, e57f.

ethernet_auto_negotiatio
n

Enables auto negotiation. on, off

ethernet_auto_negotiatio
n_100basetx_fdx

Advertises Ethernet 
100BaseTx full-duplex capa-
ble.

yes, no

ethernet_auto_negotiatio
n_100basetx_hdx

Advertises Ethernet 
100BaseTx half-duplex 
capable.

yes, no

ethernet_auto_negotiatio
n_10baset_fdx

Advertises Ethernet 
10BaseT full-duplex capa-
ble.

yes, no

ethernet_auto_negotiatio
n_10baset_hdx

Advertise Ethernet 10BaseT 
half-duplex capable.

yes, no

ethernet_auto_negotiatio
n_1g_fdx

Advertises Ethernet 1000 
Base X full-duplex capable.

yes, no

ethernet_auto_negotiatio
n_1g_hdx

Advertises Ethernet 1000 
Base X half-duplex capable.

yes, no

ethernet_auto_negotiatio
n_1g_pause

Advertises Ethernet 1000 
Base X pause capable.

neither, both, tx_only, 
rx_only

ethernet_burst_frame_siz
e

Sets the size of burst 
frames.

fixed, random
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ethernet_burst_load Sets traffic load to bursty.

ethernet_burst_numbers Sets the number of burst 
frames. Valid only when 
ethernet_burst_type is set to 
FIXED.

Accepts a number from 1 to 
65535.

ethernet_burst_size Sets burst size. If you type 
“user”, you must also enter 
the user-defined burst size 
using the 
ethernet_burst_user_s
ize configuration ID.

16, 64, 256, 1024, user

ethernet_burst_type Specifies finite number 
(fixed) or a continuous burst 
of frames.

fixed, continuous

ethernet_burst_user_size Sets user-defined burst size. 
Valid only when 
ethernet_burst_size is 
set to user.

Accepts a number from 1 to 
16500000.

ethernet_connect_rx_to_t
x

Tells the TestPad to loop the 
frames received through to 
the transmitter (instead of 
transmitting idle frames) 
when monitoring 1G traffic in 
single port THRU mode. 

on, off

ethernet_const_load Sets constant traffic load in 
percentage of bandwidth uti-
lization.

Accepts a number from 1 to 
100.

ethernet_duplex Sets duplex to half or full. half, full

ethernet_flow_control Enables or disables flow 
control.

on, off

ethernet_llb Turns line loopback feature 
on or off.

on, off

ethernet_load Sets the Ethernet traffic load 
type.

burst, constant, ramp

ethernet_loop_down Issues loop down command. on, off

ethernet_loop_up Issues loop up command. on, off
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ethernet_pattern Sets the Ethernet pattern. crpat, cjpat, cspat

ethernet_payload Sets the Ethernet transmit 
frame payload type. If you 
specify bert, you must also 
specify the pattern for the 
payload using the 
ether_fibre_tx_l2_ber
t_patt command.

acterna, bert

ethernet_ping Turns ping packet transmis-
sion on or off.

on, off

ethernet_ping_address Specifies the IP address of 
the device you are verifying 
connectivity to.

Accepts an IP address, for 
example: 128.118.200.4.

ethernet_ping_dont_fragm
ent

Specifies whether ping pack-
ets may be fragmented.

off, on

ethernet_ping_frame_type Sets the Ethernet frame type 
for transmitted ping packets.

ethernet_type_2, 
802_3_with_llc, 
802_3_with_llc_and_sna
p

ethernet_ping_gateway Sets the IP address for the 
router through which ping 
traffic will be sent if the desti-
nation for the traffic is out-
side of the local subnet.

Accepts an IP address, for 
example: 128.118.200.4.

ethernet_ping_jumbo_leng
th

Sets the frame length for 
jumbo ping packets. 

Accepts a number from 1493 
to 9982 depending on the 
frame type specified:
DIX:
1501 - 9982

802.3 w/LLC:
1497 - 9979
802.3 w/LLC and SNAP:
1493 - 9974

ethernet_ping_length Specifies the length type for 
ping packets.

user, jumbo
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ethernet_ping_packet_cou
nt

Sets the number of ping 
packets to transmit. Valid 
only when 
ethernet_ping_traffic
_type is set to multiple.

Accepts a number from 1 to 
1024.

ethernet_ping_source_add
ress

Sets the IP address for the 
FST-2802.

Accepts an IP address, for 
example: 128.118.200.4

ethernet_ping_subnet_mas
k

Sets the subnet mask 
address for the ping traffic.

Accepts an IP address, for 
example: 128.118.200.4

ethernet_ping_tagging Sets the VLAN tagged status 
for ping traffic.

nontagged, tagged

ethernet_ping_time_to_li
ve

Sets the time after which a 
fragmented ping request or 
response can be dropped by 
any device on a circuit.

Accepts a number from 0 to 
255.

ethernet_ping_traffic_ty
pe

Sets the ping traffic type. single, multiple, contin-
uous

ethernet_ping_type_of_se
rvice

Sets the type of service code 
for transmitted ping packets.

Accepts up to 8 zeros or ones, 
for example: 10001000.

ethernet_ping_user_lengt
h

Sets the frame length for 
user-defined ping packets. 

Accepts a number from 38 to 
1500, depending on the frame 
type specified:
DIX:
46 - 1500
802.3 w/LLC:
43 - 1497

802.3 w/LLC and SNAP:
38 - 1492

ethernet_ping_user_prior
ity

Sets the VLAN user priority 
for each ping packet trans-
mitted. Valid only when 
ethernet_ping_tagging 
is set to tagged.

0, 1, 2, 3, 4, 5, 6, 7
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ethernet_ping_vland_id Sets the VLAN ID for each 
ping packet transmitted. 
Valid only when 
ethernet_ping_tagging 
is set to tagged.

Accepts a value from 0 to 
4095.

ethernet_ramp_load_step Sets the load increment (as 
a percentage of bandwidth) 
for ramped traffic.

Accepts a number from 1 to 
50.

ethernet_ramp_num_drop_f
rames

Sets the threshold for 
dropped frames. Valid only 
when 
ethernet_ramp_stop_on
_dropped_frames is on.

Accepts a number from 1 to 
1000000.

ethernet_ramp_num_err_fr
ames

Sets the threshold for error 
frames. Valid only when 
ethernet_ramp_stop_er
r_frames is on.

Accepts a number from 1 to 
1000000.

ethernet_ramp_num_pause_
frames

Sets the threshold for pause 
frames. Valid only when 
ethernet_ramp_stop_on
_pause_frames is on.

Accepts a number from 1 to 
1000000.

ethernet_ramp_state Starts or stops ramp traffic. on, off

ethernet_ramp_stop_drop_
frames

Set dropped frames as a cri-
terion to stop ramp mode.

on, off

ethernet_ramp_stop_err_f
rames

Set error frames as a crite-
rion to stop ramp mode.

on, off

ethernet_ramp_stop_pause
_frames

Set pause frames as a crite-
rion to stop ramp mode.

on, off

ethernet_ramp_time_step Sets the time increment for 
ramped traffic.

Accepts a number from 0.1 to 
10.0.

ethernet_rx_profile Sets the Ethernet receive 
profile.

rx_profile_1, 
rx_profile_2, 
rx_profile_3, 
rx_profile_4
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ethernet_rx_profile_1 Sets the frame characteris-
tics for the traffic filtered 
using receive profile 1. You 
must specify a value for 
each of the ten profile set-
tings, even if they are not 
applicable. The string of val-
ues must be enclosed in 
quotes.

For example, if you issue a 
command to set up the 
receive profile to filter for 
untagged frames, the string 
of values might look like this:

"unicast, 
00404D000001, yes, 
00404D000002, 802_3. 
0800, 64, untagged, 
na, na"

Accepts a string of 10 comma 
delimited values, enclosed in 
quotes:
DA Type:
unicast, multicast, 
broadcast, dont_care
Dest Address:
000000000000 to 
ffffffffffff, na
SA:
yes, dont_care
Source Address:
000000000000 to 
ffffffffffff, na
Frame Type:
ethernet_type_2, 802_3, 
dont_care

Protocol:
0000 to ffff, na
Data Length:
64 to 1550, na
Tagging:
tagged, untagged, 
dont_care
VLAN ID:
0 to 4095, na
User Priority:
0 to 7, na

ethernet_rx_profile_2 Sets the frame characteris-
tics for the traffic filtered 
using receive profile 2.

See the description and values 
for “ethernet_rx_profile_1” on 
page 258.

ethernet_rx_profile_3 Sets the frame characteris-
tics for the traffic filtered 
using receive profile 3.

See the description and values 
for “ethernet_rx_profile_1” on 
page 258.

ethernet_rx_profile_4 Sets the frame characteris-
tics for the traffic filtered 
using receive profile 4.

See the description and values 
for “ethernet_rx_profile_1” on 
page 258.
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ethernet_rx_profile_ip_a
ddr

Specifies that the receive 
profile should filter traffic for 
a specific IP address.

Accepts an IP address, for 
example: 128.118.200.4

ethernet_sa Queries the FST-2802 for 
the factory-assigned source 
MAC address. FST-2802 
displays ID.

N/A

ethernet_speed Sets speed to 10 Mbps or 
100 Mbps. Valid only when 
ethernet_auto_negotia
tion is set to off. 

10, 100

ethernet_traffic Starts and stops traffic. on, off

ethernet_tx_profile Selects the Ethernet profile 
you want to use when you 
transmit traffic.

tx_profile_1, 
tx_profile_2, 
tx_profile_3, 
tx_profile_loop
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ethernet_tx_profile_1 Sets the frame characteris-
tics for the traffic transmitted 
using transmit profile 1. You 
must specify a value for 
each of the ten profile set-
tings, even if they are not 
applicable. The string of val-
ues must be enclosed in 
quotes.

For example, if you issue a 
command to set up the 
transmit profile to send 
untagged 64 byte 802.3 
frames to destination 
address 00404D000001, the 
string of values would look 
like this:

"unicast, 
00404D000001, 802_3, 
0800, untagged, na, 
na, 64, na, na"

Accepts a string of 10 comma 
delimited values, enclosed in 
quotes:
DA Type:
unicast, multicast, 
broadcast

DA:
000000000000 to 
ffffffffffff, na
Frame Type:
ethernet_type_2, 802_3
Protocol:
0000 to ffff, na
Tagging:
tagged, untagged
VLAN ID:
0 to 4095, na
User Priority:
0 to 7, na
Length:
64, 128, 256, 512, 1024, 
1280, 1518, user, jumbo
User Length:
64 to 1522, na
Jumbo Length:
1519 to 10000, na

ethernet_tx_profile_2 See the description for 
“ethernet_tx_profile_
1” on page 260.

See the values for 
“ethernet_tx_profile_1” 
on page 260.

ethernet_tx_profile_3 See the description for 
“ethernet_tx_profile_
1” on page 260.

See the values for 
“ethernet_tx_profile_1” 
on page 260.
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ethernet_tx_profile_loop Sets the frame characteris-
tics for the traffic looped 
back to the FST-2802 using 
the profile. You must specify 
a value for each of the ten 
profile settings, even if they 
are not applicable. The 
string of values must be 
enclosed in quotes.

For example, if you issue a 
command to set up the loop 
back profile to loop back 
untagged 64 byte 802.3 
frames from destination 
address 00404D000001, the 
values would look like this:

"unicast, 
00404D000001, 802_3, 
0800, untagged, na, 
na, 64, na, na"

NOTE: When you perform 
an automatic loopback using 
the Loop Up button on the 
traffic originating FST-2802, 
the destination address for 
the loopback profile is popu-
lated automatically with the 
source address of the Test-
Pad on the far end.

Accepts 10 comma delimited 
values, enclosed in quotes:
DA Type:
unicast, multicast, 
broadcast
DA:
na

Frame Type:
ethernet_type_2, 802_3
Protocol:
0000 to ffff, na
Tagging:
tagged, untagged
VLAN ID:
0 to 4095, na
User Priority:
0 to 7, na
Length:
64, 128, 256, 512, 1024, 
1280, 1518, user, jumbo
User Length:
64 to 1522, na
Jumbo Length:
1519 to 10000, na

ethernet_tx_sa_type Sets the transmitted source 
address type to the factory 
assigned source address 
(tx_source_address) or 
the user assigned source 
address 
(tx_user_define_sa).

tx_source_address, 
tx_user_define_sa
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ethernet_unit_text_id Sets the user defined text ID 
for each port on the FST-
2802. You must type the text 
id in quotes. For example, if 
you want to identify a port on 
the FST-2802 as TP Port 1, 
you must type “TP Port 1”. 

Accepts a quoted string of up 
to ten characters.

ethernet_user_tx_sa Sets the transmitted user-
assigned source address.

000000000000 to 
ffffffffffff

fibre_auto_llb Turns line loopback feature 
on or off.

on, off

fibre_burst_frame_size Sets the size of burst 
frames.

fixed, random

fibre_burst_load Sets traffic load to bursty.

fibre_burst_numbers Sets the number of burst 
frames. Valid only when 
fibre_burst_type is set 
to FIXED.

Accepts a number from 1 to 
65535.

fibre_burst_size Sets burst size. If you type 
“user”, you must also enter 
the user-defined burst size 
using the 
fibre_burst_user_size 
configuration ID.

16, 64, 256, 1024, user

fibre_burst_type Specifies finite number 
(fixed) or a continuous burst 
of frames.

fixed, continuous

fibre_burst_user_size Sets user-defined burst size. 
Valid only when 
fibre_burst_size is set 
to user.

Accepts a number from 1 to 
16500000.

fibre_const_load Sets constant traffic load in 
percentage of bandwidth uti-
lization.

Accepts a number from 1 to 
100.

fibre_load Sets the Fibre Channel traf-
fic load type.

burst, constant, ramp
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fibre_loop_down Issues loop down command. on, off

fibre_loop_up Issues loop up command. on, off

fibre_pattern Sets the Fibre Channel pat-
tern.

rpat, jpat, spat

fibre_payload Sets Fibre Channel transmit 
frame payload type. If you 
specify bert, you must also 
specify the pattern for the 
payload using the 
ether_fibre_tx_l2_ber
t_patt command.

acterna, bert

fibre_ramp_load_step Sets the load increment (as 
a percentage of bandwidth) 
for ramped traffic.

Accepts a number from 1 to 
50.

fibre_ramp_number_droppe
d_frames

Sets the threshold for 
dropped frames. Valid only 
when 
fibre_ramp_stop_on_dr
opped_frames is on.

Accepts a number from 1 to 
1000000.

fibre_ramp_number_errore
d_frames

Sets the threshold for error 
frames. Valid only when 
fibre_ramp_stop_err_f
rames is on.

Accepts a number from 1 to 
1000000.

fibre_ramp_state Starts or stops ramp traffic. on, off

fibre_ramp_stop_on_dropp
ed_frames

Set dropped frames as a cri-
terion to stop ramp mode.

on, off

fibre_ramp_stop_on_error
ed_frames

Set error frames as a crite-
rion to stop ramp mode.

on, off

fibre_ramp_time_step Sets the time increment for 
ramped traffic.

Accepts a number from 0.1 to 
10.0.

fibre_rx_profile Sets the Fibre Channel 
receive profile.

rx_profile_1, 
rx_profile_2, 
rx_profile_3, 
rx_profile_4
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fibre_rx_profile_1 Sets the frame characteris-
tics for the traffic filtered 
using receive profile 1. You 
must specify a value for 
each of the ten profile set-
tings, even if they are not 
applicable. The string of val-
ues must be enclosed in 
quotes.

For example, if you issue a 
command to set up the 
receive profile to filter for 
frames originating from port 
00012F, the string of values 
might look like this:

"dont_care, na, yes, 
01012F, dont_care, 
na, dont_care, na, 
dont_care, na"

Accepts a string of 10 comma 
delimited values, enclosed in 
quotes:
Routing Filter:
yes, dont_care
Routing Ctrl:
00 to ff, na
Des ID Filter:
yes, dont_care
Destination ID:
010000 to efefff, na
Src ID Filter:
yes, dont_care
Source ID:
010000 to efefff, na
Data Filter:
yes, dont_care
Data Type:
00 to ff, na
Seq Filter:
yes, dont_care
Sequence Cnt:
00 to ff, na

fibre_rx_profile_2 See the description for 
“fibre_rx_profile_1” 
on page 264

See the description for 
“fibre_rx_profile_1” on 
page 264

fibre_rx_profile_3 See the description for 
“fibre_rx_profile_1” 
on page 264

See the description for 
“fibre_rx_profile_1” on 
page 264

fibre_rx_profile_4 See the description for 
“fibre_rx_profile_1” 
on page 264

See the description for 
“fibre_rx_profile_1” on 
page 264

fibre_traffic Starts and stops traffic. on, off
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fibre_tx_profile Selects the Fibre Channel 
profile you want to use when 
you transmit traffic.

tx_profile_1, 
tx_profile_2, 
tx_profile_3, 
tx_profile_loop

fibre_tx_profile_1 Sets the frame characteris-
tics for the traffic transmitted 
using transmit profile 1. You 
must specify a value for 
each of the seven profile set-
tings, even if they are not 
applicable. The string of val-
ues must be enclosed in 
quotes.

For example, if you issue a 
command to set up the 
transmit profile to send 512 
byte frames from sequence 
ID 4F, source ID 00012F, to 
destination ID 00043D, the 
string of values would look 
like this:

"4f, 00043D, 00012F, 
na, na, 512, na"

Accepts a string of seven 
comma delimited values, 
enclosed in quotes:
Sequence ID:
00 to ff
Destination ID:
010000 to efefff, na
Source ID:
01000 to efefff, na
Originator ID:
0000 to ffff, na
Responder ID:
0000 to ffff, na
Length*:
28, 32, 512, 1024, 2076, 
user
User Length*:
28 or 76 to 2076, na
*NOTE: The minimum frame 
size for an Acterna payload is 
76 bytes; the minimum frame 
size for a BERT payload is 28 
bytes.

fibre_tx_profile_2 See the description for 
“fibre_tx_profile_1” 
on page 265.

See the description for 
“fibre_tx_profile_1” on 
page 265.

fibre_tx_profile_3 See the description for 
“fibre_tx_profile_1” 
on page 265.

See the description for 
“fibre_tx_profile_1” on 
page 265.

fibre_tx_profile_loop See the description for 
“fibre_tx_profile_1” 
on page 265.

See the description for 
“fibre_tx_profile_1” on 
page 265.
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config:all Lists the values of all applicable configurations for the port specified.

Syntax config:all? <port_id> [-all]

Remark The -all parameter returns all the configuration and associated 
values regardless of their applicability to the current test.

config:value Lists all of the possible currently applicable values for a configuration 
on the port specified.

Syntax config:value? <port_id><cfg_id> [-all]

Remark The -all parameter returns a list of all possible values for the config-
uration identifier, regardless of applicability to the current test.

config:id Lists all of the possible currently applicable configuration identifier 
values on the port specified.

Syntax config:id? <port_id> [-all]

fibre_unit_text_id Sets the user defined text ID 
for each port on the FST-
2802. You must type the text 
id in quotes. For example, if 
you want to identify a port on 
the FST-2802 as TP Port 1, 
you must type “TP Port 1”. 

Accepts a quoted string of up 
to ten characters.

laser_enable Turns the laser on the FST-
2802 on or off.

off, on
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Remark The -all parameter returns the list of all possible configurations, 
regardless of applicability. 

config:test Sets the type of test you want to perform.

Syntax config:test <test_type>

Example The following command is equivalent to selecting Term > 1G Ethernet 
> Layer 2 Traffic on the TestPad:

config:test term_ethernet_1g
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Table 33 lists the possible values for <test_type>. 

Table 33 Test configuration values

Configuration value

dualthru_ethernet_10_100

dualthru_ethernet_1g

dualthru_fibre_chan_1g
dualthru_fibre_chan_2g

thru_ethernet_10_100

thru_ethernet_10_100_ip
thru_ethernet_1g

thru_ethernet_1g_ip

thru_ethernet_unfrm_1g_bert
thru_fibre_chan_1g

thru_fibre_chan_1g_pattern

thru_fibre_chan_2g
thru_fibre_chan_2g_pattern

thru_fibre_unfrm_1g_bert

thru_fibre_unfrm_2g_bert
term_ethernet_10_100

term_ethernet_10_100_ping

term_ethernet_1g
term_ethernet_1g_pattern

term_ethernet_1g_ping

term_ethernet_unfrm_1g_bert
term_fibre_chan_1g

term_fibre_chan_1g_pattern

term_fibre_chan_2g
term_fibre_chan_2g_pattern

term_fibre_unfrm_1g_bert

term_fibre_unfrm_2g_bert
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Result commands
Use result commands to query the test set for the current value of a 
results field. After you issue a result command, the test set responds 
with the current value of the result. If the result is unavailable or not 
applicable to the current test, the message appears, UNAVAILABLE or 
N/A respectively.

result Displays the result of a field for the port specified.

Syntax result:<res_id?> <port_id>

Example The following command displays the current result of the 
Delay, Avg (us) field on port 1.

result:ethernet_delay_avg? port_1

result:all Lists all test results generated by a test on the port specified.

Syntax result:all? <port_id> [-all]

Remark The -all parameter returns all results regardless of their applicability 
to the current test.

result:id Lists all test result fields for the specified port.

Syntax result:id? <port_id>

result:summary Lists the results that are currently available in the Summary category 
for the port specified.
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Syntax result:summary? <port_id>

Remark If the FST-2802 does not detect any errors on the port specified, the 
message All Summary Results OK appears.

LED result field
IDs

Table 34 lists the LED result field identifiers.

Table 34 LED result field identifiers

Field Identifier Description

ether_fibre_l1_patt_sync For layer 1 tests, indicates the data contained 
on the incoming bit stream is synchronized 
with a BERT pattern.

ether_fibre_l2_patt_sync For layer 2 tests, indicates the data contained 
inside the frame payload is synchronized with 
a BERT pattern.

ether_fibre_l1_patt_sync_history

ether_fibre_l2_patt_sync_history

Indicates the TestPad could not achieve pat-
tern synchronization (when performing layer 1 
or layer 2 BERT testing) at some point in the 
past.

ethernet_10_100_link_active

ethernet_1G_link_active
fibre_link_active

Indicates whether a link is active. 

ethernet_10_100_lnk_act_hist

ethernet_1G_link_active_history

fibre_link_active_history

Indicates the link was lost at some point in the 
past.

ethernet_10_100_sync_history
ethernet_1G_sync_history

fibre_word_sync_history

ether_fibre_l1_bert_word_sync_history

Indicates synchronization was lost at some 
point in the past.

ethernet_10_100_sync
ethernet_1G_sync

fibre_word_sync

ether_fibre_l1_bert_word_sync

Indicates whether synchronization has been 
achieved.
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Signal result field
IDs

Table 35 lists the Signal result field identifiers. The Signal result field 
identifiers are only available for 1G and 2G tests.

Link Stats result
field IDs

Table 36 lists the Link Stats field identifiers.

ethernet_signal_history
fibre_signal_history

ether_fibre_l1_bert_signal_history

Indicates a 1G or 2G signal was lost at some 
point in the past.

ethernet_signal_present

fibre_signal_present
ether_fibre_l1_bert_signal_present

Indicates whether a 1G or 2G signal is 
present.

ethernet_sw_frm_detect_history

fibre_sw_frm_detect_history

Indicates the TestPad did not detect frames at 
some point in the past.

ethernet_sw_frm_detect

fibre_sw_frm_detect

Indicates whether the TestPad has detected 
frames.

ethernet_sw_vlan_frm_detect Indicates whether the TestPad has detected 
VLAN tagged frames as defined in IEEE 
802.p/q. This result is only available to Test-
Pads with the VLAN Tagging option.

ethernet_sw_vlan_frm_detect_hist Indicates the TestPad could not detect VLAN 
tagged frames at some point in the past. This 
result is only available to TestPads with the 
VLAN Tagging option.

Table 34 LED result field identifiers (Continued)

Field Identifier Description

Table 35 Signal result field identifiers

Field Identifier Description

ethernet_gbic_module Informs you of the type of Gigabit Interface Converter 
(GBIC) the TestPad detects in each GBIC port, and 
indicates whether detected GBICs are not supported, 
or if there is no GBIC detected.

fibre_gbic_module See “ethernet_gbic_module” on page 271.
FST-2802 TestPad User’s Guide Revision A 271



Appendix B Remote Control Commands
Result commands
Table 36 Link Stats result field identifiers

Field Identifier Description

ethernet_delay_avg The average round trip delay calculated in 
microseconds. You must transmit an Acterna 
payload to calculate round trip delay.

ethernet_delay_max The maximum round trip delay calculated in 
microseconds. You must transmit an Acterna 
payload to calculate round trip delay.

ethernet_delay_min The minimum round trip delay calculated in 
microseconds. You must transmit an Acterna 
payload to calculate round trip delay.

ethernet_frm_rate_avg
fibre_frm_rate_avg

The average rate of received frames, 
expressed in frames per second. The average 
is calculated over the time period elapsed since 
the last test restart.

ethernet_frm_rate_cur
fibre_frm_rate_cur

The current rate of received frames, expressed 
in frames per second. This measurement is an 
average taken over the prior second of test 
time.

ethernet_frm_rate_min
fibre_frm_rate_min

The minimum rate of received frames over a 
one second period, expressed in frames per 
second.

ethernet_frm_rate_peak

fibre_frm_rate_peak

The maximum rate of received frames over a 
one second period, expressed in frames per 
second.

ethernet_frm_size_max

fibre_frm_size_max

The minimum frame size of frames received 
since frame detection.

ethernet_frm_size_min
fibre_frm_size_min

The maximum frame size of frames received 
since frame detection.

ethernet_rx_mbps_tot_util_cur The current bandwidth utilized by the received 
traffic expressed in megabits per second. This 
measurement is an average taken over the 
prior second of test time.

ethernet_service_disruption_time The service disruption time (maximum inter-
frame gap) when service switches to a protect 
line calculated in milli-seconds.

ethernet_test_secs The number of seconds since the last test 
restart.
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Link Counts result
field IDs

Table 37 describe the Link Counts result field identifiers.

ethernet_tot_util_avg
fibre_tot_util_avg

The average bandwidth utilized by the received 
traffic, expressed as a percentage of the line 
rate of available bandwidth since the last test 
restart. The average is calculated over the time 
period elapsed since the last test restart.

ethernet_tot_util_cur

fibre_tot_util_cur

The current bandwidth utilized by the received 
traffic expressed as a percentage of the entire 
1 Gbps or 2 Gbps of available bandwidth. This 
measurement is an average taken over the 
prior second of test time.

ethernet_tot_util_peak

fibre_tot_util_peak

The peak bandwidth utilized by the received 
traffic since the last test restart expressed as a 
percentage of the line rate of available band-
width.

ethernet_tx_mbps_tot_util_cur

fibre_tx_bits_tot_util_cur

The current bandwidth utilized by the transmit-
ted traffic expressed in megabits per second 
(Ethernet), or bits per second (Fibre Channel). 
This measurement is an average taken over 
the prior second of test time.

Table 36 Link Stats result field identifiers (Continued)

Field Identifier Description

Table 37 Link Counts result field identifiers

Field Identifier Description

ethernet_10_100_rx_collision_cnt For 10/100 half duplex tests, a count of the 
number of times the TestPad has received a 
jam signal while it was not transmitting frames.

ethernet_10_100_tx_collision_cnt For 10/100 half duplex tests, a count of the 
number of times the TestPad has transmitted 
a frame, and then received a jam signal in the 
time slot for the frame.
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ethernet_10_100_tx_late_collision_cnt A count of the number of times the TestPad 
has transmitted a frame, and then experiences 
a collision more than 64 byte times after the 
transmission begins. Result only appears for 
half-duplex 10/100 tests.

ethernet_broadcast_frm_cnt The number of broadcast frames received 
since the last test restart.

ethernet_frm_1024_to_1518_count A count of frames with frame lengths ranging 
from 1024 bytes to 1518 bytes.

ethernet_frm_128_to_255_count A count of frames with frame lengths ranging 
from 128 bytes to 255 bytes.

ethernet_frm_256_to_511_count A count of frames with frame lengths ranging 
from 256 bytes to 511 bytes.

ethernet_frm_512_to_1023_count A count of frames with frame lengths ranging 
from 512 bytes to 1023 bytes.

ethernet_frm_64_count A count of 64 byte long frames.

ethernet_frm_65_to_127_count A count of frames with frame lengths ranging 
from 65 bytes to 127 bytes.

ethernet_multicast_frm_cnt The number of multicast frames received 
since the last test restart.

ethernet_pause_frm_cnt The number of pause frames received from a 
remote Ethernet device since the last test 
restart.

ethernet_rx_acterna_frm The number of frames with an Acterna pay-
load received since the last test restart.

ethernet_rx_atp_frames A count of received frames with Acterna test 
packets (ATP).

ethernet_rx_frm_cnt
fibre_rx_frm_cnt

The number of frames received since the last 
test restart.

ethernet_tx_10_100_defer_cnt For 10/100 half duplex tests, a count of the 
number of times the transmitter prepared to 
send traffic, and then was forced to defer 
based on link activity.

Table 37 Link Counts result field identifiers (Continued)

Field Identifier Description
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Table 38 describes the Filter Stats result field identifiers.

ethernet_tx_frm_cnt
fibre_tx_frm_cnt

The number of frames transmitted since the 
last test restart.

ethernet_unicast_frm_cnt The number of unicast frames received since 
the last test restart.

ethernet_vlan_tagged_frm_cnt A count of received VLAN frames as defined in 
IEEE 802.p/q.

fibre_frm_1024_to_2140_count A count of frames with frame lengths ranging 
from 1024 bytes to 2140 bytes.

fibre_frm_128_to_252_count A count of frames with frame lengths ranging 
from 128 bytes to 252 bytes.

fibre_frm_256_to_508_count A count of frames with frame lengths ranging 
from 256 bytes to 508 bytes.

fibre_frm_28_to_64_count A count of frames with frame lengths ranging 
from 28 bytes to 64 bytes.

fibre_frm_512_to_1020_count A count of frames with frame lengths ranging 
from 512 bytes to 1020 bytes.

fibre_frm_68_to_124_count A count of frames with frame lengths ranging 
from 68 bytes to 124 bytes.

Table 37 Link Counts result field identifiers (Continued)

Field Identifier Description

Table 38 Filter Stats result field identifiers

Field Identifier Description

ethernet_masked_delay_avg The average round trip delay calculated in 
microseconds. You must transmit an Acterna 
payload to calculate round trip delay.

ethernet_masked_delay_max The maximum round trip delay calculated in 
microseconds. You must transmit an Acterna 
payload to calculate round trip delay.
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ethernet_masked_delay_min The minimum round trip delay calculated in 
microseconds. You must transmit an Acterna 
payload to calculate round trip delay.

ethernet_masked_frm_rate_avg

fibre_masked_frm_rate_avg

The average rate of filtered frames, expressed in 
frames per second. The average is calculated 
over the time period elapsed since the last test 
restart.

ethernet_masked_frm_rate_cur

fibre_masked_frm_rate_cur

The current rate of filtered frames, expressed in 
frames per second. This measurement is an 
average taken over the prior second of test time.

ethernet_masked_frm_rate_min

fibre_masked_frm_rate_min

The minimum rate of filtered frames over a one 
second period, expressed in frames per second.

ethernet_masked_frm_rate_peak
fibre_masked_frm_rate_peak

The maximum rate of filtered frames over a one 
second period, expressed in frames per second.

ethernet_masked_frm_size_max

fibre_masked_frm_size_max

The maximum frame size of filtered frames 
received since frame detection.

ethernet_masked_frm_size_min

fibre_masked_frm_size_min

The minimum frame size of filtered frames 
received since frame detection.

ethernet_masked_util_avg
fibre_masked_util_avg

The average bandwidth utilized by the filtered 
traffic, expressed as a percentage of the line 
rate of available bandwidth since the last test 
restart. The average is calculated over the time 
period elapsed since the last test restart.

ethernet_masked_util_cur

fibre_masked_util_cur

The current bandwidth utilized by the filtered 
traffic expressed as a percentage of the line rate 
of available bandwidth. This measurement is an 
average taken over the prior second of test time.

ethernet_masked_util_peak

fibre_masked_util_peak

The peak bandwidth utilized by the filtered traffic 
since the last test restart expressed as a per-
centage of the line rate of available bandwidth.

ethernet_rx_mbps_masked_util_cur The current bandwidth utilized by the filtered 
traffic expressed in megabits per second. This 
measurement is an average taken over the prior 
second of test time.

Table 38 Filter Stats result field identifiers (Continued)

Field Identifier Description
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Table 39 describes the Filter Counts result field identifiers.

Table 39 Filter Counts field identifiers

Field Identifier Description

ethernet_masked_bcast_frm_cnt A count of filtered multicast frames received 
since the last test restart.

ethernet_masked_frm_1024_to_1518 A count of filtered frames with frame lengths 
ranging from 1024 bytes to 1518 bytes.

ethernet_masked_frm_128_to_255 A count of filtered frames with frame lengths 
ranging from 128 bytes to 255 bytes.

ethernet_masked_frm_256_to_511 A count of filtered frames with frame lengths 
ranging from 256 bytes to 511 bytes.

ethernet_masked_frm_512_to_1023 A count of filtered frames with frame lengths 
ranging from 512 bytes to 1023 bytes.

ethernet_masked_frm_64_count A count of 64 byte long filtered frames.

ethernet_masked_frm_65_to_127 A count of filtered frames with frame lengths 
ranging from 65 bytes to 127 bytes.

ethernet_masked_frm_cnt

fibre_masked_frm_cnt

A count of the total number of filtered frames 
received since frame detection.

ethernet_masked_mcast_frm_cnt A count of filtered broadcast frames received 
since the last test restart.

ethernet_masked_rx_acterna_frm A count of filtered frames with Acterna test pay-
load.

ethernet_masked_rx_atp_frames A count of filtered frames with Acterna test pack-
ets (ATP).

ethernet_masked_unicast_frm_cnt A count of filtered unicast frames received since 
the last test restart.

ethernet_masked_vlan_frm_cnt A count of filtered VLAN frames as defined in 
IEEE 802.p/q.

fibre_masked_frm_1024_to_2140_count A count of filtered frames with frame lengths 
ranging from 1024 bytes to 2140 bytes.

fibre_masked_frm_128_to_252_count A count of filtered frames with frame lengths 
ranging from 128 bytes to 252 bytes.
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Table 40 describes the Error Stats result field identifiers.

fibre_masked_frm_256_to_508_count A count of filtered frames with frame lengths 
ranging from 256 bytes to 508 bytes.

fibre_masked_frm_28_to_64_count A count of filtered frames with frame lengths 
ranging from 28 bytes to 64 bytes.

fibre_masked_frm_512_to_1020_count A count of filtered frames with frame lengths 
ranging from 512 bytes to 1020 bytes.

fibre_masked_frm_68_to_124_count A count of filtered frames with frame lengths 
ranging from 68 bytes to 124 bytes.

Table 39 Filter Counts field identifiers (Continued)

Field Identifier Description

Table 40 Error Stats result field identifiers

Field Identifier Description

ether_fibre_code_violation_rate The ratio of frames with code violations tot he num-
ber of frames expected.

ether_fibre_code_violation_secs A count of the number of seconds during which 
code violations occurred.

ether_fibre_code_violations A count of each invalid 10-bit code word in the bit 
stream.

ethernet_errored_frm A summed count of FCS Errored Frames, Runts, 
Jabbers, Undersized Frames, and Oversized 
Frames.

ethernet_fcs_err_frm A count of frames containing Frame Check 
Sequence (FCS) errors.

ethernet_jabber A count of received frames that have a byte value 
greater than the maximum frame length of 1518 
bytes (or 1522 bytes for VLAN tagged frames) and 
an errored FCS.
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ethernet_lost_frm
fibre_lost_frm

A count of lost Acterna test frames. For example, if 
the TestPad detects sequence numbers: 1, 2, 3, 6, 
7, 8, (frames 4 and 5 were not detected), the lost 
frame count is incremented by two (frames 4 and 5 
are lost). If the TestPad then detects sequence 
numbers 9, 10, 14, 15, 16 (frames 11, 12, and 13 
are missing), the lost frame count is incremented 
by three, resulting in a total count of five lost 
frames.
NOTE: If the TestPad receives errored frames con-
taining errors in the sequence number field, the 
Lost Frames count will be incorrect.

ethernet_oos_frame_count
fibre_oos_frame_count

A count of each instance where the TestPad 
detects out of sequence Acterna test frames. For 
example, if the TestPad detects sequence num-
bers: 1, 2, 3, 6, 7, 8, (frame 6 is detected immedi-
ately following frame 3), the out of sequence count 
is incremented by one, resulting in a count of one 
instance of out of sequence frames. If the TestPad 
then detects sequence numbers 9, 10, 14, 15, 16 
(frame 14 is detected immediately following frame 
10), the out of sequence number is incremented 
again by one, resulting in a total count of two 
instances of out of sequence frames.

ethernet_oversized_frm A count of frames over the maximum 1518 byte 
frame length (1522 for VLAN tagged frames).

ethernet_runt A count of frames under the required 64 byte frame 
length containing FCS errors.

ethernet_symbol_error A count of invalid 10-bit code words received on 
the physical layer. This result will not increment 
more than one time per frame.

ethernet_undersized_frm A count of frames under the minimum 64 byte 
frame length.

fibre_errored_frm A summed count of CRC Errored Frames, Runts, 
Jabbers, Undersized Frames, and Oversized 
Frames.

fibre_crc_frm A count of frames containing Cyclic Redundancy 
Check (CRC) errors.

Table 40 Error Stats result field identifiers (Continued)

Field Identifier Description
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Table 41 describes the AutoNeg Status result field identifiers.

fibre_jabber A count of received frames that have a byte value 
greater than the maximum frame length of 2140 
bytes with an errored FCS.

fibre_oversized_frm A count of frames over the maximum 2140 byte 
frame length.

fibre_runt A count of frames under the required 28 byte frame 
length containing CRC errors.

fibre_symbol_error A count of invalid 10-bit code words received on 
the physical layer. This result will not increment 
more than one time per frame.

fibre_undersized_frm A count of frames under the minimum 28 byte 
frame length.

Table 40 Error Stats result field identifiers (Continued)

Field Identifier Description

Table 41 AutoNeg Status result field identifiers

Field Identifier Description

ethernet_10_100_dplx_detect Indicates the negotiated duplex setting for 
the link (half or full).

ethernet_10_100_link_ad_stat Indicates that the FST-2802 has received a 
valid auto-negotiation capability advertise-
ment from the far end Ethernet device and 
sent an acknowledgement.

ethernet_10_100_link_config_ack Indicates that the far end Ethernet device 
has acknowledged the receipt of a valid 
auto-negotiation capability advertisement 
from the FST-2802.

ethernet_10_100_remote_fault

ethernet_1G_remote_fault

If supported by the far end Ethernet device, 
indicates a reason for auto-negotiation fail-
ure. If auto-negotiation succeeded, the 
result will read “NO”.

ethernet_10_100_speed_detect Indicates the negotiated speed setting for 
the link (10 or 100 Mbps).
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ethernet_100_fdx
ethernet_10_fdx

ethernet_1G_fdx

Indicates that the far end Ethernet device is 
full duplex capable.

ethernet_100_hdx

ethernet_10_hdx
ethernet_1G_hdx

Indicates that the far end Ethernet device is 
half duplex capable.

ethernet_1G_link_ad_status Indicates that the FST-2802 has received a 
valid auto-negotiation capability advertise-
ment from the far end Ethernet device and 
sent an acknowledgement.

ethernet_1G_link_config_ack Indicates that the far end Ethernet device 
has acknowledged the receipt of a valid 
auto-negotiation capability advertisement 
from the FST-2802.

Table 41 AutoNeg Status result field identifiers (Continued)

Field Identifier Description
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Table 42 describes the Pattern Stats result field identifiers.

ethernet_1G_pause_capable Indicates the flow control capabilities of the 
far end Ethernet device. Those capabilities 
are:
– TX Only:

The far end Ethernet device will transmit 
PAUSE frames to alert the FST-2802 to 
reduce the transmitted bandwidth, how-
ever it will not reduce its transmitted 
bandwidth if it receives PAUSE frames.

– RX Only:
The far end Ethernet device will reduce 
its transmitted bandwidth if it receives 
PAUSE frames but it will not transmit 
PAUSE frames to alert the FST-2802 to 
reduce the transmitted bandwidth.

– TX and RX: 
The far end Ethernet device will transmit 
PAUSE frames to alert the FST-2802 to 
reduce the transmitted bandwidth and it 
will reduce its transmitted bandwidth if it 
receives PAUSE frames 

– Neither TX and RX:
The far end Ethernet device will not 
transmit PAUSE frames to alert the FST-
2802 to reduce the transmitted band-
width and it will not reduce its transmit-
ted bandwidth if it receives PAUSE 
frames.

Table 41 AutoNeg Status result field identifiers (Continued)

Field Identifier Description

Table 42 Pattern Stats field identifiers

Field Identifier Description

ethernet_rx_frm_cnt The number of valid and errored Ethernet 
frames received since the link was established.

ethernet_tx_frm_cnt The number of Ethernet frames transmitted 
since the link was established.
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Table 43 describes the Ping Stats result field identifiers.

fibre_rx_frm_cnt The number of valid and errored Fibre Channel 
frames received since the link was established.

fibre_tx_frm_cnt The number of Fibre Channel frames transmit-
ted since the link was established.

Table 42 Pattern Stats field identifiers (Continued)

Field Identifier Description

Table 43 Ping Stats field identifiers

Field Identifier Description

ethernet_ping_lost_pings Count of Ping requests sent by the FST-2802 
for which replies were not received within 3 
seconds.

ethernet_ping_rt_delay The round trip delay for the last ping sent and 
successfully received by theFST-2802. Calcu-
lated in microseconds. 

ethernet_ping_rt_delay_avg The round trip delay for all pings sent and suc-
cessfully received by the FST-2802 since the 
last test restart. Calculated in microseconds. 

ethernet_ping_rt_delay_max The maximum round trip delay for pings sent 
and successfully received by the FST-2802. 
Calculated in microseconds. 

ethernet_ping_rt_delay_min The minimum round trip delay for pings sent 
and successfully received by the FST-2802. 
Calculated in microseconds.

ethernet_ping_rx_requests Count of the Ping requests received by the 
FST-2802 (in other words, requests sent to the 
FST-2802’s IP address) from another Layer 3 
device on the network.

ethernet_ping_rx_responses Count of the responses received to ping 
requests sent by the FST-2802.

ethernet_ping_tx_requests Count of the ping requests sent from the FST-
2802.
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Table 44 describes the L1 Bert Stats result field identifiers.

L2 Bert Stats
result field IDs

Table 45 describes the L2 Bert Stats result field identifiers.

ethernet_ping_tx_responses Count of the Ping responses sent by the FST-
2802 as replies to ping requests. Each time a 
ping request is received, the FST-2802 
responds and this counter is incremented by 
one.

Table 43 Ping Stats field identifiers (Continued)

Field Identifier Description

Table 44 L1 Bert Stats results

Field Identifier Description

ether_fibre_l1_ber The ratio of pattern bit errors to received pattern 
bits since initially acquiring pattern synchronization.

ether_fibre_l1_bit_error_seconds The number of seconds during which one or more 
pattern bit errors occurred since initial pattern syn-
chronization.

ether_fibre_l1_bit_errors A count of the number of received bits in a recog-
nized pattern that do not match the expected value.

ether_fibre_l1_total_bits The total number of bits received since initial pat-
tern synchronization.

Table 45 L2 Bert Stats results

Field Identifier Description

ether_fibre_l2_ber The ratio of pattern bit errors to received pattern bits 
since initially acquiring frame synchronization.
NOTE: This ratio is determined using only the bits in 
the payload of the frame.
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Event commands
Use event commands to either initiate an event or query for an event 
or series of events. Examples of initiated events are inserting an error 
or restarting a test. 

event Initiates or displays an event (specified by event and value) on the 
port specified.

Syntax event:<event_id><port_id> [event_arg]

Initiates event_id with the associated argument on the port speci-
fied. Table 46 lists the available event IDs and associated arguments 
for this syntax.

event:<event_id>? <port_id>

Lists all events for the event_id on the port specified.

event:all? <port_id>

Lists all events on the port specified.

event:clear <port_id>

Clears the event storage on the port specified.

ether_fibre_l2_bit_error_second
s

The number of seconds during which one or more 
pattern bit errors occurred since initial frame synchro-
nization.

ether_fibre_l2_bit_errors A count of the number of received bits in a recog-
nized pattern that do not match the expected value 
since initially acquiring frame synchronization.

ether_fibre_l2_total_bits The total number of bits received since initial frame 
synchronization.

Table 45 L2 Bert Stats results (Continued)

Field Identifier Description
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event:id? <port_id>

Returns the event ids for the port specified.

event:value? <port_id><event_id>

Returns the event values for the port specified.

Example The following command restarts a test on port 1:

event:test_restart port_1

Remark Not all events require a value.

Event commands Table 46 lists parameters for event change command identifiers and 
arguments.

Table 47 lists event responses to the event:all? or 
event:<event_id> command.

Table 46 Event change command identifiers and arguments

Event Identifier Description Event Argument

error_insert inserts an error   none

novram_clear Clears NOVRAM none

test_restart Causes a test restart none

ethernet_reset_svc_disruption Resets the service disrup-
tion test.

none

Table 47 Event responses

Response Description

ethernet_link_status_change

fibre_link_status_change

Indicates whether the status of the link has 
changed.

ethernet_loop_response

fibre_loop_response

Provides the response from the far end FST-
2802 when looping up or down.
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Miscellaneous commands
Use miscellaneous commands to perform a variety of functions with 
the FST-2802.

hello Lists the identification, revisions, and installed options of the FST-
2802. The output corresponds with the information on the “Revisions 
and Options” screen on the test set.

Syntax hello

help Lists the syntax and a brief description of each command.

Syntax help or ?

Example The following appears for the print command:

ethernet_loop_timeout
fibre_loop_timeout

Indicates your attempt to loop up or down has 
timed out with no response.

ethernet_optical_gbic

fibre_optical_gbic

Indicates a GBIC has been inserted or removed 
from the FST-2802.

ethernet_ping_done Indicates a ping was successful.

ethernet_ping_fail Indicates a ping has failed.

ethernet_ramp_abort

fibre_ramp_abort

Indicates a ramp was aborted.

ethernet_ramp_stopped
fibre_ramp_stopped

Indicates a ramp is complete.

Table 47 Event responses (Continued)

Response Description
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Miscellaneous commands
print:results [-save]-  Returns a printout of the 
results

id Displays the identification of the FST-2802.

Syntax id?

options Lists the configuring options installed on the TestPad. The output 
corresponds with information on the “Revisions and Options” screen.

Syntax options?

print Prints TestPad information.

Syntax print:controls [-save]

Lists the current configuration of the TestPad.

print:results [-save]

Lists the current results of the TestPad.

Remark Use the -save option to save the output in the print queue.

rev Lists the revisions of software and hardware installed on the FST-
2802.

Syntax rev?
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C

This chapter describes the customer services available through 
Acterna. Topics discussed in this appendix are as follows:

– “About our services” on page 290
– “Customer care” on page 290
– “Global services and solutions” on page 295
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About our services
Acterna offers an unmatched portfolio of services to deploy, support 
and innovate purchased equipment through its Customer Care and 
Global Services and Solutions organizations. Customer Care is stan-
dard with every product sale and consists of business hours technical 
assistance, in-warranty repair, calibration, and upgrade services. 
Global Services and Solutions provides professional services to opti-
mize product capabilities and maximize efficiencies, including field 
engineering and deployment, technical training, product support, 
consulting and custom software development. Together these organi-
zations supply the services necessary successfully utilize purchased 
equipment. 

Customer care
Customer Care is accompanied with the sale of every Acterna product. 
Customer Care services include:

– Needs Analysis on Products and Services 
– Comprehensive Product and Service Literature 
– Pre-Sales Consulting
– Technical Assistance (Business Hours)
– Instrument Repair (Under Warranty Repair and Calibration 

Services) 
– Immediate Return Authorizations 

Contact a Customer Care representative through your local distributor 
or by accessing www.acterna.com for information on upgrades, cali-
bration, warranty policies or any of Global Services and Solutions 
offerings. Representatives also provide assistance with product 
repairs and returns.

Technical
assistance

(business hours)

Expert business hours technical support, including help with product 
configuration, circuit qualification, and complete network trouble 
sectionalization is provided with your product (see “Technical assis-
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tance” on page xxiii). For around-the-clock support, 7x24 technical 
assistance may be purchased through Global Services and Solutions 
FleetCare program (see “Product support” on page 297).

Instrument repair Our service centers provide repair, calibration and upgrade services 
for under warranty equipment. Acterna understands the impact of 
equipment down time on operations and is staffed to ensure a quick 
turnaround. Available services include the following:

Product Repair — All equipment returned for service is tested to the 
same rigorous standards as newly manufactured equipment. This 
ensures products meet all published specifications, including any 
applicable product updates.

Calibration — Acterna’s calibration methods are ISO 9001 approved 
and based on NIST standards. 

Factory Upgrades — Any unit returned for a hardware feature 
enhancement will also receive applicable product updates and will be 
thoroughly tested, ensuring peak performance of the complete feature 
set.

Additional repair, calibration and upgrade services are available for 
purchase through Global Services and Solutions (see “Product 
support” on page 297).

Equipment return
instructions

Please contact your local Customer Care location via telephone or 
web site for Return or Reference Authorization to accompany your 
equipment. For each piece of equipment returned for repair, attach a 
tag that includes the following information:

– Owner’s name, address, and telephone number.
– The serial number, product type, and model.
– Warranty status. (If you are unsure of the warranty status of your 

instrument, contact Acterna Customer Care.)
– A detailed description of the problem or service requested.
– The name and telephone number of the person to contact 

regarding questions about the repair.
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– The return authorization (RA) number (US customers), or refer-
ence number (European Customers). 

If possible, return the equipment using the original shipping container 
and material. If the original container is not available, the unit should 
be carefully packed so that it will not be damaged in transit; when 
needed, appropriate packing materials can be obtained by contacting 
Acterna Customer Care. Acterna is not liable for any damage that may 
occur during shipping. The customer should clearly mark the Acterna-
issued RA or reference number on the outside of the package and ship 
it prepaid and insured to Acterna.

Warranty
information

The warranties described herein shall apply to all commercially avail-
able Acterna products. Any additional or different warranties shall 
apply only if agreed to by Acterna in writing. These warranties are not 
transferable without the express written consent of Acterna.

Hardware Warranty — Acterna warrants that Hardware Product 
sold to customer shall, under normal use and service, be free from 
defects in materials and workmanship. Information regarding the 
specific warranty period for this product can be obtained by 
contacting your local Acterna Customer Service Representative, 
or at our web site www.acterna.com. If installation services have 
been ordered, the warranty period shall begin on the earlier of (1) 
completion of installation, or (2) thirty (30) days after shipment to 
Customer. If Installation Services have not been ordered, the 
warranty period shall begin upon shipment to Customer. Hereafter 
these periods of time shall be collectively referred to as the “Initial 
Warranty Period.”
Acterna’s obligation and customer’s sole remedy under this Hard-
ware Warranty is limited to the repair or replacement, at Acterna’s 
option, of the defective product. Acterna shall have no obligation 
to remedy any such defect if it can be shown: (a) that the Product 
was altered, repaired, or reworked by any party other than Acterna 
without Acterna’s written consent; (b) that such defects were the 
result of customer’s improper storage, mishandling, abuse, or 
misuse of Product; (c) that such defects were the result of 
customer’s use of Product in conjunction with equipment electron-
ically or mechanically incompatible or of an inferior quality; or (d) 
that the defect was the result of damage by fire, explosion, power 
failure, or any act of nature.
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Acterna performed repairs shall be warranted from defective 
material and workmanship for a period of ninety (90) days, or until 
the end of the Initial Warranty Period, whichever is longer. Risk of 
loss or damage to Product returned to Acterna for repair or 
replacement shall be borne by customer until delivery to Acterna. 
Upon delivery of such product, Acterna shall assume the risk of 
loss or damage until that time that the product being repaired or 
replaced is returned and delivered to customer. Customer shall 
pay all transportation costs for equipment or software shipped to 
Acterna for repair or replacement. Acterna shall pay all transporta-
tion costs associated with returning repaired or replaced product 
to customer.
Software Warranty — Acterna warrants that Software Products 
licensed to Customer shall, under normal use and service, and for 
a period of ninety (90) days from the date of shipment of the Soft-
ware to Licensee (the “Warranty Period”), perform in all material 
respects in accordance with the published specifications for such 
Software as established by Acterna. However, Acterna does not 
warrant that the Software will operate uninterrupted or error free, 
operate in the combination with other software, meet Customer’s 
requirements, or that its use will be uninterrupted.
Acterna’s obligation and Customer’s sole and exclusive remedy 
under this Software Warranty is limited to, at Acterna’s option, 
either (i) correcting the material errors reported to Acterna in 
writing by Customer during the Warranty Period and which 
Acterna is able to reproduce, (ii) replacing such defective Soft-
ware, provided that Acterna received written notice of such defect 
within the Warranty Period, or (iii) provided that Acterna received 
written notice of such defect within the Warranty Period, termi-
nating the License and, upon return to Acterna of the Software, 
Documentation and all other materials provided by Acterna under 
the applicable License, providing Customer with a refund of all 
charges paid with respect thereto. Acterna shall have no warranty 
obligations hereunder if (a) the Software is altered or modified or 
is merged with other software by Customer or any third party or (b) 
all or any part of the Software is installed on any computer equip-
ment other than the Designated Server or used with any operating 
system for which the Software is not designed. Acterna’s obliga-
tion and Customer’s sole and exclusive remedy under this Soft-
ware Warranty is limited to, at Acterna’s option, either (i) correcting 
the material errors reported to Acterna in writing by Customer 
during the Warranty Period and which Acterna is able to repro-
duce, (ii) replacing such defective Software, provided that Acterna 
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received written notice of such defect within the Warranty Period, 
or (iii) provided that Acterna received written notice of such defect 
within the Warranty Period, terminating the License and, upon 
return to Acterna of the Software, Documentation and all other 
materials provided by Acterna under the applicable License, 
providing Customer with a refund of all charges paid with respect 
thereto. Acterna shall have no warranty obligations hereunder if 
(a) the Software is altered or modified or is merged with other soft-
ware by Customer or any third party or (b) all or any part of the 
Software is installed on any computer equipment other than the 
Designated Server or used with any operating system for which 
the Software is not designed. Customer acknowledges that the 
Software Products provided by Acterna hereunder may contain 
third party software not produced by Acterna (a "Third Party 
Supplier Product"). To the extent that the rights Acterna grants to 
Customer consist of use of Third Party Supplier Products obtained 
and provided under a GNU General Public License ("General 
Public Software"), the following notice is required and shall govern 
the use of such General Public License Software: (1) this program 
is free software; you can distribute it and/or modify it under the 
terms of the GNU General Public License as published by the 
Free Software Foundation; either version 2 of the License, or (at 
your option) any later version. This program is distributed in the 
hope that it will be useful, but WITHOUT ANY WARRANTY; 
without even the IMPLIED WARRANTY OF MERCHANTABILITY 
or FITNESS FOR A PARTICULAR PURPOSE. See the GNU 
General Public License for more details. If you would like to 
receive further details concerning the use of such General Public 
License Software or would like to receive a copy of the GNU 
General Public License, please make a written request to Acterna, 
12410 Milestone Center Drive, Germantown, Maryland 20876-
4023 or write to the Free Software Foundation, Inc., 59 Temple 
Place - Suite 330, Boston, MA 02111-1307, USA.
Services Warranty — Acterna warrants that the Services 
provided by Acterna, if any, shall be performed promptly, diligently 
and in a professional manner in accordance with the commercial 
standards of the industry. Acterna shall not, however, be respon-
sible for any delays that are not due to Acterna’s fault or negli-
gence or that could not have reasonably been foreseen or 
provided against.
294 FST-2802 TestPad User’s Guide Revision A



Appendix C Customer Services
Global services and solutions
WARRANTY DISCLAIMER — FOR HARDWARE, SOFTWARE, 
AND/OR SERVICES FURNISHED BY ACTERNA, THE FOREGOING 
WARRANTIES ARE IN LIEU OF ALL OTHER WARRANTEES AND 
CONDITIONS, EXPRESS OR IMPLIED. ACTERNA SPECIFICALLY 
DISCLAIMS ALL OTHER WARRANTIES, EITHER EXPRESS OR 
IMPLIED, ON ANY HARDWARE, SOFTWARE, DOCUMENTATION 
OR SERVICES INCLUDING BUT NOT LIMITED TO WARRANTIES 
RELATING TO QUALITY, PERFORMANCE, NONINFRINGEMENT, 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE, 
AS WELL AS THOSE ARISING FROM ANY COURSE OF DEALING, 
USAGE OR TRADE PRACTICE. UNDER NO CIRCUMSTANCES 
WILL ACTERNA BE LIABLE FOR ANY INDIRECT OR CONSE-
QUENTIAL DAMAGES RELATED TO BREACH OF THIS 
WARRANTY. 

Global services and solutions
Global Services and Solutions markets a broad portfolio of services to 
enable customers to aggressively build their competitive advantage 
within the markets they serve. Global Services and Solutions innova-
tive offerings respond to our customers’ dynamic needs:

– System deployment and field engineering services
– Technical training
– Product support 
– Consulting
– Custom software development 
– Integrated service programs

Additional information can also be found on our web site under 
Services.

System
deployment and

field engineering

Acterna offers a range of support services for our centralized test 
systems, designed around the needs of the customer’s network. Field 
engineering and deployment services provide a variety of options for 
implementing the test system into the network.
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Deployment — Thorough deployment process covers the initial site 
survey through hardware and software installation, allowing rapid inte-
gration of systems product into customers’ environment without the 
use of their own resources. Deployment includes survey, configura-
tion, installation of hardware and software, site planning, cabling, 
acceptance testing, staging, certification and system documentation. 

Basic Service for Systems — In today’s fast-paced world of commu-
nications, network operators are deploying increasingly complex 
communications test and management systems. Acterna’s Basic 
Service for Systems is designed to provide the system experts, 
support and methodologies to facilitate the integration of systems 
products into customers’ environments. Basic Service for Systems 
encompasses system deployment, training, software upgrades, tech-
nical assistance and repair. This service is subject to availability, 
please visit www.acterna.com or contact Customer Care for additional 
information.

Training Acterna delivers training in instructor-led or alternative learning 
formats that are flexible, convenient, and timely. Our training solutions 
portfolio consists of network-specific test and management tools for 
optical transport, cable, access, data, and wireless environments. 

Instructor-led training Public courses (Acterna sites)

Public courses help participants quickly acquire fundamental skills or 
broaden their communications knowledge with advanced instruction. 
Our courses deliver the ideal mix of theory and practice. 

On-site training (Customer site) 

Acterna provides practical, customized instruction at the customer’s 
designated site. Whether your goal is to shorten turn-up times or 
increase operation-wide efficiency, on-site training can be a cost-effec-
tive way to train from one to 10 participants. Prior to training, the 
instructor contacts the customer to ensure the course content is 
aligned with the organization’s training needs. We conduct step-by-
step reviews of current technologies and products to help both new 
and experienced technicians translate theory into practical, hands-on 
expertise. 
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When scheduling an on-site course, please note that Acterna requires 
a minimum commitment of two consecutive days of training. Courses 
that are only one day in duration may either be paired with another 
course for a minimum total of two training days, or presented on two 
consecutive days to different groups of participants.

Alternative learning Courseware licensing program and train-the-trainer

Recommended for customers with internal training departments, 
Acterna’s Courseware Licensing Program is a fast, affordable alterna-
tive that allows our customers to train their own staff using Acterna’s 
courseware. Each course provides comprehensive instructor and 
participant materials to ensure consistent content delivery for the 
length of the agreement. A critical part of Courseware Licensing is the 
Train-the-Trainer program, which prepares the organization’s own 
instructors to deliver Acterna training courses. Courseware Licensing 
is sold in increments of one, two, or three years.

Computer-based training (CBT)

By blending learning with technology, Acterna’s CBT program 
provides our customers with a cost-effective way to learn technology 
fundamentals and product applications. Topics include ATM, Frame 
Relay, ISDN, LAN Basics, Fiber Optics, and more. CBTs are designed 
to complement both public and on-site training; they can serve to 
prepare students for classroom Acterna courses or be used after 
instructor-led training to reinforce learning. In addition to our pre-pack-
aged CBTs, Acterna custom-develops CBTs to meet your organiza-
tion’s training needs.

To enroll in a course or for more information on the variety of Acterna 
training programs available, call 1-800-638-2049 or visit 
www.acterna.com and complete the Training Requirement Form.

Product support To continue repair, maintenance and upgrades after a product’s 
warranty expires, Acterna offers a variety of product support plans. 

FleetCare — Designed for customers with ten or more Acterna prod-
ucts, FleetCare extends each product’s initial factory warranty to 
include repair parts, labor and one-way shipping. FleetCare allows 
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customers to upgrade the base package with a variety of options, 
including Calibration Plans, Calibration Plan with Manager, Loaners, 
7x24 Technical Assistance and Software Enhancement Agreements.

Software Enhancement Agreements — In response to new devel-
opments in technology, Acterna continually upgrades and revises the 
software that drives many of its products. Software Enhancement 
Agreements automatically ships the latest software revisions, releases 
and upgrades to ensure products are operating at the most technolog-
ically advanced level.

Product Maintenance Agreements — Yearly repair and calibration 
maintenance agreements simplify billing and help ensure equipment is 
always operating at optimum levels. Product maintenance agree-
ments can be used to extend a current warranty or provide protection 
for out-of-warranty units.

Repair Pricing Options — For out-of-warranty repairs, Acterna offers 
two additional pricing options: time and material pricing and flat rate 
pricing. Under time and material pricing, customers are billed for the 
actual cost of the repair, making this a cost-effective method for minor 
repairs. Under flat rate pricing, customers pay a fixed service charge 
to repair unit failures (excluding damage or abuse).

Consulting
services

To quickly improve our customer’s efficiency and productivity, Acterna 
offers personalized consulting programs designed to meet specific 
client needs. Our consulting staff will work as part of your team, 
providing a valuable blend of subject matter proficiency, an in-depth 
test and measurement systems perspective, and trusted telecommu-
nications industry vision. 

Methods and Procedure Development — Acterna's Methods and 
Procedure Development services include consulting with your staff 
and assessing your network plant’s current test and turn-up proce-
dures. After evaluating the skill level of your workforce in specific tech-
nologies and procedures, an Acterna team of experts identifies 
potential areas of improvement and makes appropriate recommenda-
tions in a formal implementation plan. Depending on your staff 's level 
of expertise, test procedures can be written to any level of detail, from 
general methods and procedures to detailed “button-by-button" test 
and network equipment-specific procedures. In addition, Acterna’s 
experts offer hands-on training for your field technicians and can 
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resolve specific problems at the central office. Acterna develops test 
plans and procedures for Service Providers, End-users and Manufac-
turers of Network Equipment.

Test Automation — With Acterna’s Test Automation Development, a 
team of experts can develop customized automated and remote 
testing solutions so that you can keep your network functioning at peak 
levels. After consulting with you, the Acterna team can determine 
which of Acterna’s test and analysis equipment and automation plat-
forms can best streamline your testing processes, data analysis, and 
test result storage methods. The consulting team can develop and 
integrate automated testing applications on customers’ currently 
installed computer platforms that match existing methods and proce-
dures. An Acterna team of consultants can assist customers 
throughout every stage of the development and implementation of 
automated and remote testing solutions. Services range from devel-
oping automated scripts to integrating customized software applica-
tions to developing drivers to automated manufacturing tests.

On-site Test and Measurement Service — Acterna On-site Test and 
Measurement Service provides testing expertise to expedite the 
implementation, turn-up, and provisioning of network services. 
Applying their knowledge to your specific network requirements, 
Acterna’s network consultants can quickly verify transmission 
systems’ implementation, assess a fiber plant’s suitability for 
advanced services, future-proof your system. Because incomplete 
testing often results in crippling losses of revenue, carriers and 
providers must operate their networks with a very low margin of error. 
Difficulties in ensuring network performance are further compounded 
when technicians must employ unfamiliar yet critical test and 
measurement processes. But with Acterna’s dedicated, highly skilled 
team of professionals providing communications test and measure-
ment solutions, your staff can concentrate on performing value-added 
services that will maximize your profitability. 

Integrated service
programs

Service Dollars (North America only) — To deliver the highest level 
of support with your product purchase, Acterna offers Service Dollars. 
Services Dollars can be purchased at anytime, for each Acterna instru-
ment. If purchased at the same time as your product, Service Dollars 
are discounted 20 percent. This is a significant savings, as Service 
Dollars can be used towards the purchase of any of Global Services 
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and Solutions offerings. Service Dollars are also flexible in the fact that 
they can be purchased at anytime and then used later towards the 
specific service that best fits your support needs.
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Symbols/Numerics

802.11b — IEEE standard for wire-
less LANs. You can establish wire-
less LAN connections to the TestPad 
using an 802.11 PCMCIA card.

802.3 — The IEEE specification for 
Ethernet. 802.3 also specifies a 
frame type that places the frame 
length in the Length/Type field of the 
Ethernet header, as opposed to the 
DIX Type II frame type which utilizes 
the Length/Type field to identify the 
payload Ethertype.

A

ADM — Add-drop multiplexer. 

ATP — Acterna test packet. A test 
packet that contains a time stamp 
and sequence number for measuring 
round trip delay and counting out-of-
sequence frames. To transmit ATPs 

from an FST-2802, you select an 
Acterna payload on the Tx Profiles 
tab when you configure a test.

C

CJPAT — Continuous jitter test 
pattern.

Controls — Synonym for test 
configuration. Appears on the 
TestPad user interface.

CRC — Cyclic redundancy check. 
See also FCS.

CRPAT — Continuous random test 
pattern.

CSPAT — Compliant supply noise 
test pattern.

D

DA — Destination address.
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DB-9 — Standard 9-pin RS-232 
serial port or connector. The Y cable 
supplied with the TestPad provides a 
DB-9 connector.

DB-25 — 25-pin RS-232 serial port 
or connector.

DHCP — Dynamic Host Configura-
tion Protocol. A communications 
protocol that assigns IP addresses 
dynamically as needed. Also 
supports static IP address assign-
ment.

DIX — Digital, Intel, and Xerox. 
Ethernet Type II frame format.

DTE —  Data Terminal Equipment. 
Port that serves as the data transmis-
sion source, data transmission desti-
nation, or both, for the purpose of 
sending or receiving data. The USB/
Serial port of the TestPad is config-
ured as a DTE port.

E

Ethernet — A LAN protocol. Using 
the FST-2802, you can test and verify 
Ethernet network elements and 
services. If you purchase the 
Networking option, you can establish 
Ethernet connections from the 
TestPad to an Ethernet network or a 
laptop or PC using an Ethernet 
PCMCIA card and an Ethernet LAN 
or crossover cable. After you estab-
lish an Ethernet connection, you can 
run the Remote GUI, use FTP to 
transfer files, issue remote control 
commands, and launch the Web 
browser.

Ethernet link partner — The 
nearest Ethernet device on a link. 
The FST-2802 auto-negotiates its 
capabilities with this device when you 
initialize a link.

F

FCS — Frame check sequence. A 
value calculated by an originating 
device and inserted into an Ethernet 
frame. The receiving device 
performs the same calculation, and 
compares its FCS value with the FCS 
value in the frame. If the values don’t 
match (suggesting the frame is 
errored), an FCS error is declared. 
Switching devices will discard the 
frame.

FDX — Full duplex.

FTP — File transfer protocol. 
Protocol used on LANs and the 
Internet to transfer files. If you 
purchase the Networking option, you 
can transfer files to and from the 
TestPad using FTP.

G

GBIC — Gigabit Interface Converter. 
An Ethernet or Fibre Channel module 
that provides a media conversion 
from a standard, defined Ethernet or 
Fibre Channel interface to the 
desired media such as single-mode 
or multi-mode fiber. The FST-2802 
provides a GBIC jack for 
1G Ethernet, 1G Fibre Channel, and 
2G Fibre Channel testing.
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GUI — Graphical User Interface. 
Layout of commands in a user-
friendly environment. See also UI 
(user interface).

H

HDX — Half duplex.

Histogram — Print output of specific 
results in a bar graph format.

I

ICMP — Internet Control Message 
Protocol. Protocol which provides 
basic control messages such as 
Echo Requests and Echo Replies for 
IP packet processing. When you ping 
a layer 3 or IP device using the FST-
2802, the FST-2802 displays key 
ICMP messages in the message 
display of the user interface.

IP — Internet Protocol. Protocol 
specifying the format and address 
scheme of packets transmitted over 
the Internet. Typically used with TCP.

ISP — Internet service provider. A 
vendor who provides access to the 
Internet and the World Wide Web.

ITU — International Telecommunica-
tions Union based in Geneva, Swit-
zerland. 

J

jabber — An Ethernet frame that 
exceeds the IEEE 802.3 maximum 
length of 1518 bytes (or 1522 bytes 
with a VLAN tag) and contains an 
errored FCS, or a Fibre Channel 

frame that exceeds the maximum 
length of 2140 bytes with an errored 
CRC.

jumbo frame — An Ethernet frame 
that exceeds the IEEE 802.3 
maximum length of 1518 bytes (or 
1522 bytes with a VLAN tag), or a 
Fibre Channel frame that exceeds 
2140 bytes. You can transmit jumbo 
frames using the FST-2802.

L

LCD — Liquid crystal display.

LED — Light emitting diode. 

LLC — Logical link control. Three 
bytes carried in 802.3 frames which 
specify the memory buffer the data 
frame is placed in. When you 
transmit pings using the FST-2802, 
you can transmit 802.3 frames with 
LLC, or 802.3 frames with LLC and 
SubNetwork Access Protocol 
(SNAP).

M

MDI — Medium dependent interface.

MDI-X — Medium dependent inter-
face crossover.

Msg — Message.

MSPP — MSPP. Multi-service provi-
sioning platform. Typically next 
generation SONET multiplexors 
capable of aggregating multiple 
access technologies such as 
Ethernet, TDM, and ATM onto a 
SONET ring.
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N

NiMH — Nickel-Metal Hydride. The 
TestPad is equipped with a recharge-
able Nickel-Metal Hydride battery.

P

PCMCIA — Personal Computer 
Memory Card International Associa-
tion. The PCMCIA standardizes 
credit-card size packages for 
memory and input/output for 
computers, laptops, palmtops, and 
more.

Ping — Program which sends an 
ICMP echo request packet to an IP 
address and awaits a reply. Ping 
requests are typically used to test 
connectivity. You can transmit and 
respond to ping packets using the 
FST-2802.

Print event trigger — An event, 
such as a change in test results or a 
test restart, which prompts the 
TestPad to generate print output.

Print mode — The means of gener-
ating print output on the TestPad. 
You can manually generate output, 
schedule the TestPad to generate 
output at timed intervals, or schedule 
the TestPad to generate output when 
a test ends.

Print type — The type of information 
provided in print output.

R

RFC 2544 — Document titled 
Benchmarking Methodology for 
Network Interconnect Devices, 
published by the Internet Engi-
neering Task Force. RFC 2544 
defines a series of tests that can be 
used to measure the performance 
characteristics of data networking 
devices. Using the FST-2802, you 
can run an automated script which 
prompts you for key parameters for 
each of the RFC 2544 recommended 
tests.

RJ-11 — Modular telephone jack, 
typically used for telephones, 
modems, and fax machines.

RJ-45 — Jack on the FST-2802 
used for 10/100 Ethernet testing.

RS-232 — Set of standards speci-
fying electrical, functional and 
mechanical interfaces used for 
communicating between computers, 
terminals and modems.

runt — An Ethernet frame that is 
shorter than the IEEE 802.3 
minimum frame length of 64 bytes 
and contains an errored FCS, or a 
Fibre Channel frame that is shorter 
than the minimum 28 byte frame 
length containing an errored CRC.

Rx — Receive.

S

SA — Source address.

Secs — Seconds.
304 FST-2802 TestPad User’s Guide Revision A



Glossary
Service disruption time — The 
time between Ethernet or Fibre 
Channel frames (maximum inter-
frame gap) when service switches to 
a protect line. The Svc Disruption 
(ms) result in the Link Stats category 
displays the service disruption time.

SFD — Start of frame delimiter. Part 
of an Ethernet frame preamble that 
indicates that the destination 
address frame is about to begin.

SMTP — Simple mail transfer 
protocol. You must connect to an 
SMTP server to send e-mail from the 
TestPad.

SNAP — SubNetwork Access 
Protocol. Protocol used in 802.3 
frames which specifies a vendor 
code and an Ethertype. When you 
transmit pings using the FST-2802, 
you can transmit 802.3 frames with 
with logical link control (LLC) and 
SNAP.

T

Tcl/Tk — Scripting language which 
enables you to write your own test 
scripts for the TestPad.

TCP — Transmission Control 
Protocol. Protocol enabling two hosts 
to establish a connection and 
exchange streams of data.

Term — See Terminate

Terminate — An application where 
the test set is terminating the circuit. 
In these applications, the test set 
sends and receives traffic.

Thru — An application where the 
test set is used in series with a 
network circuit to monitor the traffic 
on that circuit.

ToS — Type of service. When you 
configure the FST-2802 to transmit 
pings, you can optionally specify the 
type of service using the Advanced 
button on the PING tab.

TTL — Time to live. Time after which 
a fragmented ping request or 
response can be deleted by any 
device on a circuit. When you 
configure the FST-2802 to transmit 
pings, you can optionally specify the 
TTL value in seconds using the 
Advanced button on the PING tab.

Tx — Transmit

U

UIM — User interface module.

USB — Universal Serial Bus. A bus 
designed to handle a broad range of 
devices, such as keyboards, 
mouses, printers, modems, and 
hubs. The Y cable supplied with the 
TestPad provides a USB connector.

V

VNC — Virtual Network Computing. 
A thin client system that enables you 
to run applications on a VNC server 
from any other computer connected 
to the Internet. Using VNC, you can 
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run the TestPad from a remote work-
station, and you can run remote 
applications from the TestPad.
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Configuration commands

config 251
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config:id 266
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storing 107
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printers 49
TestPad for testing 96
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about serial and network 80
IP socket 90
LAN 87
modem dial-in 85
modem dial-out 83
serial 81, 82

Connectivity
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troubleshooting Ethernet 127
troubleshooting Fibre Channel 187

Connectivity Tools Menu command 24
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Constant traffic

about 118
configuring for Ethernet 128
configuring for Fibre Channel 188
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Copying and pasting files 75
CRC errors, inserting 211
CRPAT pattern 150, 206
CSPAT pattern 150, 206
Custom result category 45
Customer services 290–295

technical assistance 290
warranty information 292–295

D
Date and time, setting 35
default.txt file 47
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Dual port THRU mode

monitoring 1G Ethernet traffic 175
monitoring Fibre Channel traffic 216
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DIX frame format 114
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VLAN tagged frame format 115

Event commands 285
event 285
event change 286

Event triggers 49
Extended keypad
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Help key 26
Keyboard key 26
Printer Setup key 26
Restart key 25
Toggle Screen key 25

F
Factory defaults, restoring 46
FCS errors, inserting 156
Features and capabilities

Ethernet 4
Fibre Channel 5
FST-2000 TestPad 5

Fibre Channel testing
about 182
end-to-end testing 197
establishing connectivity 185
inserting a CRC error 211
Layer 1 BERT 200
Layer 2 BERT 202
link initialization 182
loopback testing 207
measuring round trip delay 214
measuring service disruption time 203
monitoring traffic 215
transmitting patterns 205
troubleshooting connectivity 187

Fibre Channel traffic
about 182
bursty loads 118
configuring loads 188
constant loads 118
frame format 182, 183
ramped loads 119
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Files
copying and pasting 75
deleting 75
filtering 74
renaming 75
running 75
selecting 71
viewing 75

Filter Counts results 232
Filter Stats results 231
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Ethernet traffic 133, 136
Fibre Channel traffic 192, 194
files 74

Flow control
turning off advertised capability 123

Frame formats
802.3 160
DIX 114
DIX, VLAN tagged 115
Fibre Channel 183

Front panel 19
FST-2802
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Ethernet testing 111
features and capabilities 3
Fibre Channel testing 181
GBICs 9
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powering 20
remote control commands 249
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FTP server
connecting to remote 76
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G
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H
Headings, on print output 52
Help key 26
Histograms, setting up 57
Hub, connecting 33
HyperTerminal, launching 69

I
Inserting

CRC errors 211
FCS errors 156

Internet and intranet content, viewing 68
IP address 176

determining the TestPad’s 70
IP socket connections 90

J
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provisioning routers for 162
transmitting 139

K
Keyboard key 26
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connecting USB 33
on-screen 61

Keys
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Help 26
Keyboard 26
Printer Setup 26
Restart 25
Toggle Screen 25

L
LAN connections 87
LED display panel 20
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alarm 222
display panel 222
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status 222

Line loopback feature
Ethernet 151
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Link initialization

about Ethernet 112
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Link Stats results 227
Load types

configuring Ethernet 128
configuring Fibre Channel 188
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Loads, traffic
bursty 118
constant 118
ramped 119

Loop Up button 153, 209
Loopback testing, Ethernet

about 151
inserting FCS errors 156
text identifiers 153
two TestPad requirement 115
using automatic loopback 153
using line Loopback 151

Loopback testing, Fibre Channel
about 207
inserting CRC errors 211
text identifiers 210
using automatic loopback 209
using line Loopback 207

M
MAC address

assigning user-specified 172
determining factory-assigned 139

MDIs 179
Measuring

round trip delay, Ethernet 158
round trip delay, Fibre Channel 214
service disruption time, Ethernet 147
service disruption time, Fibre Channel 
203

Medium dependent interfaces 179
Message display bar 23
Miscellaneous commands

hello 287
help 287
id 288
options 288
print 288
rev 288

Modem dial-in connections 85
Modem dial-out connections 83
monitoring on 1G Ethernet 176
Monitoring traffic, Ethernet

10/100 in dual port THRU mode 177
1G using a splitter 174
1G using dual port THRU mode 175
1G using single port THRU mode 174
IP addresses on 1G traffic 176

Monitoring traffic, Fibre Channel
using a splitter 215

using dual port THRU mode 216
using single port THRU mode 215

Mouse, connecting 33
Muting the speaker 39

N
Networking option 8
NOVRAM, clearing 46

O
Online help

launching 24, 26
On-screen keyboard 61
Options

about 6
AutoMATE 24
FST-2802 7
loading 41
Networking 8
Scripting 8
TestPad 8
VLAN Tagging 7
VT100 8, 69
Web browser 8, 68

options command 288

P
Panels

bottom 18
front 19
LED display 20
top 16

Parameters
connectivity 81
testing 94

Password, remote GUI 35
Pattern Stats results 237
Patterns

CJPAT 150, 206
CRPAT 150, 206
CSPAT 150, 206
transmitting Ethernet 149
transmitting Fibre Channel 205

Payload, Acterna
Ethernet 137, 158
Fibre Channel 195, 214
FST-2802 TestPad User’s Guide Revision A 311



Index
PCMCIA cards
serial 81
slots 17

PDFs, viewing 66
Physical specifications 246
Ping

Ping Stats results 237
response messages 164
testing 159

Port buttons 22
Power status button 25
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Print output See Printing
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Printer Setup key 26
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print event triggers 49
print management 24
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print output, viewing 60
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stored print files 61
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Product support plans 297–298
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Profiles, Fibre Channel
defining receive 192
defining transmit 194
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support 162

R
Ramped traffic

about 119
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configuring for Fibre Channel 188
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defining Ethernet 133
defining Fibre Channel 192

Remote control
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configuration commands 251
event commands 285
miscellaneous commands 287
result commands 269

Remote control function, about 250
Remote GUI

Extended keypad commands 26, 71
password 35
running 70

Renaming files 75
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Restoring factory defaults 46
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result:id 269
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about 220
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Error Stats 234
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Link Stats 227
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Summary 220
Time 224

RFC 2544
about the script 165
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162
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S
Safety

safety instructions ix
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Screen saver, setting up 37
Scripting option 8
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about RFC 2544 165
running RFC 2544 from Remote GUI 
169
running RFC 2544 from TestPad 165
See alsoTest scripts

Selecting files 71
Sending e-mail 62
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default settings 82
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Service disruption time
measuring Ethernet 147
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Services
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global services and solutions 299–300
product support plans 297–298
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Setup button 22
Signal results 223
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monitoring Fibre Channel traffic 215
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assigning user-specified 172
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Specifying
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ties 123
link initialization parameters 123
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Summary bar 22
Summary results 220
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addresses 115
application modules 28

Switch port emulation 113
Switching, Ethernet 115
System button 23

T
TCP/IP address, LAN connections 89
Technical assistance, Acterna xxiii
Test configurations

loading 108
storing 107

Test results
about 220
AutoNeg Status 224
Custom 45
Error Stats 234
Filter Counts 232
Filter Stats 231
LED 222, 223
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Link Stats 227
Pattern Stats 237
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Signal 223
Summary 220
Time 224
viewing 106
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about RFC 2544 165
AutoMATE option 24
running 109
running RFC 2544 from Remote GUI 
169
running RFC 2544 from TestPad 165
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Testing
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configuring a test 94
connecting TestPad for 96
Ethernet 111
Fibre Channel 181
restarting 24, 106
running a test 94
scripts See Test scripts
test results 219
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computer name 70
connecting for testing 96
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front panel 19
FTP server 77
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options 8
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sending e-mail 62
settings 24
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user interface 21

Text identifiers, defining 153, 210
THRU mode

dual port, Ethernet 175
dual port, Fibre Channel 216
single port, Ethernet 174
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Tools button 24
Tools menu commands

AutoMATE 24
Connectivity 24
File Management 24
FST-2802 Settings 24
Help 24
Print Management 24
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about 113
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switching 115
transmit profiles 120, 136
VLAN tagged frame format 115

Traffic, Fibre Channel
about 182
bursty loads 118
configuring loads 188
constant loads 118
frame format 183
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receive profiles 185, 192
transmit profiles 184, 194

Training 296–297
computer-based 297
courseware licensing program 297
instructor-led 296
train the trainer 297

Transmit profiles
defining Ethernet 136
defining Fibre Channel 194
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Ethernet 149
Fibre Channel 205

Troubleshooting 242
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UIM
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